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KAPITOLA 1

Uvod do kurzu

1.1

Predmluva

Welcome to our course! We will be showing you how to use QGIS easily and efficiently. If you are new to GIS, we will
tell you what you need to get started. If you are an experienced user, you will see how QGIS fulfills all the functions
you expect from a GIS program, and more!

1.1.1 Why QGIS?

As information becomes increasingly spatially aware, there is no shortage of tools able to fulfill some or all commonly
used GIS functions. Why should anyone be using QGIS over some other GIS software package?

Here are only some of the reasons:

It’s free, as in lunch. Installing and using the QGIS program costs you a grand total of zero money. No initial
fee, no recurring fee, nothing.

It’s free, as in liberty. If you need extra functionality in QGIS, you can do more than just hope it will be included
in the next release. You can sponsor the development of a feature, or add it yourself if you are familiar with
programming.

It’s constantly developing. Because anyone can add new features and improve on existing ones, QGIS never
stagnates. The development of a new tool can happen as quickly as you need it to.

Extensive help and documentation is available. If you're stuck with anything, you can turn to the extensive
documentation, your fellow QGIS users, or even the developers.

Cross-platform. QGIS can be installed on macOS, Windows and Linux.

Now that you know why you want to use QGIS, these exercises will make you know how.
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1.1.2 Background

In 2008 we launched the Gentle Introduction to GIS, a completely free, open content resource for people who want to
learn about GIS without being overloaded with jargon and new terminology. It was sponsored by the South African
government and has been a phenomenal success, with people all over the world writing to us to tell us how they are
using the materials to run University Training Courses, teach themselves GIS and so on. The Gentle Introduction is not
a software tutorial, but rather aims to be a generic text (although we used QGIS in all examples) for someone learning
about GIS. There is also the QGIS manual which provides a detailed functional overview of the QGIS application.
However, it is not structured as a tutorial, but rather as a reference guide. At Linfiniti Consulting CC. we frequently
run training courses and have realised that a third resource is needed - one that leads the reader sequentially through
learning the key aspects of QGIS in a trainer-trainee format - which prompted us to produce this work.

This training manual is intended to provide all the materials needed to run a 5 day course on QGIS, PostgreSQL and
PostGIS. The course is structured with content to suit novice, intermediate and advanced users alike and has many
exercises complete with annotated answers throughout the text.

1.1.3 Licence

@060

The Free Quantum GIS Training Manual by Linfiniti Consulting CC. is based on an earlier version from Linfiniti
and is licensed under a Creative Commons Attribution 4.0 International. Permissions beyond the scope of this license
may be available at below.

We have published this QGIS training manual under a liberal license that allows you to freely copy, modify and
redistribute this work. A complete copy of the license is available at the end of this document. In simple terms, the
usage guidelines are as follows:

* You may not represent this work as your own work, or remove any authorship text or credits from this work.

* You may not redistribute this work under more restrictive permissions than those under which it was provided
to you.

« If you add a substantive portion to the work and contribute it back to the project (at least one complete module)
you may add your name to the end of the authors list for this document (which will appear on the front page)

* If you contribute minor changes and corrections you may add yourself to the contributors list below.

* If you translate this document in its entirety, you may add your name to the authors list in the form ,, Translated
by Joe Bloggs*“.

* If you sponsor a module or lesson, you may request the author to include an acknowledgement in the beginning
of each lesson contributed, e.g.:

Poznamka: This lesson was sponsored by MegaCorp.

* If you are unsure about what you may do under this license, please contact us at office@linfiniti.com and we
will advise you if what you intend doing is acceptable.

* If you publish this work under a self publishing site such as https://www.lulu.com we request that you donate
the profits to the QGIS project.

* You may not commercialise this work, except with the expressed permission of the authors. To be clear, by
commercialisation we mean that you may not sell for profit, create commercial derivative works (e.g. selling
content for use as articles in a magazine). The exception to this is if all the profits are given to the QGIS project.
You may (and we encourage you to do so) use this work as a text book when conducting training courses, even if
the course itself is commercial in nature. In other words, you are welcome to make money by running a training
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course that uses this work as a text book, but you may not profit off the sales of the book itself - all such profits
should be contributed back to QGIS.

1.1.4 Sponsoring Chapters
This work is by no means a complete treatise on all the things you can do with QGIS and we encourage others to add
new materials to fill any gaps. Linfiniti Consulting CC. can also create additional materials for you as a commercial

service, with the understanding that all such works produced should become part of the core content and be published
under the same license.

1.1.5 Authors

¢ Riidiger Thiede - Rudi has written the QGIS instructional materials and parts of the PostGIS materials.

e Tim Sutton (tim@kartoza.com) - Tim has overseen and guided the project and co-authored the PostgreSQL
and PostGIS parts. Tim also authored the custom sphinx theme used for this manual.

* Horst Diister (horst.duester@kappasys.ch ) - Horst co-authored the PostgreSQL and PostGIS parts

¢ Marcelle Sutton - Marcelle provided proof-reading and editorial advice during the creation of this work.

1.1.6 Individual Contributors

Your name here!

1.1.7 Sponsors

 Cape Peninsula University of Technology

1.1.8 Source files and Issue reports

The source of this document is available at GitHub QGIS Documentation repository. Consult GitHub.com for
instructions on how to use the git version control system.

Despite our efforts, you could find some errors or miss some information while following this training. Please report
them at https://github.com/qgis/QGIS-Documentation/issues.

1.1.9 Latest Version

You can always obtain the latest version of this document by visiting the online version which is part of the QGIS
documentation website (https://docs.qgis.org).

Poznamka: The documentation website contains links to both online and PDF versions of the Training manual and
other parts of the QGIS documentation.
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1.2 About the exercises

Now that you know why you want to use QGIS, we can show you how.

Varovani: This course includes instructions on adding, deleting and altering GIS datasets. We have provided
training datasets for this purpose. Before using the techniques described here on your own data, always ensure
you have proper backups!

1.2.1 How to use this tutorial

Any text that looks like this refers to something that you can see in the QGIS user interface.
Text that looks » like » this directs you through menus.

This kind of text refers to something you can type, such as a command.
This/kind/of.text refers to a path or filename.

This+That refers to a keyboard shortcut comprised of two buttons.

1.2.2 Tiered course objectives

This course caters to different user experience levels. Depending on which category you consider yourself to be in,
you can expect a different set of course outcomes. Each category contains information that is essential for the next
one, so it’s important to do all exercises that are at or below your level of experience.

\ Basic

In this category, the course assumes that you have little or no prior experience with theoretical GIS knowledge or the
operation of GIS software.

Limited theoretical background will be provided to explain the purpose of an action you will be performing in the
program, but the emphasis is on learning by doing.

When you complete the course, you will have a better concept of the possibilities of GIS, and how to harness their
power via QGIS.

/ Intermediate

In this category, it is assumed that you have working knowledge and experience of the everyday uses of GIS software.

Building on the instructions for the beginner level will provide you with familiar ground, as well as to make you aware
of the cases where QGIS does things slightly differently from other software you may be used to. You will also learn
how to use analysis functions in QGIS.

When you complete the course, you should be comfortable with using QGIS for all of the functions you usually need
for everyday use.
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mm=— Advanced
In this category, the assumption is that you are experienced with GIS software, have knowledge of and experience
with spatial databases, using data on a remote server, perhaps writing scripts for analysis purposes, etc.

Building on the instructions for the other two levels will familiarize you with the approach that the QGIS interface
follows, and will ensure that you know how to access the basic functions that you need. You will also be shown how
to make use of the QGIS plugin system, database access, and so on.

When you complete the course, you should be well-acquainted with the everyday operation of QGIS, as well as its
more advanced functions.

1.2.3 Data

The sample data that accompanies this resource is freely available and comes from the following sources:
« Streets and Places datasets from OpenStreetMap (https://www.openstreetmap.org/)
* Property boundaries (urban and rural), water bodies from NGI (https://ngi.dalrrd.gov.za/)
e SRTM DEM from the CGIAR-CGI (http://srtm.csi.cgiar.org/)

Download the prepared dataset from the Training data repository and unzip the file. All the necessary data are provided
in the exercise_data folder.

If you are an instructor, and would like to use more relevant data, you will find instructions for creating local data in
the Preparing Exercise Data appendix.
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KAPITOLA 2

Module: Creating and Exploring a Basic Map

In this module, you will create a basic map which will be used later as a basis for further demonstrations of QGIS
functionality.

2.1 Lesson: An Overview of the Interface

We will explore the QGIS user interface so that you are familiar with the menus, toolbars, map canvas and layers list
that form the basic structure of the interface.

The goal for this lesson: To understand the basics of the QGIS user interface.
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211 \ Try Yourself: The Basics

*Basic Map - QGIS 0c62abed96 [tm]

SNSAHS
<
‘3

Layers | Browser
L Typet X | 1.egend entres removes. Coordinate| 20.3420,33.9989 |85 Scale|1:32869 |~ | @ Magnifier| 100%

2| Rotation

2| v Render @ EPsGi3zs @

The elements identified in the figure above are:
1. Layers List / Browser Panel
. Nastrojové listy

. Map canvas

2
3
4. Status bar
5. Side Toolbar
6

. Locator bar

\ The Layers List

In the Layers list, you can see a list, at any time, of all the layers available to you.

Expanding collapsed items (by clicking the arrow or plus symbol beside them) will provide you with more information

on the layer’s current appearance.

Hovering over the layer will give you some basic information: layer name, type of geometry, coordinate reference

system and the complete path of the location on your device.

Right-clicking on a layer will give you a menu with lots of extra options. You will be using some of them before long,

so take a look around!

Poznamka: A vector layer is a dataset, usually of a specific kind of object, such as roads, trees, etc. A vector layer

can consist of either points, lines or polygons.
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\ The Browser Panel

The QGIS Browser is a panel in QGIS that lets you easily navigate in your database. You can have access to common
vector files (e.g. ESRI Shapefile or Maplnfo files), databases (e.g. PostGIS, Oracle, SpatiaLite, GeoPackage or MS
SQL Server) and WMS/WES connections. You can also view your GRASS data.

If you have saved a project, the Browser Panel will also give you quick access to all the layers stored in the same path
of the project file under in the . Project Home item.
Moreover, you can set one or more folder as Favorites: search under your path and once you have found the folder,

right click on it and click on Add as a Favorite. Youshould then be able to see your folder in the Favorites
item.

Tip: It can happen that the folders added to Favorite item have a really long name: don’t worry right-click on the
path and choose Rename Favorite. .. to set another name.

\ Toolbars

Your most often used sets of tools can be turned into toolbars for basic access. For example, the Project toolbar allows
you to save, load, print, and start a new project. You can easily customize the interface to see only the tools you use
most often, adding or removing toolbars as necessary via the View » Toolbars menu.

Even if they are not visible in a toolbar, all of your tools will remain accessible via the menus. For example, if you
remove the Project toolbar (which contains the Save button), you can still save your map by clicking on the Project
menu and then clicking on Save.

\ The Map Canvas

This is where the map itself is displayed and where layers are loaded. In the map canvas you can interact with the
visible layers: zoom in/out, move the map, select features and many other operations that we will deeply see in the
next sections.

\ The Status Bar

Shows you information about the current map. Also allows you to adjust the map scale, the map rotation and see the
mouse cursor’s coordinates on the map.

\ The Side Toolbar

By default the Side toolbar contains the buttons to load the layer and all the buttons to create a new layer. But remember
that you can move all the toolbars wherever it is more comfortable for you.

2.1. Lesson: An Overview of the Interface 9
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\ The Locator Bar

Within this bar you can access to almost all the objects of QGIS: layers, layer features, algorithms, spatial bookmarks,
etc. Check all the different options in the locator_options section of the QGIS User Manual.

Tip: With the shortcut Ct r1+K you can easily access the bar.

2.1.2 \ Try Yourself 1

Try to identify the four elements listed above on your own screen, without referring to the diagram above. See if you
can identify their names and functions. You will become more familiar with these elements as you use them in the
coming days.

Answer

Refer back to the image showing the interface layout and check that you remember the names and functions of the
screen elements.

213 \ Try Yourself 2

Try to find each of these tools on your screen. What is their purpose?

=]
1. =5

2. 50
3. BN

4. ERender

5. mm

Poznamka: If any of these tools is not visible on the screen, try enabling some toolbars that are currently hidden.
Also keep in mind that if there isn’t enough space on the screen, a toolbar may be shortened by hiding some of its
tools. You can see the hidden tools by clicking on the double right arrow button in any such collapsed toolbar. You
can see a tooltip with the name of any tool by holding your mouse over the tool for a while.

Answer

1. Save as
Zoom to layer(s)
Invert selection

Rendering on/off

A

Measure line
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2.1.4 What’s Next?

Now that you are familiar with the basics of the QGIS interface, in the next lesson we will see how to load some
common data types.

2.2 Lesson: Adding your first layers

We will start the application, and create a basic map to use for examples and exercises.

The goal for this lesson: To get started with an example map.

Poznamka: Before starting this exercise, QGIS must be installed on your computer. Also, you should have
downloaded the sample data to use.

Launch QGIS from its desktop shortcut, menu item, etc., depending on how you configured its installation.

Poznamka: The screenshots for this course were taken in QGIS 3.4 running on Linux. Depending on your setup,
the screens you encounter may well appear somewhat different. However, all the same buttons will still be available,
and the instructions will work on any OS. You will need QGIS 3.4 (the latest version at time of writing) to use this
course.

Let’s get started right away!

2.2.1 \ Follow Along: Prepare a map

1. Open QGIS. You will have a new, blank map.

Untitled Project - QGIS [new]
Project Edit View Layer Settings Plugins Vector Raster Database Web Processing Help

DDERRRY @eLL " BP 3 b I
aSV./ "

Cror=s “® Recent Projects
PR B XY

GIE )
8 p
Ll
|

Favorites
» [5] Home
» O/
@ GeoPackage
# SpatiaLite
@ Postcls
P MssQL
2 pB2
@ WMS/WMTS
» @ XYZTiles
@ wes
& WFS
© ows
& ArcGisMapServer
&) ArcGisFeatureServer
3¢ GeoNode

Layers 2®
« i % T |7 3 gy

Q Type to locate (Ctrl+K) Ready Coordinate B sale| 11 ~| @ Magnifier| 100% < Rotation |0,0° = VIRender & EPSCi4326 @

2. The Data Source Manager dialog allows you to choose the data to load depending on the data type. We'll use

it to load our dataset: click the ‘5 Open Data Source Manager {34t
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If you can’t find the icon, check that the Data Source Manager toolbar is enabled in the View » Toolbars menu.

Untitled Project - QGIS [new] o

Project Edit View Layer Settings Plugins Vector Raster Database Web Progessing Help
DEERGRY O BP BHDR B EE =P
Mo ) = R 2

® B
Brows ©®  Recent Projects
QRYX®*O
Favoyjtes
» @ Homé
» o/
@ GeoPacRyge Data Source Manager | Browser
: Spatialite B
POSLGIS
5o LRTYH®He
> MssQL . g Vector .
@ o2 L ~ ¢ Favorites
@ WMS/WMTS » [ /media/TRAVAIL/2019/Controle
- % Raster
» @ XYZTiles » [6 Home
S wes 2% Mesh =
@ WFs . » @ GeoPackage
© ows o Delimited Text / spatiaLite
@ ArcGisMapServer @ Postals
@ ArcGisFeatureServer 4 Geopackage » MssQL
si¢ GeoNode - DB2
74 spatialite » @ WMS/WMTS
» @ XYZTiles
4 PostaresQL @ wes
@ wFs
= ows
@ ArcGisMapServer
@ ArcGisFeatureServer
i GeoNode
Layers @0 WA virtual Layer *
c@gwTE-BADL =
& wms/wmts
& wes
a WFS
&3 ArcGis Map Server
/2 ArcGIS Feature
s server
4 GeoNode
Q Type to locate (Ctrl+K) Ready Coordinate ¥ scle 11 ~| @ Magnifier | 100% | Rotation |00° 2|V Render @ EPSG4326 @

3. Load the protected_areas. shp vector dataset:

1. Click on the Vector tab.

2. Enable the - ® File source type.
3. Press the ... button next to Vector Dataset(s).

4. Select the exercise_data/shapefile/protected_areas.shp file in your training
directory.

5. Click Open. You will see the original dialog, with the file path filled in.
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B Browser

Vector

* Raster

</
_A_+ Mesh

* Delimited Text

"d GeoPackage

ey SpatialLite
* PostgreSQL
4 MSSQL

DB2
% DB2

m Virtual Layer

ﬁ WMS/WMTS
5@; WCs
g WFS
@ ArcGIS Map
# Server

ArcGIS Feature

Server

Data Source Manager | Vector
Source Type
(@ File ( Directory (' Database (' Protocol: HTTP(S), cloud, etc.
Encoding System -

Source

Vector Dataset(s) exercise_data/shapefile/protected_areas.shp

@Help < Add # Close

6. Click Add here as well. The data you specified will now load: you can see a protected_areas item
in the Layers panel (bottom left) with its features shown in the main map canvas.

*Untitled Project - QGIS [new]

Project Edit View Layer Settings Plugins Vector Raster Database Web Progessing Help

DEBRERRY UeLL /i BPPRPRA RN &0 -5-8-5,58#% I =-0-

LA AN A TN

Browser B®
GRTHO
Favorites
» (6] Home
y [0/
@ GeoPackage
/# spatiaLite
@ Postals
» MmssQL
I pB2
@ WMS/WMTS
» @ XYZTiles
@ wcs
@ WFS
© ows
& ArcGisMapServer
& ArcGisFeatureServer
s§¢ GeoNode

Layers B®
Qe TEFAL
1 protected areas

Q Type to locate (CErl+K) Ready

an
= o ® -
Coordinate|20.3631,33.8948 | 9 Scale 1:76050 ~ | & Magnifier | 100% | Rotation |0,0° 5 V| Render & EPsc4326 @
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Congratulations! You now have a basic map. Now would be a good time to save your work.

1. Click on the Save As button: #=£3

2. Save the map under a solution folder next to exercise_data andcallit basic_map.ggz.

2.2.2 \ Try Yourself

Repeat the steps above to add the places.shp and rivers.shp layers from the same folder
(exercise_data/shapefile) to the map.

Answer

In the main area of the dialog you should see many shapes with different colors. Each shape belongs to a layer you
can identify by its color in the left panel (your colors may be different from the ones in Obr. 2.1 below):

Project Edit View Layer Settings Plugins Vector Raster Database Web Processing Help
D DE? @‘:‘}E}aﬁ;}}f};\”) P ! El;: GQ %'D'g{‘é}zﬁ'o i
MRV 4/ BGR-FTSE B ~aE@%zuEn @ 2 ¢ K

Layers (=]
e T &~>F AL

v/ * places

v [ ] protected_areas

Layers = Browser AN

L Type to locate (Ctrl+K) Coordinate | 20.4061,-33.8952 | ¥ Scale | 1:108708 ~ | @ Magnifier| 100% 2| Rotation |0.0° +| v/ Render @ EPSC:43z6 @

Obr. 2.1: A basic map

223 \ Follow Along: Loading vector data from a GeoPackage Database

Databases allow you to store a large volume of associated data in one file. You may already be familiar with a database
management system (DBMS) such as Libreoffice Base or MS Access. GIS applications can also make use of databases.
GIS-specific DBMSes (such as PostGIS) have extra functions, because they need to handle spatial data.

The GeoPackage open format is a container that allows you to store GIS data (layers) in a single file. Unlike the
ESRI Shapefile format (e.g. the protected_areas. shp dataset you loaded earlier), a single GeoPackage file
can contain various data (both vector and raster data) in different coordinate reference systems, as well as tables
without spatial information; all these features allow you to share data easily and avoid file duplication.

In order to load a layer from a GeoPackage, you will first need to create the connection to it:

1. Click on the {5 Open Data Source Manager ¢,

2. On the left click on the @ GeoPackage tab.
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3. Click on the New button and browse to the t raining_data.gpkg file in the exercise_data folder
you downloaded before.

4. Select the file and press Open. The file path is now added to the Geopackage connections list, and appears in
the drop-down menu.

You are now ready to add any layer from this GeoPackage to QGIS.

1. Click on the Connect button. In the central part of the window you should now see the list of all the layers
contained in the GeoPackage file.

2. Select the roads layer and click on the Add button.

Data Source Manager | GeoPackage

I srowser Connections
- g Vector training_data.gpkg@/media/sf_GitHub/QGIS-Training-Data/exercise_data/training_data.gpkg -
4 Raster New Remove
XU/
=pili=el Table > Type Geometry column Sql
Delimited Text v /media/sf GitHub/QGIS-Training-Data/exercise data/training data.gpkg
= buildings = MultiPolygon geom
roads " LineString  geom
T SpatialLite
+ PostgresQL
* MSSQL
0B2
s DB2
' Virtual Layer
[\/] y
@ WMS/WMTS
£ wes
|y WFS q ’

#
Also list tables with no geometry

¥# ArcGIS Map Server

ArcGIS Feature Search options

&# server
& GeoNode @Help setFilter || «/Add % Close

A roads layer is added to the Layers panel with features displayed on the map canvas.
3. Click on Close.

Congratulations! You have loaded the first layer from a GeoPackage.

224 \ Follow Along: Loading vector data from a SpatiaLite Database with
the Browser

QGIS provides access to many other database formats. Like GeoPackage, the SpatiaLite database format is an
extension of the SQLite library. And adding a layer from a SpatiaLite provider follows the same rules as described
above: Create the connection —> Enable it —> Add the layer(s).

While this is one way to add SpatiaLite data to your map, let’s explore another powerful way to add data: the Browser.
1. Click the ‘! icon to open the Data Source Manager window.

2. Click on the = Browser tab.

3. In this tab you can see all the storage disks connected to your computer as well as entries for most of the tabs
in the left. These allow quick access to connected databases or folders.
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For example, click on the drop-down icon next to the 0 GeoPackage entry. You'll see the
training-data.gpkg file we previously connected to (and its layers, if expanded).

4. Right-click the f SpatiaLite entry and select New Connection....

5. Navigate to the exercise_data folder, select the landuse.sglite file and click Open.
Notice that a @ landuse.sqglite entry has been added under the SpatiaLite one.

6. Expand the @ landuse.sqlite entry.

7. Double-click the -~ landuse layer or select and drag-and-drop it onto the map canvas. A new layer is added
to the Layers panel and its features are displayed on the map canvas.

Data Source Manager | Browser

| Browser SoTneE
Py O2THO
- g Vector i Favorites
» [® Project Home
Raster
* » [&] Home
A% Mesh v O/
» ~ @ GeoPackage
o Delimited Text ¥ & training_data.gpkg
_ 9 buildings
‘ﬁ GeoPackage V" roads

~ / SpatiaLite

i"'; SpatiaLite ~ = landuse.sqlite

& PostgresQL @ PostGls
P mssQL
& MsSsQL = pB2
@ WMS/WMTS
082, DB2 v @ XYZ Tiles
A & OpenStreetMap
m Virtual Layer @ wes
. i WFS
A A —
\ﬁl_ WMS/WMTS © ows
_:@; WCS 6? ArcGisMapServer
& ArcGisFeatureServer
Ly WFS s}t GeoNode

ArcGIS Map Server

ArcGIS Feature
&/% Server

+

» GeoNode

Tip: Enable the Browser panel in View » Panels » and use it to add your data. It’s a handy shortcut for the Data
Source Manager » Browser tab, with the same functionality.

Poznamka: Remember to save your project frequently! The project file doesn’t contain any of the data itself, but it
remembers which layers you loaded into your map.
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2.25 / Try Yourself Load More Vector Data
Load the following datasets from the exercise_data folder into your map using any of the methods explained
above:

* buildings

* water

Answer
Your map should have seven layers:
* protected_areas
e places
* rivers
* roads

* landuse

buildings (taken from training_data.gpkg) and

water (taken from exercise_data/shapefile).

2.2.6 Follow Along: Reordering the Layers

The layers in your Layers list are drawn on the map in a certain order. The layer at the bottom of the list is drawn
first, and the layer at the top is drawn last. By changing the order that they are shown on the list, you can change the
order they are drawn in.

Poznamka: You can alter this behavior using the Control rendering order checkbox beneath the Layer Order panel.
‘We will however not discuss this feature yet.

The order in which the layers have been loaded into the map is probably not logical at this stage. It’s possible that the
road layer is completely hidden because other layers are on top of it.

For example, this layer order...

Layers (=]ES]
< .@ ®, T & (£ S g

v [] water

v [ buildings

v/ [ landuse

v — roads

v — rivers

v/ * places

v [] protected_areas

... would result in roads and places being hidden as they run underneath the polygons of the landuse layer.
To resolve this problem:

1. Click and drag on a layer in the Layers list.

2. Reorder them to look like this:

2.2. Lesson: Adding your first layers 17
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basic_map - QGIS
Project Edit View Layer Settings Plugins Vector Raster Database Web Help

DEARRERY OBALLAHPPLAAREDNRE &6 K-N-5,0E I m- -
REV.A® # /B R S@<0 0 “qE%% 3 s ® @

Layers B
o m T g~ »
places
v/ — roads
v| — rivers
v! [ buildings
V! [ water
v| [] protected_areas
v/ [l landuse

Layers | Browser

Q Type to locate (Ctrl+K) - Cnn’rdinala 20.4981,33.9741 |9 scale| 1:56077 ~| @ Magniﬁer Rotation | 0.0% :I v Render ¢ EPSG4326 @
You'll see that the map now makes more sense visually, with roads and buildings appearing above the land use regions.

2.2.7 In Conclusion

Now you’ve added all the layers you need from several different sources and created a basic map!

2.2.8 What’s Next?

Now you're familiar with the basic function of the Open Data Source Manager button, but what about all the others?
How does this interface work? Before we go on, let’s take a look at some basic interaction with the QGIS interface.
This is the topic of the next lesson.

2.3 Lesson: Navigating the Map Canvas

This section will focus on basic QGIS navigation tools used to navigate within the Map Canvas. These tools will allow
you to visually explore the layers at different scales.

The goal for this lesson: Learn how to use Pan and Zoom tools within QGIS and learn about map scale.

2.3.1 \ Follow Along: Basic Navigation Tools

Before learning how to navigate within the Map Canvas, let’s add some layers that we can explore during this tutorial.

1. Open a new blank project and using the steps learnt in Create a Map, load the previously seen
protected_areas, roads and buildings layers to the project. The result view should look similar to
the snippet in Obr. 2.2 below (colors do not matter):
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Q

O RN (UL HPP QY LT @ N-8-LhEHE -
BQVA®D  / = %= - @ @
9 12 px

Browser (=]
OR2THO
v [ VirtualBox
¢ vscode
’ 3D Objects
¢ Anaconda3
» AppMods
¢ Autodesk
» Contacts
¢ Desktop
» Documents
b Downloads
Dropbox (BOSTON UNIVERSITY)
1 eclipse
+ [ eclipse-workspace
Layers
o @ ® T &~8 0
v roads
v| [l buildings
v| [ protected areas

R )2
DoomnoooooOol

b

2

—

L Type to locate (Ctrl+K) 1leg 1| 20.2255-34.0416 |¥ ¢ 1:110950 |~ | @ r|100% $ 3 00¢ 3| V| Render @ gpsGi43ze @

Obr. 2.2: Protected areas, roads and buildings added

Let’s first learn how to use the Pan Tool.

1. In the Map Navigation Toolbar, make sure the @ Pan button is activated.
2. Move the mouse to the center of the Map Canvas area.
3. Left-click and hold, and drag the mouse in any direction to pan the map.

Next, let’s zoom in and take a closer look at the layers we imported.

1. In the Map Navigation Toolbar, click on the 4*+’ Zoom In bystton,
2. Move your mouse to approximately the top left area of where there is the highest density of buildings and roads.
3. Left click and hold.

4. Then drag the mouse, which will create a rectangle, and cover the dense area of buildings and roads (Obr. 2.3).
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Obr. 2.3: Zoom in

5. Release the left click. This will zoom in to include the area that you selected with your rectangle.
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@ *Untitled Project - QGIS — O X
Project Edit View Layer Settings Plugins Vector Raster Database Web Mesh Help

DoBRREY IVPLHAPPI KA EBEOR &¢ K-8, EE-
AL AYAN' N NN L =4 ReE - R 4 H
OV E_FHe Y :

Browser (=]
QRETHO

b [ VirtualBox =
v [ wscode

b [ 3D Objects
+ [ Anaconda3
+ [ AppMods

v [ Autodesk
»

v

»

Y

»

»

[ Contacts

5 Desktop

[1 Documents 7

[ Downloads L= T

1 Dropbox (BOSTOMN UNIVERSITY) -

[ eclipse ]
|+ [ eclipse-workspace
Layers =] . X
i » T &8 7 O i

— roads : 7.6 -
M buildings ' - ol .-
[T protected areas ;

1]

[ Q Type tolocate (Ctr+K) | 1 204849,-33.9843 |¥ /132458 v | @ r[100% |5 3 [00°  [5][v/Render @ ePsciaize @

6. To zoom out, select the }9 Zoom Out byytton and perform the same action as you did for zooming in.

As you pan, zoom in, or zoom out, QGIS saves these views in a history. This allows you to backtrack to a previous
view.

1. In the Map Navigation Toolbar, click on ;a Zoom Last hytton to go to your previous view.

2. Click on }a Zoom Next bytton to proceed to move forward in your history.
Sometimes after exploring the data, we need to reset our view to the extent of all the layers. Instead of trying to use
the Zoom Out tool multiple times, QGIS provides us with a button to do that action for us.

1. Click on the ﬂ Zoom Full Extent tyyon,

As you zoomed in and out, notice that the Scale value in the Status Bar changes. The Scale value represents the Map
Scale. In general, the number to the right of : represents how many times smaller the object you are seeing in the Map
Canvas is to the actual object in the real world.
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Coordinate  20.6324,-34.0757 - Scale 1:128472 ~ | & Magnifier 100% +| Rotation |0.0° 5| v/ Render X @

You can also use this field to set the Map Scale manually.
1. In the Status Bar, click on the Scale textfield.

2. Type in 50000 and press Enter. This will redraw the features in the Map Canvas to reflect the scale you
typed in.

3. Alternatively, click on the options arrow of the Scale field to see the preset map scales.

£
1:1000000 =

1:500000
1:250000
1:100000
1:50000
1:10000
1:5000
1:2500
1:1000 '~
b Scale|1:50000 v

4. Select 1:5000. This will also update the map scale in the Map Canvas.

Now you know the basics of navigating the Map Canvas. Check out the User Manual on Zooming and Panning to
learn about alternative ways of navigating the Map Canvas.

2.3.2 In Conclusion

Knowing how to navigate the Map Canvas is important, as it allows one to explore and visually inspect the layers.
This could be done for initial data exploration, or to validate output of a spatial analysis.

2.4 Lesson: symbolika

Symbolika vrstvy je jeji zobrazeni na mapé€. Zdkladni sila GIS ve srovnani s jinymi zpUsoby, jak zobrazovat data
pomoci prostorovych aspektt je to, Ze s GIS mate dynamické vizudlni znazornéni dat, se kterym pracujete.

Proto, je vizudlni vzhled mapy (ktera zavisi na symbolice jednotlivych vrstev), velmi dtlezity. Koncovy uZivatel map
by mél byt schopen snadno poznat, co mapa znazorfiuje. Stejné tak je dtleZité, mit mozZnost zkoumat data, se kterymi
pracujete a dobrd symbolika vam v tom hodné pomuze.

Jinymi slovy, mit vhodnou symboliku nemate pouze pro luxus nebo kvtli krase. Ve skutecnosti je to nezbytné, pro
spravné pouzivani GISu a vytvareni map a informaci, které budou lidé moci pouZivat.

Cil této lekce: Byt schopen vytvorit libovolnou symboliku, kterou chcete pro jakoukoli vektorovou vrstvu.
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2441 \ Follow Along: zména barev

Chcete-li zménit symboliku vrstvy, oteviete :guilabel: Layer Properties. Zacnéte tim, Ze zménite barvu: guilabel:
vrstva landuse.

1. Right-click on the landuse layer in the layers list.

2. Select the menu item Properties... in the menu that appears.

Poznamka: Ve vychozim nastaveni mizete také jit do vlastnosti vrstvy dvojitym kliknutim na vrstvu
V seznamu Vvrstev.

Tip: The d button at the top of the Layers panel will open the Layer Styling panel. You can use this panel
to change some properties of the layer: by default, changes will be applied immediately!

3. In the Layer Properties window, select the % Symbology tab:

Layer Properties - landuse | Symbology

v |

| = single symbol
@ rnformaton | 0 |&i

. [ simple fill

3 source

& symbology
€™ Labels
€D Masks Unit | Millimeters ~|
- Opacity 71/1000% |+
1 Diagrams d
Color | H

Ng 3D View

E Fields

E Attributes Form

| @ Favorites - | &
Joins
ﬁ Auxiliary Storage -| -
@ Actions ) . . . .
gradient gray 3 fill hashed black / hashed black,  hashed black X outline blue outline green outline red
L
, Display plasma
y Rendermg . @ - - -
L
Variables
. outline xpattern pattern dot pattern zelda simple blue fill  simple green fill  simple red fill
a Metadata black
®& Dependencies (== |save symbol... || Advanced ~|
Legend b Layer Rendering
58 qais server _| @Help || style - | «/Apply | % cancel | ’ /oK ]

4. Click the color select button next to the Color label. A standard color dialog will appear.
5. Vyberte Sedou barvu a kliknéte na OK.

6. Kliknutéte znovu na OK v okné€ Layer Properties a uvidite, Ze se zména barvy aplikuje na vrstvu.
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2.4.2 \ Try Yourself

Change the color of the water layer to light blue. Try to use the Layer Styling panel instead of the Layer Properties
menu.

Solution

 Verify that the colors are changing as you expect them to change.

« It is enough to select the water layer in the legend and then click on the (\{ Open the Layer Styling panel by top,
Change the color to one that fits the water layer.

symbology - QGIS

Project Edit View Layer Settings Plugins Vector Raster Database Web Help
NEEBREY (AL HPPRAARBRIR 6 K B -LEEE = - I-
ROV AR F/BRR-ZT =60 "AEHNERTT R A

Layers [E3] Layer styling i3]
<8l TE-B »

(- water -

& | = single symbol -

] simple fill

landuse

m

v|[] water
|

v

Unit Millimeter -
Opacity == 100.0% =

Color W

. Favorites a |~ &f

» Layer Rendering

Layers | Browser b | e v Live update | «/ Apply

L Type to locate (Ctrl+K) Coordinate | 20.5265-33.9850 | Scale 1:50008 ~ | @ Magnifier 100% < | Rotation |0.0° +| v Render @ EPsc4326 @

If you want to work on only one layer at a time and don’t want the other layers to distract you, you can hide a layer
by clicking in the checkbox next to its name in the layers list. If the box is blank, then the layer is hidden.

243 \ Follow Along: zména struktury symboliky
To je velmi dobrd véc, ale v symbolice vrstvy je vice neZ jen barva. Ddle chceme vyloucit hranice mezi riznymi
oblastmi vyuziti pudy tak, aby mapa byla co nejméné vizualné zaplnéna.
1. Otevieme okno Layer Properties pro vrstvu landuse.
Under the (\{ Symbology tab, you will see the same kind of dialog as before. This time, however, you’re doing
more than just quickly changing the color.
2. In the symbol layers tree, expand the Fill dropdown and select the Simple fill option.
3. Click on the Stroke style dropdown. At the moment, it should be showing a short line and the words Solid Line.

4. Zméiite je na No Pen.
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Layer Properties - landuse | Symbology

| = Single symbol -]

(4 Information > [ Fill |E|

Simple Fill
N :
AN Source e
Q2]
ﬂ' symbology
€3 Labels
5 Masks symbol layer type| Simple Fill v |
: i .
" Diagrams Fill color | H =
Fill skyl Solid v
Wf 3D View syle | -| =
stroke color | (NN - =,
B Fielas B
Stroke width | 0,260000 2| Mmillimeters  ~ | &,
E Attributes Form
Stroke style | No Pen '| LEH
o] Joinstyle | T Bevel M=
ﬂ Auxiliary Storage % | 0,000000 |:
Offset ' Millimeters - |
@ Actions y  0,000000 2]
@ oisplay v| Enable symbol layer €=, Draw effects
q. Rendering
P Layer Rendering
Variables _| @nelp || style - | «/Apply || % cancel |[ < oK ]

5. Kliknéte na OK.

Nyni vrstva :guilabel:"landuse nebude mit mezi plochami Zadné linie.

24.4 \ Try Yourself

* Change the water layer’s symbology again so that it has a darker blue outline.

* Zméiite symbologii vrstvy rivers na vhodné zndzornéni vodstva.

Remember: you can use the d Open the Layer Styling panel 1y,tton and see all the changes instantly. That panel also allows
you to undo individual changes while symbolizing a layer.

Answer

Your map should now look like this:
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symbology - QGIS 0

Project Edit View Layer Settings Plugins Vector Raster Database Web Help
0 B (e, HPPLARRINLS &6 N-N-GEHE I - [T
REV.AR J/BVER-ZT BB =4 HEB3%T R 2 « K

@® Layer Styling =[]
® /" rivers -
& = Single symbol -
v b 5 — Simple line
areas D
8 ' K
= B
Q & O allw
{
= e unit  Millimeter x|~
N Opacity _1/100.0 % =
’ color | NN
Wwidth | 0.36000 ERES
<. Favorites a |- a
» Layer Rendering
Layers | Browser b e V| Live update | « Apply
Q Type to locate (Ctrl+K) Coordinate  20.3963-34.0335 | 9§  Scale | 1:51337 ~ | @ Maagnifier| 100% 2| Rotation |0.0° || Render ¢ EPSG:4326 @

If you are a Beginner-level user, you may stop here.
 Use the method above to change the colors and styles for all the remaining layers.
* Try using natural colors for the objects. For example, a road should not be red or blue, but can be gray or black.

* Also feel free to experiment with different Fill style and Stroke style settings for the polygons.

symbology - QGIS
Project Edit View Layer Settings Plugins WVector Raster Database Web Help

NEEBRREY NE,sNPPAAGBEIS 66 -0 - B8 e -
BV A y/BRER-ZTd<8 B o g e E o on = @A x

Layers ® Layer Styling ®
|0 e T & -8 » - 7 buildings -
Vi 8 places = Single symbol -
v/ — roads nd
7 — rteere __F
v! [l buildings W simple fill
v| [ | water | " .
v || protected_areas , ML ¢ i "l
v landuse
’, 7 & ol[a|[¥
<4 =
i unit  Millimeter |~
Opacity _1/100.0 % -
Color I
. Favorites a|-| &
P Layer Rendering
Layers | Browser / LIS V| Live update | « Apply
Q Type to locate (Ctrl+K) Coordinate| 20.5355-33.9815 |5 Scale 1:53664 ~ | @ Magnifier 100% ~| Rotation |0.0° +| v Render @ Epsc:4326 @
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24.5 / Follow Along: viditelnost zavisla na méfritku

Nekdy zjistite, Ze vrstva neni vhodna pro dané méfitko. Naptiklad soubor dat ze vSech kontinentti miZe mit nizky
detail, a nemusi byt velmi presny na trovni ulic. KdyzZ se to stane, budete chtit mit moznost, datovou sadu v nevhodnych
méfitkach, skryt.

In our case, we may decide to hide the buildings from view at small scales. This map, for example...

symbology - QGIS 3

Project Edit View Layer Settings Plugins Vector Raster Database Web Help

DEEREBRY Q2L HPPLAlBOR Q6 N-R-EHE D &-6 -

5 Sl @p = J o= ne i @y (ahe| (abgl ‘abgl abe 5

L LAV A N NE-R.Y, £ @O =B B e Gy [ g agl oy wg ®R 2 H w X
Layers (2]
AT EH >

v| * places

v — roads

v — rivers

v ; buildings

V| [ | water

v protected

v landuse

Layers | Browser

Q Type to locate (Ctrl+K) sordinal| 207122339589 |% zal|1:150104 |~ | @ agnifi 100% | otatic |0.0° <| ¥/ Render & EPSG:4326 @

My

... neni velmi uZite¢nd. Budovy jsou v tomto méfitku tézko rozliSitelné.
Chcete-li povolit vykreslovani zaloZené na méfitku:

1. Oteviete dialog Layer Properties pro vrstvu buildings.

2. Activate the f Rendering tab.
3. Enable scale-based rendering by clicking on the checkbox labeled Scale dependent visibility:
4. Change the Minimum value to 1:10000.
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Layer Properties - buildings | Rendering >

v |v| Scale Dependent Visibility

Minimum (exclusive) Maximum (inclusive)
4= [1:10000 - |[&| P o - ||m

v Simplify Geometry

"}’ Information

" Source

T

% Symbology
Note: Feature simplification may speed up rendering but can result in rendering inconsistencies

S Simplification threshold (higher values result in more simplification) 1,00 <! pixels

€D Masks simplification algorithm Distance ~
Diagrams

‘4; 3D View Maximum scale at which the layer should be simplified (1:1 always simplifies) | 1:1 -

E Fields Force layer to render as a raster (may result in smaller export file sizes)

E Attributes Form Refresh layer at interval (seconds)

, Refresh layer on notification
Joins

ﬁ Auxiliary Storage
{;'.-Q Actions
, Display

@’ Rendering

5. Kliknéte na OK.

Otestujte Gcinky tak, Ze pfibliZite a oddalite ve vasi map¢€, dokud nezaznamenéte, Ze vrstva buildings vrstva zmizi
a znovu se objevi.

Poznamka: MizZete pouZit koleCko mysi pro zvySeni ptibliZzeni. MiiZete pouZit alternativni néstroje, pro pfibliZzovani
v okné:

Y=

2.4.6 / Follow Along: pfidavani vrstev symboliky
toto umoziiuje provést pomoci vrstev symbolii.
1. Go back to the landuse layer’s symbol properties panel (by clicking Simple fill in the symbol layers tree).

V tomto prikladu nemad aktudlni symbol Zadny obrys (to znamend, Ze pouziva styk ohraniceni No Pen).
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Layer Properties - landuse | Symbology

| = Single symbol -]

(4 Information > [ Fill |E|

Simple Fill
N :
AN Source e
Q2]
ﬂ’ symbology
€A Labels
5 Masks symbol layer type| Simple Fill -
: i .
' Diagrams Fill color | H L=
Fill skyl Solid v
Wf 3D View syle | -| =
stroke color | (NN - =,
B Fielas -
Stroke width | 0,260000 2| Mmillimeters  ~ | &,
E Attributes Form
Stroke style | No Pen '| LEH
o] Joinstyle | T Bevel M=
E_’. Auxiliary Storage x | 0,000000 E
Offset ' Millimeters - |
@ Actions y  0,000000 2]
@ oisplay v| Enable symbol layer €=, Draw effects
& f Rendering
P Layer Rendering
Variables _| @Help || style ~| | «/Apply || % cancel |[ «/ OK ]

2. Select the Fill level in the tree and click the Ifl-l:l-l:| Add symbol layer ytton, The dialog will change to look something
like this, with a new symbol layer added:
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Layer Properties - landuse | Symbology >

= Single symbol =
"’;’ Information ~ H Fill
Simple Fill =l
33 source [X simple Fill .
' =E
& symbology
€= Labels
symbol layer type Simple Fill -
D Masks Y ver typ s
. i O
S Fill color [=h
Fill style I solid -
WF 3D View 2 &
stroke color | [ - <.
E Fields
Stroke width | 0,260000 @ |7 |Millimeters K =N
E Attributes Form —
Stroke style | ——Solid Line - | €
Joins Join style 1 Bevel K=
ﬁ Auxiliary Storage x | 0,000000 -
Offset Millimeters -
U_@ Actions y | 0,000000 =
® oisplay v| Enable symbol layer 4=, Draw effects
Qj,/ Rendering
» Layer Rendering
e dblee @Help Style -~ « Apply || % cancel «/ OK

-

It may appear somewhat different in color, for example, but you’re going to change that anyway.

Ted je tu druhd vrstva symbold. Kdyby byla jednobarevnd, tak by samozifejmé tplné zakryvala predchozi druh
symbolu. Navic, ma styl hranice Solid Line, coz nechceme. Je zfejmé, Ze tento symbol musi byt zménén.

Poznamka: Je dileZité, nesplést si mapovou vrstvu a vrstvu symboli. Mapova vrstva je vektor (nebo rastr), ktery byl
nacten do mapy. Vrstva symboli je soucasti symbolu, pouZitého pro zobrazeni mapové vrstvy. Tento postup obvykle
oznacuje mapovou vrstvu jen jako vrstvu, ale vrstva symboldl bude vZdy nazyvana jako vrstva symboldl, aby nedoslo
k nedorozuméni.

With the new Simple Fill symbol layer selected:
1. Nastavte styl ohraniCeni No Pen tak, jako predtim.

2. Zméiite styl vyplné na néco jiného nez Solid nebo No brush. Naptiklad:
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Layer Properties - landuse | Symbology

- |

| = single symbol

fi' Information ~ [ Fill |§|

Simple Fill — =
‘:{:\\ Source [T simple Fill :i: :l:
: Q|| a
& symbology -
€= Labels
€D Masks symbol layer type| Simple Fill - |
: i (.
S Fill color | H <
Fill skyl i cross -
WF 3D View term | _| =
stroke color | (. - <.
E Fields -
Stroke width | 0,260000 @ || Millimeters  ~ | &,
E Attributes Form
Stroke style | No Pen - &
Joins Joinstyle | T Bevel - &
E’. Auxiliary Storage % | 0.000000 |:
Offset | Millimeters - |
L Actions y |0,000000 S ——
® oisplay v| Enable symbol layer =, Draw effects
&  Rendering
» Layer Rendering
Variables _| @Help || style ~| | «/Apply || % cancel H «/ OK ]

3. Kliknéte na OK.

Now you can see your results and tweak them as needed. You can even add multiple extra symbol layers and create
a kind of texture for your layer that way.

O | o |
i simple Fill
1T simple Fill
] simple Fill

Je to zdbava! Ale ma to pravdépodobné prili§ mnoho barev pro pouZiti v redlném map¢. ..

247 / Try Yourself

Pamatujte na pfiblizeni v pripad€ potieby, vytvoite jednoduchou, ale nezneklidiiujici texturu pro vrstvu buildings,
za pouZiti vySe uvedené metody.

Answer

Customize your buildings layer as you like, but remember that it has to be easy to tell different layers apart on the
map.

Here’s an example:
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symbology - QGIS
Project Edit View Layer Settings Plugins Vector Raster Database Web Help

DoBRREEY Ve, HPRLLALBMNR & N-A-EHEE -
BV AW J/BRR-ZT<2HBHoe T2QE =2 - R &4 B &

Layers
« @ ® T & -8 &L =

* places

— roads

— rivers

[7] buildings

|:| water

[] protected_areas

[ landuse

Layers | Browser

[ 2 Type to locate (ctrl+K) | 1| 2045020-3401345 | 2| 1:5000

|vl & rf100% EEREXS || v Render @ Epsgezs @

248 / Follow Along: usporadani urovni symbolu

Jsou-li vrstvy symboll poskytované, jsou také poskytované v poradi, podobnym zplisobem, jakym jsou poskytované
ruzné mapové vrstvy. To znamend, Ze v nékterych piipadech, pokud mame mnoho vrstev symbolti v jednom symbolu,
miZe to vést k neocekavanym vysledktim.

1. Dejte vrstvé roads jednu vrstvu symboll navic (metodou pro ptidani vrstvy symbold, kterd byla znazornéna
vyse).
2. Give the base line a Stroke width of 1.5 and a black color.

3. Give the new, uppermost layer a thickness of 0. 8 and a white color.

Vsimnéte si, Ze se stane toto:
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Well, roads have now a street like symbology, but you see that lines are overlapping each others at each cross. That’s
not what we want at all!

Chcete-li zabranit, aby se toto stalo, miiZete setfidit Grovné symboll a tim fidit poradi, ve kterém jsou rizné vrstvy
symbolll poskytované.

To change the order of the symbol layers:
1. Select the topmost Line layer in the symbol layers tree.

2. Click Advanced w Symbol levels... in the bottom right-hand corner of the window.
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Layer Properties - roads | Symbology B

Q = single symbol =
@ information %
simple line
33 source == Simple line
& symbology
€€ Labels
Unit Millimeters >
B Masks .
Opacity _11100,0% v
", Disgrams Color | -
@& .
3D View
alg width | 1,50000 =RES
E Fields
. (73
E Attributes Form . Favorites a|~| 8
Joins
E_'i Augxiliary Storage
{;'.-® Actions dash black dash blue dash green dash red
- Display Sl v
i Save Symbol...
4 Rendering Symboly evels...

_ b Layer Rendering v| Clip Features to Canvas Extent
Variables _ | @Help Style ~ « Apply || % Cancel < OK

This will open a dialog like this:

symbol Levels x

Enable symbol levels

Define the order in which the symbol layers are rendered. The numbers
in the cells define in which rendering pass the layer will be drawn.

@Help % Cancel

3. Check A Enable symbol levels. You can then set the layer order of each symbol by entering the corresponding
level number. O is the bottom layer.
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In our case, we just want to activate the option, like this:

Symbol Levels

Enable symbol levels

Define the order in which the symbol layers are rendered. The numbers
in the cells define in which rendering pass the layer will be drawn.

Layer 0 Layer 1
= () 1

% cancel |[_Jok_|

This will render the white line above the thick black line borders:
4. Kliknéte dvakrat na OK pro ndvrat do mapy.

Mapa nyni bude vypadat takto:

N\

When you're done, remember to save the symbol itself so as not to lose your work if you change the symbol again

in the future. You can save your current symbol style by clicking the Save Style... button at the bottom of the Layer
Properties dialog. We will be using the QGIS QML Style File format.
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Save your style in the solution/styles/better_roads.qgml folder. You can load a previously saved style
at any time by clicking the Load Style... button. Before you change a style, keep in mind that any unsaved style you
are replacing will be lost.

24.9 / Try Yourself

Zmérite vzhled z vrstvy roads znovu.

Make the roads narrow and yellow, with a thin, pale gray outline and a thin black line in the middle. Remember that
you may need to change the layer rendering order via the Advanced » Symbol levels... dialog.

Answer

To make the required symbol, you need three symbol layers:

Layer Properties - roads (triple_levels) | Symbology

| 2 single symbol

@ information | tine __ ________________

— Simple line
:{:\1_- Source simple line
== Simple line
& symbology
€2 Labels —
| | ollallw
Diagrams
~ unit | Millimeter - |
N 3D View s 1/1000% %/
E SourceFields eCoal ]
Attributes <
Form width | 2.10000 EKES
Joins
L Auxiliary | 2 Favorites ~| 8
&1 storage .
@ Actions
© [EEE T PRI PP T —
- Display
‘ Rendering dash black dash blue dash green dashred effect emboss effect neon
Varisbles Ell= |save Symbol| | Advanced ~|
ak Metadata
P Layer Rendering
T Dependencies .| @Help || style - | JApply || ®cancel || ok |

The lowest symbol layer is a broad, solid gray line. On top of it there is a slightly thinner solid yellow line and finally
another thinner solid black line.
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If your symbol layers resemble the above but you’re not getting the result you want:

1. Check that your symbol levels look something like this:

symbol Levels

Enable symbol levels

Define the order in which the symbol layers are
rendered. The numbers in the cells define in which
rendering pass the layer will be drawn.

Layer 0 Layer 1 Layer
= . 1 — 2

1] v

 cancet | [_J0_|

2. Now your map should look like this:

2410 a Try Yourself

Symbol levels also work for classified layers (i.e., layers having multiple symbols). Since we haven’t covered
classification yet, you will work with some rudimentary pre-classified data.

1. Create a new project and add only the roads dataset.

2. Apply the style file advanced_levels_demo.qgml provided in exercise_data/styles to the

layer. This can be done through the Style » Load Style... combobox at the bottom of the Layer Properties
dialog.
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3. PfibliZte na oblast Swellendam.
4. Pouzitim vrstev symbolil zajistéte, aby do sebe obrysy vrstev zapadly, jako na obrazku nize:

N SRS 27
()

-

[ =

S\ > —J
R (

=3
>,
N\,
%O%h (¢
==

P

Answer

1. Adjust your symbol levels to these values:

symbol Levels X

v Enable symbol levels

Define the order in which the symbol layers are
rendered. The numbers in the cells define in which
rendering pass the layer will be drawn.

Layer 0 Layer 1
| Trunk [ [ 3
—|Tertiary - 2
=|Unclassified =0 1

@Help # Cancel

1. Experiment with different values to get different results.

2. Open your original map again before continuing with the next exercise.
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2.4.11 / Follow Along: typy vrstev symbolu

In addition to setting fill colors and using predefined patterns, you can use different symbol layer types entirely. The
only type we’ve been using up to now was the Simple Fill type. The more advanced symbol layer types allow you to
customize your symbols even further.

Kazdy druh vektoru (bod, linie a polygon) ma svoji vlastni sadu typl vrstvy symbolti. Nejprve se podivime na typy,
které jsou k dispozici pro body.

Typy vrstev symboll pro body

1. Uncheck all the layers except for places.

2. Zméiite nastaveni symbolil pro vrstvu places:

Layer Properties - places | Symbology
| = single symbol ]

'ri Information

® Simple marker

A3 source

.Q’ symbology

€3 Labels

€D Masks Unit | Millimeters -
Opacity 1| 100,0 % |._|
Size | 2,00000 |:| L EE
E Fields Rotation | 0,00 ° BE=1

E Attributes Form | O Favorites al-| 8

- .
. Diagrams

Color |

N7 3D View

Joins

I'ﬁ Auxiliary Storage ® O @ O O %

@ Actions

- Display shadow

dot black dot white dot blue dot green dot red effect drop

4 Rendering B @ ®

Variables

N shield disability topo hospital  topo pop capital
a Metadata

ﬁ Dependencies |_| = |save Symbol... | |Advanced - |

» Layer Rendering
.| @Help || style -  Japply || Xcancel || JoOK |

3. You can access the various symbol layer types by selecting the Simple marker layer in the symbol layers tree,
then click the Symbol layer type dropdown:
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Layer Properties - places | Symbology

Q = Single symbol -

Ellipse marker

fi Information

Filled marker

15
W Source Font marker

(0t}

& symbology Geometry generator

Mask

€3 Labels .
Raster image marker —

O Masks symbol layer type[STiTE El TN

- : . SVG marker
. [MELEINE Size .
Vector field marker
Np 3D View Fill color N | S
E Fields stroke color | (I - <.
E Attributes Form Stroke style | —— Solid Line ~| &
. Stroke width | Hairline || Millimeters ~| &
Joins
. Join style 5 Bevel ~| S
ﬂ Augxiliary Storage
Rotation 0,00° = EL
o actions 0,000000 =
) X0, -
® Display Offset Millimeters ~| &
y | 0,000000 =
rd .
4  Rendering VCenter MRS
Anchor point
VELELIES . HCenter -~ &
[ Metadata
& OCO0AAKXT@++X 1| > D
ﬁ Dependencies £ a O O |_| I\ /] “ a -

P Layer Rendering

@Help Style - «/ Apply || % Cancel

4. Prozkoumejte riizné moznosti, které mate k dispozici a zvolte si symbol se stylem, jaky je podle vas vhodny.

5. If in doubt, use a round Simple marker with a white border and pale green fill, with a Size of 3. 00 and a Stroke
width of 0. 5.

Typy vrstev symbolt pro linie

Chcete-li zobrazit riizné moznosti, které jsou k dispozici pro liniova data:

1. Change the Symbol layer type for the roads layer’s topmost symbol layer to Marker line:
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"i Information

-?& Source

Q’ Symbology

€= Labels

B Masks

: Diagrams

N7 3D View

E Fields

E Attributes Form

Joins

ﬁ Augxiliary Storage

@ Actions
- Display

&  Rendering

Variables
E Metadata

ﬁ Dependencies

| = single symbol

[ @rep | syle -

Layer Properties - roads | Symbology

v — Line

Arrow
Geometry generator
Hashed line

Marker line &
symbol layer type| Simple line

Color . ] E| L=
Stroke width | 0,260000 @ ||| Milimeters  ~| &,
Offset 10,000000 2| Millimeters  ~| &
stroke style | ——Solid Line K=
Join style | B Bevel - &
Cap style | B square - e
Use custom dash pattern
| Millimeters - g

v| Enable symbol layer 4=, Draw effects

P Layer Rendering

 /Apply || %cancel || JoK |

2. Select the Simple marker layer in the symbol layers tree. Change the symbol properties to match this dialog:
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Layer Properties - roads | Symbology
| = single symbol

"i Information ~ -+ Line |E|
* . - Marker line

;{s} Source v - Marker

Q/ Symbology

""""" jla

€3 Labels
EED Masks symbol layer type Simple marker - 1=
: Diagrams Size 0,500000 |$| | Millimeters ~| &
.." 3D View Fill color | E| (=8
B s stroke color | MM | <,
E Attributes Form Stroke style | ——Solid Line KEE
Soirs Stroke width | Hairline |‘| | Millimeters MKEN
. Join style | B Bevel - &
5" Augxiliary Storage
Rotation | 0,00° | &
& actions 10,000000 [ P
- x y -
- Offset | Millimeters - &
O oisplay y |0,000000 B
& Rendering \VCenter - &
Variables Anchor point 'HCenter aK=E
| Metadat:
AT D000AAK T @++X | > b
"™ Dependencies Dd aoif hA M a -
P Layer Rendering
.| @Help || style - JApply || Xcancel || JoK |

3. Select the Marker line layer and change the interval to 1.00:

42 Kapitola 2. Module: Creating and Exploring a Basic Map



QGIS Training Manual

Layer Properties - roads | Symbology x

Q = Single symbol -

fi Information v = Line g

3

"W Source + - Marker =
simple marker L2

@' Symbology

€3 Labels

B Masks symbol layer type| Marker line -

: Diagrams Marker placement =,

N7 3D View ® withinterval | [0 2| Millimeters  ~ | &

E Fields (! on every vertex

() on last vertex only

E Attributes Form ) )
! on first vertex only

Joins (! on central poink
ﬁ Augxiliary Storage ) on central point of segments

() on every curve point

{;'.-® Actions
- Display

i "
4 Rendering

Offset along line 0,000000 Millimeters ~| &

v| Rotate marker to Follow line direction

Average angle over | 4,000000 < | Millimeters ~| &
Variables Line offset 0,000000 2 |Millimeters  ~ | &
E Metadata
v| Enable symbol layer 4=, Draw effects

ﬁ Dependencies

P Layer Rendering

@Help Style - «/ Apply || % Cancel

4. Ujistéte se, Ze trovné symboli jsou spravné (ptes dialog Advanced w Symbol levels, ktery jsme pouZili dfive)
pred pouZitim stylu.

Poté, co styl pouZijete, podivejte se na jeho vysledky na mapé. Jak mtiZete vidét, tyto symboly méni smér spolu se
silnici, ale ne vZdy se spolu s ni zakfivuji. To je pro nékteré ucely uzitecné, ale pro ostatni zase ne. Pokud chcete,
muZete zménit vrstvu symbolid v pfedchozi dotazu tak, jak vypadala predtim.

Typy vrstev symboll pro polygony

Chcete-li zobrazit rizné moznosti, které jsou k dispozici pro polygonova data:
1. Change the Symbol layer type for the water layer, as before for the other layers.
2. Zjistéte, jaké jsou rizné moznosti na seznamu, které mizete délat.
3. Vyberte si jednu z nich, kterd vam nejvice vyhovuje.

4. V ptipad¢€ pochybnosti, pouZijte Point pattern fill s nasledujicimi moZnostmi:
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Layer Properties - water | Symbology
& [Ssinglesymbol

"i Information - Fill |E|
~ °  Point pattern fill
v © Marker

° Q]3]

- |

-?& Source

Q’ Symbology

€3 Labels
EED Masks symbol layer type Simple marker - 1=
: Diagrams Size 2,000000 |$||Millimeter5 ~| &
.r' 3D View Fill color | E| (=8
B s stroke color | (N | =,
E Attributes Form Stroke style | ——Solid Line KEE
Soirs Stroke width | Hairline |‘| | Millimeters MKEN
. Join style | B Bevel - &
5" Augxiliary Storage
Rotation | 0,00° | &
& actions 10,000000 [ P
- x y -
- Offset | Millimeters - &
O oisplay y |0,000000 B
4" Rendering \VCenter K=
Variables Anchor point 'HCenter aK=E
 srctad
B mecadoro OCO00CAANXTO@F+F X | DD
"™ Dependencies Dd aoif hA M a -
P Layer Rendering
.| @Help || style - JApply || Xcancel || JoK |
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Layer Properties - water | Symbology
& [Ssinglesymbol

%) Information ~ . . Fill | |

a cooo Point pattern Fill
"W Source o000 v © Marker — =
o000 © simple marker |E| |Q|
Q’ Symbology o000
€3 Labels
B Masks symbol layer type Point pattern fill - |
: Diagrams Distance
Horizontal |4,000000 <| | Millimeters K =R
N7 3D View [ | <] |
Vertical | 4,000000 2| Millimeters  ~| &
E Fields .
Displacement
B8 Attributes Form Horizontal | 0,000000 4| Mmillimeters  ~| &
Joins Vertical | 0,000000 4| Mmillimeters  ~ | &
L Offset
5" Augxiliary Storage
Horizontal | 0,000000 2| Millimeters  ~| &
@ Actions - —
Vertical | 0,000000 2| Millimeters  ~| &
- Display
g. Rendering
Variables
E Metadata
v| Enable symbol layer 4=, Draw effects

ﬁ Dependencies

P Layer Rendering
.| @Help || style - JApply || Xcancel || JoK |

5. Pfidejte novou vrstvu symbolt Simple fill.
6. Vytvorte tu samou, ale ve svétle modré barvé s tmavé modrym obrysem.

7. Presuiite ji pod vrstvu symboli pro bodovy vzor tlacitkem Move down:
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Layer Properties - water | Symbology X

Q = Single symbol -

fi Information ~ | Fill o
2 simple Fill = @

"% Source » . . Point pattern Fill Olla
& symbology -
€3 Labels
B Masks symbol layer type Simple Fill -
-

, Diagrams Fllcolor | M - (=,
N7 3D View Fill style I solid -la
E Fields stroke color | (I - =
E P — Stroke width | 0,260000 = | Millimeters ~| &

. Stroke style |—— Solid Line K=k
Joins
. Join style 5 Bevel ~| S
E_" Augxiliary Storage -
X | 0,000000 -
@ Actions Offset Millimeters -
. y | 0,000000 =
- Display
/ .
4 Rendering
Variables

E Metadata

ﬁ Dependencies v| Enable symbol layer <=, Draw effects
P Layer Rendering
@Help Style - «/ Apply || % Cancel o OK

Vysledkem je strukturovany symbol pro vrstvu vodstva, s pfidanou vyhodou, Ze miZete meénit velikost, tvar
a vzdélenost jednotlivych bodi, které tvofi strukturu.

2.4.12 / Try Yourself

Apply a green transparent fill color to the protected_areas layer, and change the outline to look like this:
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Answer

Here are examples of the symbol structure:

Layer Properties - protected_areas | Symbology
| = single symbol -

"rf Information ~ . Fill

Marker line Nhkddk
;-'o_';_\ Source ~ 4 Marker : :
+ Simple marker ) >
w' symbology simple Fill ayvvvy
€2 Labels — — — — —
1®||=|8laallY]
. Diagrams
symbol layer type| Outline: Marker line v| =
u# 3D View
Marker placement <,
E Source Fields ® with | | I la
®) with interval |3.000000 = Millimeter -
Attributes
Form ) on every vertex
Joins ) on last vertex only
&% Auxiliary ) on first vertex only
L Storage )
: _! on central point
& Actions ]
- ! on every curve point
Display y | PP
Offset along line | 0.000000 || Millimeter -~ &
& Rendering ¥| Rotate marker
Variables Line offset |0.000000 /| Millimeter K=
!h Metadata T I
P Layer Rendering
™ Dependencies _| @Help | stle -| | «/Apply || ®cancel |’ «/ OK ]
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'ff Information

Layer Properties - protected_areas | Symbology

| 2 single symbol -

=
~ _ . Fill

¥ i 4 Marker line ey

;{0} Source * 4+ Marker - -

1 £
& symbology simple Fill avrvyy
€3 Labels — ——

1E|[=|8]|3]| a]l¥
'I Diagrams

Symbol layer type| Simple marker v| =
W 3D View

Size |2.200000 2| | Millimeter -~ e

E Source Fields .

: i ]
Attributes AlLe | l;| &
— Stroke color | H (=R
Joins ~
o stroke style | ——Solid Line aK=E

=~ Auxiliary

& B storage Stroke width | 0.200000 @ ||| Millimeter K =N
@ Actions Join style | B Bevel - a
. Display Rotation |0.00° |:| <
o o x | 0.000000 s

& Rendering Offset | | Millimeter aK=E

Variables y 0.000000 |'|
| vcenter K =

ah Metadata

P Layer Rendering

™ Dependencies _| @Help | style -| | «/Apply || %cancel |’ «/ OK ]

2.4.13 & Follow Along: Geometry generator symbology

You can use the Geometry generator symbology with all layer types (points, lines and polygons). The resulting symbol
depends directly on the layer type.

Very briefly, the Geometry generator symbology allows you to run some spatial operations within the symbology
itself. For example you can run a real centroid spatial operation on a polygon layer without creating a point layer.

Moreover, you have all the styling options to change the appearance of the resulting symbol.

Let’s give it a try!

1. Select the water layer.

2. Click on Simple fill and change the Symbol layer type to Geometry generator.
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(] Centroid Fill
| Z single symbol

G‘ Information

Geometry ge'?eratcr
Gradient fill

Line pattern Fill
Point pattern Fill
Random marker Fill 3

-?& Source

Q’ Symbology

Raster image Fill
€3 Labels SVG Fill
Shapeburst Fill

B Masks symbol layer typ
simple Fill
-
, Diagrams Fill color | Outline: Arrow
.r' 3D View Fill style | Outline: Hashed line
- | Outline: Marker line
i Stroke color
E Fields Outline: simple line
E Attributes Form Stroke width | 0,260000 @ [7[|Millimeters ~ T &
. Stroke style | ——Solid Line -~ &
Joins
. Joinstyle | T Bevel -~ &
E" Augxiliary Storage -
x | 0,000000 - |—
1B Actions Offset - | Millimeters ~|
y | 0,000000 2] R
- Display
&  Rendering
Variables
E Metadata
v| Enable symbol layer 4=, Draw effects

E Dependencies

P Layer Rendering
.| @Help || style - JApply || Xcancel || JoK |

3. Before to start writing the spatial query we have to choose the Geometry Type in output. In this example we
are going to create centroids for each feature, so change the Geometry Type to Point / Multipoint.

4. Now let’s write the query in the query panel:

[centroid($geometry) ]
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Layer Properties - water | Symbology

| = single symbol

"i Information ~ @ Fill |

Geometry generator

-?& Source ~ @ Marker
® simple marker |

Q’ Symbology

€= Labels

B Masks symbol layer type Geometry generator - |

Diagrams Geometry type | " Point / MultiPaint - |

b
I —
\" 3D View centroid($geometry) |£|
E Fields

E Attributes Form

Joins

ﬁ Augxiliary Storage

@ Actions
- Display

" Rendering

Variables

| Metadata 4 L

Dependencies v/ Enable symbol layer <=, Draw effects

P Layer Rendering
.| @Help || style - | «/Apply || % cancel |[ o OK ]

5. When you click on OK you will see that the water layer is rendered as a point layer! We have just run a spatial
operation within the layer symbology itself, isn’t that amazing?
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*chapter_3 - QGIS [tm]

Project Edit View Layer Settings Plugins Vector Raster Database Web Progessing Help
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/ 4 Qa® ~29- B A X
Layers EE]
- .
o @ ® TV &AL
e
v L]
°
P
®
1]
.
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° .
. °
. .
°
° °
°
. °
°
°
°
° e
.
°
Layers | Brow
Type to locate (Ctrl+K Coordinate| 20.4963.-33.9835 |® Scale|1:34265 |~ @ Magnifier| 100% 2| Rotation |0.0° %V Render @ EPSG:4326 @

With the Geometry generator symbology you can really go over the edge of normal symbology.

mm= Try Yourself
Geometry generator are just another symbol level. Try to add another Simple fill underneath the Geometry generator
one.
Change also the appearance of the Simple marker of the Geometry generator symbology.

The final result should look like this:
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Answer

1. Click on the "--II:I-II:I button to add another Symbol level.

2. Move the new symbol at the bottom of the list clicking the v button.

3. Choose a good color to fill the water polygons.

4. Click on Marker of the Geometry generator symbology and change the circle with another shape as your wish.
5

. Try experimenting other options to get more useful results.

2414 == Follow Along: tvorba vlastniho SVG Fill

Poznamka: Chcete-li délat toto cvifeni, budete potfebovat mit nainstalovany bezplatny software pro tpravu vektoru
Inkscape Inkscape .

1. Start the Inkscape program. You will see the following interface:
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T = =
e HET B & EENTE—— [ | [ [ | L B
= 3 B
e B @ % @ |-Layer L ¢ | No objects selected. Click, Shift-click, or drag around objects to select. X A3 (e [

Meélo by vam byt povédomé, pokud jste nékdy pouzili jiné programy na dpravu vektorovych obrazki, jako je
Corel.

Za prvé, zménime obraz na velikost vhodnou pro malou texturu.

Kliknéte na polozku menu File » Document Properties. Dostanete dialog Document Properties.
Zméite Units na px.

Change the Width and Height to 100.

Zavtete dialogové okno, az budete hotovi.

Kliknéte na polozku menu View » Zoom » Page pro nahled stranky, se kterou pracujete.

N oA »d

Vyberte nastroj Circle:
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0060 '\ New document 1 - Inkscape
File Edit View Layer Object Path Text Filters Extensions Help
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e Na @ & @ [-Layer1 ¢ shift: dlick to toggle select; drag for rubberband selection; Al: click to select under: drag to move selected or select by touch Fom z e

8. Kliknutim a taZenim nakreslete elipsu. Chcete-li elipsu zménit v kruh, podrzte pfi kresleni tlacitko Ctrl .

9. Klepnéte pravym tlacitkem mysi na kruh, ktery jste pravé vytvorili, a oteviete Fill and Stroke moZnosti. MlZete
modifikovat jeho renderovéni, jako naptiklad:

1. Zméite Fill barvu na pfiblizné Sedo-modrou,
2. Pfifad’te okrajlim tmavsi barvu v Stroke paint zaloZce,

vy

3. A snizZte Sitku okraje pod Stroke style zalozkou.
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10. Nakreslete linii s pouZitim ndstroje Pencil:
1. Click once to start the line. Hold Ct r1 to make it snap to increments of 15 degrees.
. Posuiite ukazatel horizontdlné a jednoduchym kliknutim vloZte bod.
. Kliknéte a sejméte vrchol linie a sledujte svislou linii, ukoncete jednoduchym kliknutim.

vy

. Zmérite barvu a §itku trojihelnikového symbolu, aby odpovidala hranici kruhu a posuiite ji, jak to bude
nutné tak, Ze nakonec dostanete symbol, jako je tento:

2
3
4. Nyni spojte tyto dva koncové vrcholy.
5
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11. If the symbol you get satisfies you, then save it as landuse_symbol under the directory that the course is in,

under exercise_data/symbols, as SVG file.
V QGISu:

1. Otevtete Layer Properties pro vrstvu landuse.

2. In the ‘Q( Symbology tab, change the symbol structure by changing the Symbol Layer Type to SVG Fill

shown below.

3. Click the ... button and then Select File... to select your SVG image.

[XNN

It’s added to the symbol tree and you can now customize its different characteristics (colors, angle, effects,

units. ..).

56 Kapitola 2. Module: Creating and Exploring a Basic Map



QGIS Training Manual

Layer Properties - landuse | Symbology

| = single symbol

%) Information ~ [ Fill | |
— 4 SVG fill
-?& Source = :J:i v — Line o
7\ r‘ — simple line |E| |Q|
Q’ Symbology E —
€3 Labels
B Masks symbol layer type SVG fill -
: Diagrams Texture width | 10,000000 |:| | Millimeters - &
.r' 3D View Fill color (=8
E Fields Stroke color =8
BB Attributes Form Stroke width | || Millimeters  ~| &
: Rotation 0,00° i &
Joins
SVG Groups SVG symbols
E" Auxiliary Storage ~ [ App Symbols - - . . 252 =
& _ [ accommodation - ..
g Actions ] amenity oy e
: [ arrows i S|e &y x
- Display L

[J backgrounds
[ components

&  Rendering

[ crosses o :
Variables [] emergency |0 ' _ '||
[ entertainment we llwe I
{ Metadata [ food h &
a [ gpsicons X : S Y o | ﬂ%
ﬁ Dependencies [ health
[J landmark = A\ O ‘#’ ’(:}‘ [E— m A =
"~ Legend A
s *nts/GIS/QGIS/TrainingManual/exercise_data/symbols/landuse_symbol.svg & ||_|t| =i
& qais server
v| Enable symbol layer <, Draw effects

ﬂ Digitizing

» Layer Rendering
| @Help || style -  Japply | %cancel |[ ok |

Once you validate the dialog, features in landuse layer should now be covered by a set of symbols, showing a texture
like the one on the following map. If textures are not visible, you may need to zoom in the map canvas or set in the
layer properties a bigger Texture width.
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2.4.15 In Conclusion

Zména symboliky pro rizné vrstvy pfemeénila sbirku vektorovych soubort na Citelnou mapu. Nejen, Ze mtzZete vidét,

co se déje, ale jesté krasnéjsi je to vidét!

2.4.16 Further Reading

Examples of Beautiful Maps

2.4.17 What's Next?

Zména symbolil pro celé vrstvy je uZiteCnd, ale informace obsaZené v kazdé vrstvé jeste nejsou k dispozici pro toho,
kdo z danych map cte. Jaké ndzvy maji ulice? Které regiony patii do urcitych oblasti? Jaké jsou povrchové plochy
vztahujici se ke statkim? VSechny tyto informace jsou stéle skryté. V dalsi lekci vysvétlime, jak zobrazovat tato data
na mapeé.

Poznamka: Nezapomnéli jste si v posledni dobé€ ulozit vasi mapu??
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KAPITOLA 3

Module: Classifying Vector Data

Classifying vector data allows you to assign different symbols to features (different objects in the same layer),
depending on their attributes. This allows someone who uses the map to easily see the attributes of various features.

3.1 Lesson: Vector Attribute Data

Vector data is arguably the most common kind of data in the daily use of GIS. The vector model represents the location
and shape of geographic features using points, lines and polygons (and for 3D data also surfaces and volumes), while
their other properties are included as attributes (often presented as a table in QGIS).

Up to now, none of the changes we have made to the map have been influenced by the objects that are being shown.
In other words, all the land use areas look alike, and all the roads look alike. When looking at the map, the viewers
don’t know anything about the roads they are seeing; only that there is a road of a certain shape in a certain area.

But the whole strength of GIS is that all the objects that are visible on the map also have attributes. Maps in a GIS
aren’t just pictures. They represent not only objects in locations, but also information about those objects.

The goal for this lesson: To learn about the structure of vector data and explore the attribute data of an object

3.1.1 \ Follow Along: Viewing Layer Attributes

It’s important to know that the data you will be working with does not only represent where objects are in space, but
also tells you what those objects are.

From the previous exercise, you should have the protected_areas layer loaded in your map. If it is not loaded,
then you can find the protected_areas. shp ESRI Shapefile format dataset in directory exercise_data/
shapefile.

The polygons representing the protected areas constitute the spatial data, but we can learn more about the protected
areas by exploring the attribute table.

1. In the Layers panel, click on the protected_areas layer to select it.

2. In the Layer menu, click the == Open Auribute Table 1yy¢¢6n (also accessible from top toolbars buttons). This will
open a new window showing the attribute table of the protected_areas layer.
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|L-\

\
y o f LT E & D P E = A &
full_id osm_id osm_type boundary is_in leisure name type wikidata
1/ 12855697 2855697 relation protected_a... Western Ca... nature_reser... Bontebok N... boundary Q892884
2 w187055916 187055916 way protected_a... Western Ca... nature_reser... Marloth Nat... NULL NULL

1

T show All Features _

Next, let’s see how a record in the attribute table is linked to a polygon feature that we see on the Map Canvas.

wil

en:Bc

A row is called a record and is associated with a feature in the Canvas Map, such as a polygon. A column
is called a field (or an attribute), and has a name that helps describe it, such as name or id. Values in the cells
are known as attribute values. These definitions are commonly used in GIS, so it is good to become familiar

with them.

In the protected_areas layer, there are two features, which are represented by the two polygons we see

on the Map Canvas.

Poznamka: In order to understand what the fields and attribute values represent, one may need to find
documentation (or metadata) describing the meaning of the attribute values. This is usually available from the

creator of the data set.

1. Go back to the main QGIS window.

-

2. In the Edit —> Select menu, click on the 5% Select Feature(s) button.

3. Make sure the protected_areas layer is still selected in the Layers panel.

4. Move your mouse to the Map Canvas and left click on the smaller of the two polygons. The polygon will turn

yellow indicating it is selected.
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5. Go back to the Attribute Table window, and you should see a record (row) highlighted. These are the attribute
values of the selected polygon.

Q protected_areas ©: Features Total: 2, Filtered: 2, Selected: 1 - [l *

/ 2 B 0§ LT ES P PE EDe

full id osm id 0sm type boundary is in leisure name tvpe wikidata Wi

) r2855697 protected_a... |Western Ca... |nature_reser... |Bontebok M... |boundary (892884
2/w187055916 187055916 way protected_a... Western Ca... nature_reser... Marloth Mat... NULL NULL NULJ
L) L3

| 7 show All Features _ 2|8
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You can also select a feature using the Attribute Table.

1. Inthe Attribute Table window, on the far left, click on the row number of the record that is currently not selected.

Q protected_areas : Features Total: 2, Filtered: 2, Selected: 1 — Oa X
/ > ® 08 T E S P e = Fe

full id osm id osm tvpe boundary i5 in leisure name type wikidata Wi
() r2855697 2855697 protected_a... |Western Ca... |nature_reser... |Bontebok N...

187055916 187055916 way protected_a... Western Ca... nature_reser... Marloth Mat... NULL NULL MNULI

[4 b

T show All Features _

2. Go back to the main QGIS window and look at the Map Canvas. You should see the larger of the two polygons
colored yellow.
3. To deselect the feature, go to the Attribute Table window and click on D-u] Deselect all features from the layer ¢y

Sometimes there are many features shown on the Map Canvas and it might be difficult to see which feature is selected
from the Attribute Table. Another way to identify the location of a feature is to use the Flash Feature tool.

1. In the Antribute Table, right-click on any cell in the row that has the attribute value r2855697 for the field
full_id.

2. In the context menu, click on Flash Feature and watch the Map Canvas.

Q protected_areas :: Features Total: 2, Filte

4 " B &

full id osm id osm type
1

2|w1870559

Select All

Copy Cell Content
Zoom to Feature
Pan to Feature

Flash Feature

Open Form

You should see the polygon flash red a few times. If you missed it, try it again.
Another useful tool is the Zoom to Feature tool, that tells QGIS to zoom to the feature of interest.

1. In the Antribute Table, right-click on any cell in the row that has the attribute value r2855697 for the field
full_id.

2. In the context menu, click on Zoom to Feature
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0 protected_areas @ Features Total: 2, Fi

¥ [ | -
¥ ) El

S F

full id osm id osm tvi

JOCCo0T

il r23855697 -
Select All

2/ w1870559
Copy Cell Content

Zoom to Feature

Pan to Feature

Flash Feature

Open Form

Look at the Map Canvas. The polygon should now occupy the extent of the Map Canvas area.

You may now close the attribute table.

3.1.2 \ Try Yourself Exploring Vector Data Attributes

1. How many fields are available in the rivers layer?

2. Tell us a bit about the t own places in your dataset.

3. Open the attribute table for the places layer. Which field would be the most useful to represent in label form,
and why?

Answer

* There should be 9 fields in the rivers layer:

1.

2.

3.

Select the layer in the Layers panel.

Right-click and choose Open Attribute Table, or press the button on the Attributes Toolbar (it can be
enabled from View » Toolbars menu).

Count the number of columns.

A quicker approach could be to double-click the rivers layer, open the Layer properties » Fields tab, where you
will find a numbered list of the table’s fields.

* Information about towns is available in the places layer. Open its attribute table as you did with the rivers layer:
there are two features whose place attribute is set to town: Swellendam and Buffeljagsrivier. You can add
comment on other fields from these two records, if you like.

¢ The name field is the most useful to show as labels. This is because all its values are unique for every object
and are very unlikely to contain NULL values. If your data contains some NULL values, do not worry as long
as most of your places have names.
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3.1.3 In Conclusion

You now know how to use the attribute table to see what is actually in the data you’re using. Any dataset will only
be useful to you if it has the attributes that you care about. If you know which attributes you need, you can quickly
decide if you're able to use a given dataset, or if you need to look for another one that has the required attribute data.

3.1.4 What’s Next?

Different attributes are useful for different purposes. Some of them can be represented directly as text for the map
user to see. You'll learn how to do this in the next lesson.

3.2 Lesson: Labels

Labels can be added to a map to show any information about an object. Any vector layer can have labels associated
with it. These labels rely on the attribute data of a layer for their content.

The goal for this lesson: To apply useful and good-looking labels to a layer.

3.2.1 \ Follow Along: Using Labels

First, ensure that the “2k=! button is visible in the GUI:
1. Go to the menu item View » Toolbars

2. Ensure that the Label Toolbar item has a check mark next to it. If it doesn’t, click on the Label Toolbar item
to activate it.

3. Click on the places layer in the Layers panel so that it is highlighted
4. Click on the ‘2zl toolbar button to open the Labels tab of the Layer Styling panel
5. Switch from No Labels to ‘2tz Single Labels

You’'ll need to choose which field in the attributes will be used for the labels. In the previous lesson, you decided
that the name field was the most suitable one for this purpose.

6. Select name from the Value list:
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Layer Styling )
o places =

=1 Single Labels - ||
(g

Value |abc name ~ || E

-

abe i abe abc . J

Text

Font | MS ShellDig 2 | S

Style Regular = @.
uE|sl€ B E 1€

Size | 10.0000 | &
Points | S

coor | (GG - <.

Dpaﬂtyl __l IDD.D E‘n"u -

1. Favorites v | 8
= Save Settings...

| e | Live update Apply

7. Click Apply

The map should now have labels like this:
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3.2.2 \ Follow Along: Changing Label Options

Depending on the styles you chose for your map in earlier lessons, you might find that the labels are not appropriately
formatted and either overlap or are too far away from their point markers.

Poznamka: Above, you used the button in the Label Toolbar to open the Layer Styling panel. As with Symbology,
the same label options are available via both the Layer Styling panel and the Layer Properties dialog. Here, you'll use
the Layer Properties dialog.

1. Open the Layer Properties dialog by double-clicking on the places layer
2. Select the ‘=E2| Labels tab

3. Make sure Text is selected in the left-hand options list, then update the text formatting options to match those
shown here:
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@ Layer Properties - places | Labels

Information
Source

: Symbology
Labels
D Masks

o -
. Diagrams
E Fields

E Attributes Form

Joins

ﬂ Auxiliary Storage
{;@ Actions
- Display

Rendering

Variables

E Metadata
ﬁ’ Dependencies

Legend
QGIS Server

B oigitizing

W e

4. Click Apply

=1 Single Labels

Value | abc name

w Text Sample

Lorem Ipsum

Larem Ipsum

abe Text
2% Farmatting
abe Byffer

abc! Mask

. Background
- Shadow
ape Callouts
1-:0 Placement

_,"’ Rendering

=
- &
# | |usesw | v | (B |- -

Text
Font |Arial Vl E,
Style Regular - @.
U € (s & BE 1€
Size | 13.0000 A ER
Points | S
coor | (. - =
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Save Settings...
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That font may be larger and more familiar to users, but its readability is still dependent on what layers are
rendered beneath it. To solve this, let’s take a look at the Buffer option.

5. Select Buffer from the left-hand options list

6. Select the checkbox next to Draw text buffer, then choose options to match those shown here:
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@ Layer Properties - places | Labels

Q
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7. Click Apply

4
| =1 Single Labels - | |E|
= Value |ib< name - | |E|
w Text Sample
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abc) Mask
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“ Rendering
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Blend mode |Normal - | @
Draw effects
oK | | cancel || Apply [ Help |

You'll see that this adds a colored buffer or border to the place labels, making them easier to pick out on the

map:
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Now we can address the positioning of the labels in relation to their point markers.
8. Select Placement from the left-hand options list

9. Select Around point and change the value of Distance to 2 . 0 Millimeters:
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10. Click Apply

You'll see that the labels are no longer overlapping their point markers.

3.2.3 / Follow Along: Using Labels Instead of Layer Symbology

In many cases, the location of a point doesn’t need to be very specific. For example, most of the points inthe places
layer refer to entire towns or suburbs, and the specific point associated with such features is not that specific on a large
scale. In fact, giving a point that is too specific is often confusing for someone reading a map.

To name an example: on a map of the world, the point given for the European Union may be somewhere in Poland,
for instance. To someone reading the map, seeing a point labeled European Union in Poland, it may seem that the
capital of the European Union is therefore in Poland.

So, to prevent this kind of misunderstanding, it’s often useful to deactivate the point symbols and replace them
completely with labels.

In QGIS, you can do this by changing the position of the labels to be rendered directly over the points they refer to.
1. Open the ‘2| Labels tab of the Layer Properties dialog for the places layer

2. Select the Placement option from the options list
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3. Click on the Offset from point button

This will reveal the Quadrant options which you can use to set the position of the label in relation to the point
marker. In this case, we want the label to be centered on the point, so choose the center quadrant:
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N —
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4. Hide the point symbols by editing the layer Symbology as usual, and setting the size of the Marker size to 0 . 0:
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5. Click Apply and you’ll see this result:
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If you were to zoom out on the map, you would see that some of the labels disappear at larger scales to avoid
overlapping. Sometimes this is what you want when dealing with datasets that have many points, but at other times
you will lose useful information this way. There is another possibility for handling cases like this, which we’ll cover

in a later exercise in this lesson. For now, zoom out and click on the button in the toolbar and see what happens.

3.24 / Try Yourself Customize the Labels

* Reset the label and symbol settings to have a point marker and a label offset of 2 . 0 Millimeters.

Answer

Your map should now show the marker points and the labels should be offset by 2mm. The style of the markers and
labels should allow both to be clearly visible on the map:
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* Set the map to the scale 1: 2100000. You can do this by typing it into the Scale box in the Status Bar. Modify
your labels to be suitable for viewing at this scale.

Answer

One possible solution has this final product:

74

Kapitola 3. Module: Classifying Vector Data



QGIS Training Manual

() “basic_map - QGIS 3e6aebidf1 — [m] x
Project Edit View Layer Seftings Plugine Vector Raster Dstabase Mesh Progessing Help

 mERRE (DL RPRP I AL REINOR 60 -H-B-R-BE# =~ 0

LA -4 - w0, g W my g gy a |
Browser Layer Styling
QQTEI‘O ‘.‘bplaues 'l
- 7 Favorites E &1 single Labels -] [

v 5 QGIS-Training-Data\e _‘ | f—

~ 5 QGIS-Training-Data\s = value [abe name M| ‘£|

b [ styles
3 Q basic_map
" Spatial Bookmarks
(% Project Home
[&] Home
[(mE=Y
e GeoPackage
# Spatialite
@ rostcls
P wmssaL
2 pe2
@ WMSWMTS
ﬂ Vector Tiles
55 XVZ Tiles
& wes
7 WFS [ OGC API - Feature
) ows
)] ArcGisMapServer
AR A e,

1 »
Layers
‘ill@ l? 814'13 »
V| @ places
v roads
v rivers
v| B buitdings
v . water
v . protected_areas
v landuse

-

| Q4 Type to locate {Ctrl+)

Coordinatz | 20.5946,-34.0152 %8  Scale | 1:100000

| Mo change

Formatted numbers a

Decimal places | 3 =

Show plus sign

‘El ‘El V| Live update |

- | ﬁ Magnlﬁer\lUU%

|2] Rotation (0.0°

[2] v Render @ epsciazs @

:_ ] |- ase | ») '}°|<‘»|

Apply

R ="
eter o000 2] &
word | 0,0000 B =8

| Enable kerning
Text orientation | Horizontal - G
Blend mode |Nwma| b ‘ @
Apply label text substitutes
Multiple lines
Wrap on character | ‘ @

Wrap lines to | No automatic wrapping = \ @

| Maximum line length -
Line height [ 1.00line DR =R
Alignment |Fo||ow Label Placement  ~ ‘ @

-

To arrive at this result:

e Use a font size of 10

* Use an around point placement distance of 1.5 mm

¢ Use a marker size of 3.0

mm

* In addition, this example uses the Wrap on character option:
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* Enter a space in this field and click Apply to achieve the same effect. In our case, some of the place names
are very long, resulting in names with multiple lines which is not very user friendly. You might find this setting
to be more appropriate for your map.
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3.25 / Follow Along: Labeling Lines

Now that you know how labeling works, there’s an additional problem. Points and polygons are easy to label, but what
about lines? If you label them the same way as the points, your results would look like this:
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| Q Type to locate (Cirl+K) | Coordinate | 20.5190,-33.3845 | % Scale [1:35434  + | (@ Magrifier 100% 2| Rotation | 0.0° [2] ¥ mender @ Epsciazs @

We will now reformat the roads layer labels so that they are easy to understand.
1. Hide the places layer so that it doesn’t distract you
2. Activate Single Labels for the roads layer as you did above for places
3. Set the font Size to 10 so that you can see more labels
4. Zoom in on the Swellendam town area

5. In the Labels tab’s Placement tab, choose the following settings:
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@ Layer Properties - roads | Labels x
Q =1 Single Labels - | |¢' |
Value |ib< name - | | € |
w Text Sample
Lorem Ipsum
{abe| Labels _— B b’
|Loren1 Ipsum I‘b | |1:8860 - | |ﬁ;|’| | |'|
abc -
abe Text Placement
2% Farmatting =
- 8be Buffer
= abe' Mask (®) Parallel () Curved () Horizontal
= . Background
|
- Shadow
= Callouts
/* Allowed positions Above line || On line Below line @
#y¥ Placement
‘( Rendering Line orientation dependent position
(v} Distance | 0.0000 s €&
Millimeters hd L
Repeat | No repeat |:| @.
| Points - | €
Overrun feature | No overrun |:| E.
|Mil|imeters - |
v Geometry generator
l/
¥ -
= | style - | oK || cancel | | Apply | [ Help |
You'll probably find that the text styling has used default values and the labels are consequently very hard to
read. Update the 7ext to use a dark-grey or black Color and the Buffer to use a light-yellow Color.
The map will look somewhat like this, depending on scale:
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() “basic_map - QGIS 3e6aebidf1 — [m] x
Project Edit View Layer Seftings Plugins Vector Raster Database Mesh Progessing Help

IEBERRY (O LPL,HPRLrF AL RBLNOR Qe -H-a-R-BE#H$IZ =S 0~
LA N 4 J =Y e YRR L]
Browser = &
LRTY*TO
- Favorites |
v 5 QGIS-Training-Data\e
~ [ QGI5-Training-Data\s
b [ styles
3 @ basic_map
" Spatial Bookmarks
(% Project Home
[&] Home
[(mE=Y
e GeoPackage
# Spatialite
@ rostcls
P mssaL
= DB2
@ WMSWMTS
ﬂ Vector Tiles
55 XVZ Tiles
& wes
7 WFS [ OGC API - Feature
) ows
)] ArcGisMapServer

AR e e

4 3
Layers
o« @ e T EG-F »
® places

roads

rivers
I buildings
¥ water

. protected_areas
landuse

-

<L LSS

=
y 7 , & pam

e/ fi8lFarseene, Peaits J:
| Q4 Type to locate {Ctrl+) | Coordinate | 20.46253,-34.02814 %% Scale 18850 | v | (@ Magnifier 100% |2] Rotation (0.0° [2] [V Render @ Epsciazzs @

You'll see that some of the road names appear more than once and that’s not always necessary. To prevent this
from happening:

6. In the Labels tab of the Layer Properties dialog, choose the Rendering option and select Merge connected lines
to avoid duplicate labels as shown:
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@ Layer Properties - roads | Labels

=1 Single Labels -
Information Value | abc name - || &

w Text Sample

g

Source
Symbology Larem Ipsum
Labels b
Lorem Ipsum % | | 1:8860 - | | B~ v
D Masks o Rendering
¥ (4] - -
- + . - a
¢ Diagrams s Farmatting
abe B ffer Pixel size-based visibility (Jabels in map units) E,
E Fields abc) pqask
Minimum 3 px = L
Background
E Attributes Form . g 5
J Shadow Maximurn 10000 px - L
Joins }” Callouts
\ .:’ Placement Label zindex | 0,00 - E.
e i uxiliary Storage / Rendering Show all labels for this layer (induding colliding labels)
@ . Data defined
o Actions
) Show label 4= | Alwaysshow L
- Display Show upside-down labels
: ® never | | when rotation defined always
Rendering
o Featu i
Variables bt re options
~ Label every part of multi-part features
H Metadata vea e E’
v Merge connected lines to avoid duplicate labels
ﬁ Dependencies Limit number of features to be labeled to
Legend 2000 v
Suppress labeling of features smaller than
IE QGls
5.00 mm -
B oigitizing -
Style * 0K, Cancel Apply Help

7. Click OK
Another useful function is to prevent labels being drawn for features too short to be of notice.

8. In the same Rendering panel, set the value of Suppress labeling of features smaller than ... to 5.00 mm and
note the results when you click Apply

Try out different Placement settings as well. As we’ve seen before, the Horizontal option is not a good idea in
this case, so let’s try the Curved option instead.

9. Select the Curved option in the Placement panel of the Labels tab

Here’s the result:
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() “basic_map - QGIS 3e6aebidf1 — [m] x
Project Edit View Layer Seftings Plugins Vector Raster Database Mesh Progessing Help
I AR U LPL,RPPF AR LEOR & -H-EB-R-BE% =0 0~
REVL AW B 4/ - =4 {9 RFgRFR 4
Browser = ! A

LN
LETTO

¥ 57 Favorites

» 5 QGIS-Training-Datale

= [ QGIS-Training-Data\s
b [ styles
3 a basic_map

[ Spatial Bookmarks

(% Project Home

[&] Home

[(mE=Y

e GeoPackage

# Spatialite

@ rostcls

P wmssaL

2 pe2

@B WMSWMTS

@ Vector Tiles

55 XVZ Tiles

& wes

- | Ry

)] ArcGisMapServer
ARa e

4 *

Layers ]
=y +
« @l ® T &~ » %
® places
roads
rivers
I buildings
¥ water
D protected_areas
landuse

<L LSS

o5

el ®

2t DN b ;
Q, Type tolocate (Ctrl+Q) | Coordinate | 20.46062,-34.02842 % Scale |1:88s0 | v | (@ Magnifier 100% |2] Rotation (0.0° [2] [V Render @ Epsciazzs @

As you can see, this hides some labels that were previously visible, because of the difficulty of making some of them
follow twisting street lines while still being legible. It makes other labels much more useful since they track the roads
rather than float in space between them. You can decide which of these options to use, depending on what you think
seems more useful or what looks better.

3.2.6 & Follow Along: Data Defined Settings

1. Deactivate labeling for the roads layer

2. Reactivate labeling for the places layer

3. Open the attribute table for places via the button

It has one field which is of interest to us now: place which defines the type of urban area for each record.
We can use this data to influence the label styles.

4. Navigate to the Text panel in the places Labels panel

5. Click the \= button next to the Italic text button beneath Style and select Edit... to open the Expression String
Builder:
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@ Expression String Builder

Expression Function Editor

= L= =~ (e

Expected format: bool [1=True|0=False]

Preview:

Feature < Mational Park Reception & Shop | ~

&, Search...

T T T T T YT YT T YTTYTTTTTTYTTTTTE

symbol_color
value
Aggregates
Arrays

Color
Conditionals
Conversions
Date and Time
Fields and Values
Files and Paths
Fuzzy Matching
General
Geometry

Map Layers
Maps

Math

Operators
Rasters

Record and Attributes
String

User expressions
Variables

Recent (generic)

Show Help

Ok Cancel Help

6. Under Fields and Values, double click on place and then click All Unigue. This will list all unique values of

the place field of this layer. Add a = in the text editor and then double click on town.

Alternatively, you can type: "place"

7. Click OK twice:

= 'town' directly in the text editor.

Q@ Expression String Builder

Function Editor

B L
o "town’

Expression

= e - L= e
Expected format: bool [1=True|0=False]
Feature «Mational Park Reception & Shop | ~

Preview: 0

&, Search...

{d vy v v ¥vw¥vovw

rF T T T rorw

symbol_color
value
Aggregates
Arrays

Color

Conditienals
Conversions
Date and Time
Fields and Values
abe fyll_id
abc psm_id
abc gsm_type
abc 5 _in
abc name
abc place
abc sagns_id
abc wikidata
abe wikipedia
Files and Paths
Fuzzy Matching
General
Geometry
Map Layers
Maps
Math

Show Values

group field

Double-click to add field name to expression
string.

Right-Click on field name to open context
menu sample value loading options,
Loading field values from WF5 layers isn't
supported, before the layer is actually
inserted, ie. when building queries.

Values | L Search..
All Unique 10 Samples
hamlet
locality
suburb
town
Ok Cancel Help

Notice that the labels for all places whose place field matches t own are displayed in italics.
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(2 *basic_map - QGIS 3e6aebidf1
Project Edit View Layer Settings Plugins Vector Raster Database Mesh Progessing Help
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ﬂ Vector Tiles
R XYZ Tiles
& wes
7 WFS/ OGC API - Feature,
) ows
)] ArcGisMapServer —
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f\\l .

J
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%yﬂh
/-f‘“
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;'ng_

!
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)
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=
o D

Layers
o« § ® T &G-&F »

P

P

Coordinate | 20.5470,34.0360 | % scale [1:35428  ~ | (@ Magnifier | 100% |2] Rotation (0.0°
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‘ Q, Type to locate (Ctrl+)

3.2.7 A Try Yourself Using Data Defined Settings

Poznamka: We're jumping ahead a bit here to demonstrate some advanced labeling settings. At the advanced level,
it’s assumed that you’ll know what the following means. If you don'’t, feel free to leave out this section and come back
later when you’ve covered the requisite materials.

1. Open the Attribute Table for places
2. Enter edit mode by clicking the i button

3. Add a new column with the button
4. Configure it like this:
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(2} Add Field X
Name FONT _SIZE

Comment

Type Decimal number (real) -

Provider type double
Length 3

Ll

qk

Precision 1

K Cancel

5. Use this to set custom font sizes for each different type of place (each key in the place field)

Answer

1. Still in edit mode, set the FONT__SIZE values to whatever you prefer. The example uses 1 6 for towns, 14 for
suburbs, 12 for localities, and 10 for hamlets.

2. Remember to save changes and exit edit mode
3. Return to the Text formatting options for the places layer and select FONT_SIZE in the A#utribute field of

the font size \= data defined override dropdown:

@ “basic_map - QG aeB3df1 — [m] ® « Re
| ) Layer Properties - places | Labels * « Re
Q 1 = v i [
Q = Single Labels - [ @)= fel
@ irrormation Value [ abc name - (e
w Text Sample
I :{4:\\ Source
Lorem Ipsum
Lorem Ipsum | 135423 |~ | By v
b Text Text 3
Diagrarms % Formatting  Font  |Arial -
5 Buffer
E Fields B8 Mosk style  |Regular - .
Background v
BE] uibutes Form [ uals a Bl & [
J Shadow
abo Size 13,0000 = %|
Joins 7 Callouts
. % Placement Points - -
Y Awiry Storage 7 Rendering | Description... Agsrivier
coor | Store Data in the Praject
B actions
= Opadty |1 100.0 % - Attribute Field N
0 oicpiy e dle : full id (string)
. <, Favorites a@ - Expression osm_id  (string)
& Rendering
Variable | osmtype (string)
Variables Edit... isin  (string)
‘ ~ Paste name  (string)
Bl veteoa Assistant... place  (string)
ﬁ Dependencies sagns_id  (string)
wikidata (string)
Legend wikipedia (string)

FONT_SIZE (double)

& qais server

Save Settings...

BsY

ﬂ [

Style  ~ oK | Cancel Apply Help

APE

.

Q Type to locate (Cirl+) Toagles the editing st Coordinate | 20.4135,-34.0203 | Scale| 1:35423 |~ | @ Magnifier | 100% 2| Rotation |0.0° +| V|Render @ Ersia3e @

Your results, if using the above values, should be this:
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(2 *basic_map - QGIS 3e6aebidf1 - O X
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e
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@ WMS/WMTS 0.’ - \ i"_{)‘g

ﬂ Vector Tiles

v R XVZ Tiles ] & /\S_\;J\’
@ wes (e y P v
7 WFS/ OGC API - Feature, el
S = e

) ows

)] ArcGisMapServer |
[ 4
4] 1 D ‘A

Layers 3
tion:&iSho
RN IO "' p /
v § places
roads
|| — rivers
[v| Il buitdings
.waler . =

[ protected areas = Kraal[Rest.Camp)

2| [V Render @ Epsciazze @

| Q Type o locate (Ctrl+Q) | Coordinate | 20.5489,-34.0554 | Scale | 1:35428 "| & Wagrifier | 100% |2] Rotation (0.0°

3.28 A Further Possibilities With Labeling

We can’t cover every option in this course, but be aware that the Label tab has many other useful functions. You
can set scale-based rendering, alter the rendering priority for labels in a layer, and set every label option using layer
attributes. You can even set the rotation, XY position, and other properties of a label (if you have attribute fields
allocated for the purpose), then edit these properties using the tools adjacent to the main Layer Labeling Options
button:

ol - Aok R

(These tools will be active if the required attribute fields exist and you are in edit mode.)

Feel free to explore more possibilities of the labeling system.
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3.2.9 In Conclusion

You've learned how to use layer attributes to create dynamic labels. This can make your map a lot more informative
and stylish!

3.2.10 What’s Next?

Now that you know how attributes can make a visual difference for your map, how about using them to change the
symbology of objects themselves? That’s the topic for the next lesson!

3.3 Lesson: Classification

Labels are a good way to communicate information such as the names of individual places, but they can’t be used for
everything. For example, let us say that someone wants to know what each 1anduse area is used for. Using labels,
you would get this:

This makes the map’s labeling difficult to read and even overwhelming if there are numerous different landuse areas
on the map.

The goal for this lesson: To learn how to classify vector data effectively.

3.3.1 \ Follow Along: Classifying Nominal Data

1. Open the Layer Properties dialog for the 1anduse layer
2. Go to the Symbology tab
3. Click on the dropdown that says Single Symbol and change it to Categorized:
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"i Information

‘:{:\? Source

& symbology

€€ Labels

B Masks

- .
. [MELEINE

N7 3D View

E Fields

Attributes
Form

Joins

% Auxiliary
< B storage

@ Actions
- Display

4. In the new panel, change the Value to 1anduse and the Color ramp to Random colors

5. Click the button labeled Classify

'rf Information

:-'C\ Source

Q’ Ssymbology

€= Labels

B Masks

Diagrams
W# 3D View

E Fields

Attributes
Form

Joins

L Auxiliary
< B Storage

@ Actions
- Display

3

6. Click OK

| = Categorized

= Categorized

Layer Properties - landuse | Symbology

Value |

Symbol ||

Color ramp |

Random colors

symbol = Value Legend

P Layer Rendering
@Help || style -

- |

Layer Properties - landuse | Symbology

| Classify | |E| |E| | Delete All |

|Advanced ~ |

| /Apply || % cancel |[ & OK ]

value abc landuse ~|| €]
symbol || [+
Color ramp | Random colors |'|
Symbol = Value Legend

v [l cemetery cemetery

v/ [ conservation conservation

v/ [l farmland farmland

v/ [l forest forest

v/ [ grass grass

v Il industrial industrial

v/ [l orchard orchard

v/ [ reservoir reservoir

v/ [l residential residential

v/ [l village _green village green

v [ vineyard vineyard

v [ all other values

| Classify | |E| |E| | Delete All |

» Layer Rendering
@Help || stle -

- |

You'll see something like this:

|Advanced - |

 JApply || ®cancel || JoK |
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7. Click the arrow (or plus sign) next to 1anduse in the Layers panel, you'll see the categories explained:
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Layers (&) )
o [ ® T &~5 & [
» v o places -
v| ] buildings
v — roads
water |
v rivers
* W .~ landuse
v . cemetery
. conservation

B farmland

. Forest

I grass
B industrial

I orchard
. reservoir

B residential

I village_green
"] vineyard

e e e e e e L

Now our landuse polygons are colored and are classified so that areas with the same land use are the same
color.

8. If you wish to, you can change the symbol of each landuse area by double-clicking the relevant color block in
the Layers panel or in the Layer Properties dialog:
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Symbol Selector

(%]
Unit | Millimeters - |
Opacity ~1/100,0 % |:_|
Color | H
| ©. Favorites a|~| &
| Z/ BN

gradient gray 3 fill hashed black/  hashed black,

plasma
|| B |save Symbol... | | Advanced ~|
| @Help | | % cancel H « oK ]

Notice that there is one category that’s empty:
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Layer Properties - landuse | Symbology B

Q = Categorized -

@ information Value a< landuse ~|[g

Symbol [ ] |+

‘:{:\‘_- Source

& symbology

Color ramp Random colors M

symbol = Value Legend
€3 Labels v [ cemetery cemetery
v/ [l conservation conservation
EED Masks v/ [l farmland farmland
. v/ [l forest forest
, Diagrams v/ [ grass grass
v Il industrial industrial
ﬁ 3D View v [l orchard orchard
v [ reservoir reservoir
E Fields v/ [l residential residential
Attributes v/ [l v?llage_green v?llage_green
v [ vineyard vineyard

Form
all other values

<
|

Joins

L Auxiliary
< B storage

{;'.-® Actions

@ Display —| @Help Style - « Apply || % cancel

Classify | = | = | Delete All Advanced ~
P Layer Rendering

This empty category is used to color any objects which do not have a landuse value defined or which have a NULL
value. It can be useful to keep this empty category so that areas with a NULL value are still represented on the map.
You may like to change the color to more obviously represent a blank or NULL value.

Remember to save your map now so that you don’t lose all your hard-earned changes!

3.3.2 \ Try Yourself More Classification

Use the knowledge you gained above to classify the bui 1dings layer. Set the categorisation against the building
field and use the Spectral color ramp.

Poznamka: Remember to zoom into an urban area to see the results.

3.3.3 / Follow Along: Ratio Classification

There are four types of classification: nominal, ordinal, interval and ratio.

In nominal classification, the categories that objects are classified into are name-based; they have no order. For
example: town names, district codes, etc. Symbols that are used for nominal data should not imply any order or
magnitude.

* For points, we can use symbols of different shape.
* For polygons, we can use different types of hatching or different colours (avoid mixing light and dark colours).

* For lines, we can use different dash patterns, different colours (avoid mixing light and dark colours) and different
symbols along the lines.
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In ordinal classification, the categories are arranged in a certain order. For example, world cities are given a rank
depending on their importance for world trade, travel, culture, etc. Symbols that are used for ordinal data should
imply order, but not magnitude.

* For points, we can use symbols with light to dark colours.
* For polygons, we can use graduated colours (light to dark).
* For lines, we can use graduated colours (light to dark).

In interval classification, the numbers are on a scale with positive, negative and zero values. For example: height
above/below sea level, temperature in degrees Celsius. Symbols that are used for interval data should imply order and
magnitude.

* For points, we can use symbols with varying size (small to big).
* For polygons, we can use graduated colours (light to dark) or add diagrams of varying size.
¢ For lines, we can use thickness (thin to thick).

In ratio classification, the numbers are on a scale with only positive and zero values. For example: temperature above
absolute zero (0 degrees Kelvin), distance from a point, the average amount of traffic on a given street per month,
etc. Symbols that are used for ratio data should imply order and magnitude.

* For points, we can use symbols with varying size (small to big).
* For polygons, we can use graduated colours (light to dark) or add diagrams of varying size.
¢ For lines, we can use thickness (thin to thick).

In the example above, we used nominal classification to color each record in the 1anduse layer based on its
landuse attribute. Now we will use ratio classification to classify the records by area.

We are going to reclassify the layer, so existing classes will be lost if not saved. To store the current classification:
1. Open the layer’s properties dialog
2. Click the Save Style ... button in the Style drop-down menu.
3. Select Rename Current..., enter land usage and press OK.
The categories and their symbols are now saved in the layer’s properties.

4. Click now on the Add... entry of the Style drop-down menu and create a new style named rat io. This will
store the new classification.

5. Close the Layer Properties dialog

‘We want to classify the landuse areas by size, but there is a problem: they don’t have a size field, so we’ll have to make
one.

1. Open the Attributes Table for the 1anduse layer.
2. Enter edit mode by clicking the & Toegle editing pyiron

3. Add a new column of decimal type, called AREA, using the | o Newfield 1y, ¢¢0n:

Add Field Lo

Name AREA
Comment
Type Decimal number (double) -

Provider type FLOAT
 Cancel | /0K
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4. Click OK

The new field will be added (at the far right of the table; you may need to scroll horizontally to see it). However,

at the moment it is not populated, it just has a lot of NULL values.

To solve this problem, we will need to calculate the areas.

1. Open the field calculator with the =] button.

You will get this dialog:
(= landuse — Field Calculator x
Only update 0 selected features
v | Create a new field Update existing field
Create virtual field
Output field name
Cutput field type | Binary object (BLOB) -
Cutput field length | 0 Precision 3
Expression Function Editor
s || nke L Se.. Show Help
row_number
F Aggregates
b Arrays
» Color
b Conditionals
+  Conversions
¥ Date and Time
+ Fields and Yalues
b Files and Paths
¥ Fuzzy Matching
b General
F Geometry
b Map Layers
» Maps
F Math
b Operators
- » Rasters
=+ ILCJ [ ¥ Record and Attribu...
k String
TEos - b b User expressions
Preview: » Variables
OK Help
2. Check the A Update existing fields
3. Select AREA in the fields drop-down menu
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Field Calculator %

Create a new field v Update existing Field

1.2 AREA -

4. Under the Expression tab, expand the Geometry functions group in the list and find $area

5. Double-click on it so that it appears in the Expression field

landuse — Field Calculator o

Create a new Field v Update existing Field
1.2 AREA -

Expression | Function Editor

8 &L A Search... function $area
sares r E=o . ~ Returns the area of the current feature. The
» Date and Time . :
» Fields and Values area calculated by this function respects both
» Files and Paths the current project's ellipsoid setting and area
» Fuzzy Matching unit settings. For example, if an ellipsoid has
» General been set for the project then the calculated
~ Geomekry area will be ellipsoidal, and if no ellipsoid is
anﬂle at_vertex set then the calculated area will be
planimetric.
area
azimuth Syntax
boundary .
bounds area
=LA A A ) bounds_height
bounds_width Examples
Feature |1 - 3 buffer
Preview: 1312821.1395745648 buffer_by_m - * $area 42

@Help ¥ cancel «/ OK

6. Click OK

7. Scroll to the ARER field in the attribute table and you will notice that it is populated with values (you may
need to click the column header to refresh the data).

Poznamka: These areas respect the project’s area unit settings, so they may be in square meters or square
degrees.

5. Press B to save the edits and exit the edit mode with ,ﬁ; Toggle editing
6. Close the attribute table
Now that we have the data, let’s use them to render the 1anduse layer.
1. Open the Layer properties dialog’s Symbology tab for the 1anduse layer

2. Change the classification style from Categorized to Graduated
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3. Change the Value to AREA

4. Under Color ramp, choose the option Create New Color Ramp...:

@ Layer Properties - landuse | Symbology

Q

" Symbology

X
| = Graduated -
[ |12 agea ") |E|
Symbol | |:|

Legend format |%1— Yol

||Precim'or14 |3| V| Trim

I

Color ramp |
Labels T
& | Classes | ] Invert Coler Ramp
i Random Ceolor Ramp
Masks Symbol ~ V
] I Blues
Diagrams I Greens
Fields M Greys
. Magma
Attributes Form I I RdGy
I Reds
Joins
I |Spectra|
iary Storage . Viridis
All Color Ramps b
Actio
Create Mew Celor Ramp...
Display Edit Color Ramp...
— Save Color Ramp..,
Rendering Made | §iE Equarcommyguanmey——1 Classes | 5 =
e | Classify | |i| |E| | Delete Al | | Advanced '|
V| Link dass boundaries
Variables
b Layer Rendering
Mstadata [ sy - ok || cancd || mply || Hep |
5. Choose Gradient (if it’s not selected already) and click OK. You will see this:
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() Select Color Ramp >

Color 1 | (N |~ color 2 | IR |~/ Type | Continuous B

] ]
w Gradient Stop -
Relative position | 0.0 %G Delete Stop
5 * .
m|® Z o B N o :
Standard colors * | = 100%  |w

100% |«

G 0 =
B 255 A
[ ] | | Opadty S oo -
o | = HTML notation | 0000
Current

w Flot

Information oK Cancel Help

You'll be using this to denote area, with small areas as Color 1 and large areas as Color 2.
6. Choose appropriate colors

In the example, the result looks like this:
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(&) Select Color Ramp >

Color 1 - Color 2 _ - Type | Continuous =
| I |~ | O | o | |

w Gradient Stop |~

Relative position | 0.0 % = | Delete Stop

CREERE-REA Ow RV v [}

Standird colors “H | Os Y O e -
—‘ - -

. o I o

1
[ | - | Opadty T lw00% |2

|£"E| HTML notation | #h2dfaa v |

ot o eI
Y OO ]

Information oK ] | Cancel | | Help

7. Click OK
8. You can save the colour ramp by selecting Save Color Ramp... under the Color ramp tab. Choose an appropriate
name for the colour ramp and click Save. You will now be able to select the same colour ramp easily under All
Color Ramps.
9. Under Mode choose H_H Equal Count (Quantile)
10. Click Classify

Now you will have something like this:
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@ Layer Properties - landuse | Symbelogy x
Q = Graduated - |
= value 12 anea - [g]
Symboal | |:|

Legend format | %1 - %2 | | Precision 0 |$| V! Trim

‘ Symbology -
Colorramp | . S——

abe -

| Classes | Histogram

e Symbol ™ Values Legend
v 131.30 - 10512.65 131-10313
v 10312.65 - 35728.06 10313 - 35728
= vl 35728.06 - 132271.73 35728 - 132272
= vl 132271.73 - 362220.57 132272 - 362221
— v 362220.57 - 112894046,06 362221 - 112894046
=0
Mode |H:EHEquaI Count (Quantile) ~ | Classes |5 3|
| Classify | |¥| |;| | Delete Al | | Advanced '|
V| Link class boundaries
O
B Layer Rendering
| stye - ok || cancel || Appy || hHep |
Leave everything else as-is.
11. Click OK:

Bontebok &¥Shop)
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3.34 / Try Yourself Refine the Classification

* Change the values of Mode and Classes until you get a classification that makes sense.

Answer

The settings you used might not be the same, but with the values Classes = 6 and Mode = Natural Breaks (Jenks) (and
using the same colors, of course), the map will look like this:

| Bontebok|Natonal Park Recepfion &I Shoplt
Cr. ]

3.35 A Follow Along: Rule-based Classification

It’s often useful to combine multiple criteria for a classification, but unfortunately normal classification only takes one
attribute into account. That’s where rule-based classification comes in handy.

In this lesson, we will represent the 1anduse layer in a way to easily identify Swellendam city from the other
residential area, and from the other types of landuse (based on their area).

1. Open the Layer Properties dialog for the 1anduse layer
2. Switch to the Symbology tab
3. Switch the classification style to Rule-based

QGIS will automatically show the rules that represent the current classification implemented for this layer. For
example, after completing the exercise above, you may see something like this:
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@ Layer Properties - landusze | Symbolo: *
y P Y gy
- [= Rule-based -
q Information Label Rule Min, scale Max.
v 131 - 101924 "AREA" »= 131.299349 AND "AREA" <= 101924.439748
J\-:\a_ TrnmEz v 101924 - 300418 "AREA" » 101924.495748 AND "AREA" <= 309417.846808
: v . 300418 - 839955 "AREA" » 309417.846808 AND "AREA" <= 839954.777508
v . 839955 - 1578789 "AREA" » 839954,777508 AND "AREA" <= 1578788.863263
v . 1578789 - 34452227 "AREA" » 1578788.863263 AND "AREA" <= 34452226.958486
£ Labels v . 34452227 - 112884046 "AREA" » 34452226,958486 AND "AREA" <= 112894046.060455
LD Masks
- . _
. Diagrams 7 5
E Eiskis g S E Symbol Levels. ..
: Refine Selected Rules
E Attributes Form

p Layer Rendering

Joins Style - oK Cancel Apply Help

4. Click and drag to select all the rules

5. Use the "= Remove selected rules 1101 to remove all of the existing rules

Let’s now add our custom rules.

1. Click the ':II-I:I-I:| Addrule by tton
2. The Edit rule dialog then appears

3. Enter Swellendam city as Label

4. Click the € button next to the Filter text area to open the Expression String Builder

5. Enter the criterion "name" = 'Swellendam' and validate

Expression String Builder x

Expression | Function Editor

] L Q search... group field

= 'Swellendam' Conditionals =

Double-click to add field name to expression string.

b
b G i
» Cﬁ:::;lsmns Right-Click on field name to open context menu sample value
» Date and Time loading options.
~ Fields and Values Notes
NULL - -
123 ogc_Ffid
ave Full_id Values | & search...
abc osm_id
< psm_type All Unique 10 Samples
»< landuse Fynbos Heights -
Gaikou Lodge
anc type Koloniesbos
ahe wikipedia Koornland
=0+ A w s boundary Marloth Nature Reserve
an< s in Railton
Feature 1 e > abe lefsure Swellendam
Preview: 0 e name:de - Wamakersbos -
@Help 3 Cancel

6. Back to the Edit rule dialog, assign it a darker grey-blue color in order to indicate the town’s importance in the
region and remove the border
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Label swellendam city =
e Filter "name" = 'Swellendam’ b Test
Else Catch-all For other Features
Description
Scale range
v Symbol
=
M simple Fill
Unit Millimekers -
Opacity _11100.0 % -
Color v

-

@Help ¥ cancel

7. Press OK
8. Repeat the steps above to add the following rules:

1. Other residential label with the criterion "landuse" = 'residential' AND "name" <>
'Swellendam'. Choose a pale blue-grey Fill color

2. Bignon residential areas label with the criterion "1anduse" <> 'residential' AND "AREA"
>= 605000. Choose a mid-green color.

Layer Properties — landuse (basic) — Symbology 0

Q = Rule-based -

@ information * |Label Rule Min. Scale Max. Scale  Count Duplicate Count
v| [l swellendam city "name" = 'Swellendam’

:{_‘\\ Source v Other residenttial "landuse" = 'residential' AND "name" <> 'Swellendam’

v| [l Big non residential areas "landuse" <> 'residential' AND "AREA" >= 605000
& symbology

WF 3D View

Diagrams

-
'
o Z[|Z symbol Levels...

E Fields

E Attributes Form e Redering

Joins - | @Help Style - < Apply | % cCancel

These filters are exclusive, in that they exclude areas on the map (non-residential areas which are smaller
than 605000 (square meters) are not included in any of the rules).

3. We will catch the remaining features using a new rule labeled Small non residential areas. Instead of

a filter expression, Check the ® ' Else. Give this category a suitable pale green color.
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Label small non residential areas =
) Filter
(e Else Catch-all for other features

Description

Scale range
v| Symbol
o
simple Fill
Unit Millimeters -
Opacity _11100.0 % -
Color v

-

©@Help % Cancel

Your rules should now look like this:

Layer Properties — landuse (basic) — Symbology

Q = Rule-based -
@ information | Label Rule Min. Scale Max. Scale  Count Duplicate Count
v| [l swellendam city "name” = 'Swellendam’
a\:\\ Source v Other residenttial "landuse” = 'residential' AND "name" <> 'Swellendam'
v| [l Big non residential areas "landuse" <> 'residential' AND "AREA" >= 605000
d Symbology v Small non residential areas ELSE
€3 Labels
€D Masks
W@ 30 View
>
4 Diagrams
L 4| Z symbol Levels...
E Fields

E Attributes Form

b Layer Rendering

Joins - | @Help Style - «/ Apply || % cancel

9. Apply this symbology

Your map will look something like this:

102 Kapitola 3. Module: Classifying Vector Data



QGIS Training Manual

Om&

Now you have a map with Swellendam the most prominent residential area and other non-residential areas colored
according to their size.

3.3.6 In Conclusion
Symbology allows us to represent the attributes of a layer in an easy-to-read way. It allows us as well as the map reader

to understand the significance of features, using any relevant attributes that we choose. Depending on the problems
you face, you’ll apply different classification techniques to solve them.

3.3.7 What’s Next?

Now we have a nice-looking map, but how are we going to get it out of QGIS and into a format we can print out, or
make into an image or PDF? That’s the topic of the next lesson!

3.3. Lesson: Classification 103



QGIS Training Manual

104 Kapitola 3. Module: Classifying Vector Data



KAPITOLA 4

Module: Laying out the Maps

In this module, you'll learn how to use the QGIS print layout to produce quality maps with all the requisite map
components.

4.1 Lesson: Using Print Layout

Now that you’ve got a map, you need to be able to print it or to export it to a document. The reason is, a GIS map
file is not an image. Rather, it saves the state of the GIS program, with references to all the layers, their labels,colors,
etc. So for someone who doesn’t have the data or the same GIS program (such as QGIS), the map file will be useless.
Luckily, QGIS can export its map file to a format that anyone’s computer can read, as well as printing out the map if
you have a printer connected. Both exporting and printing is handled via the Print Layout.

The goal for this lesson: To use the QGIS Print Layout to create a basic map with all the required settings.

411 \ Follow Along: The Layout Manager

QGIS allows you to create multiple maps using the same map file. For this reason, it has a tool called the Layout
Manager.

1. Click on the Project » Layout Manager... menu entry to open this tool. You'll see a blank Layout manager
dialog appear.
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Layout Manager B3

w New from Template

Empty layout -

Open template directory User

@Help % Close

2. Under New from Template, select Empty layout and press the Create... button.
3. Give the new layout the name of Swellendam and click OK.
4. You will now see the Print Layout window:

Swellendam
Layout Edit View [tems AddItem Atlas Settings

B [ &gl B8R p- o
|o |50 |100 |150 | |200 |250 ‘300 ltems BE®
ol b b b b b bbb booon b bveon vl —
@ - Item

0
1

50|
tria b

Layout | Item Properties | Guides

Item Properties (=]ES]
= Page Size
_E Size A4 K ER
i Orientation Landscape K EE
o_: Wwidth 297,000 =l I =
§ Height 210,000 &

Exclude page from exports =,

200|

«Pd FEAODHFEZOE

Background v

x: 169.559 mm y: 86.6092 mm page: 1 43.4% v |

You could also create this new layout via the Project » New Print Layout... menu.

Whichever route you take, the new print layout is now accessible from the Project » Layouts » menu, as in the image
below.
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Edit View Layer Settings Plugins Vector Raster Databa

" New Ctrl+N ;] gju g} &q

New from Template ’
Qpen... ctrl+o
Open From b
Open Recent »
Close
= save ctrl+s
| Save As... Ctrl+Shift+s
save To »
Revert...
Properties... Ctrli+Shift+P
Snapping Options...
Import/Export »
i New Print Layout... ctrl+P

2} New Report...

% Layout Manager...

Swellendam
Exit QGIS crl+Q

41.2 \ Follow Along: Basic Map Composition

In this example, the composition was already the way we wanted it. Ensure that yours is as well.

1. Right-click on the sheet in the central part of the layout window and choose Page properties... in the context
menu.

2. Check that the values in the Item Properties tab are set to the following:
* Size: A4
* Orientation: Landscape

Now you’ve got the page layout the way you wanted it, but this page is still blank. It clearly lacks a map. Let’s
fix that!

3. Click on the L £ A%Map bygion,
With this tool activated, you will be able to place a map on the page.

4. Click and drag a box on the blank page:
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*Swellendam

Layout Edit View [tems AddItem Atlas Settings

BRLURORE B @ikt e | | BE H- @

|o |50 |1on |150 |2ﬂn |250 | ‘300 ltems E®
v bbb b bvraoa b bvooo v bvvoar b bl vrah g —
@ 3 = & Item
el
ﬁ 3
5 EE Layout = Item Properties = Guides
!f;’ = Item Properties =]
8| :
L2
E
) .
E_
. |23
=._n ]
= ]
he <
3
width: 289.104 mm height: 202.495 mm X:292.763 mm y: 206.154 mm page: 1 43.4% v [

The map will appear on the page.
5. Move the map by clicking and dragging it around:

*Swellendam

Layout Edit View [tems AddIitem Atlas Settings

BRLRDR oy e | | B® H- B

300 Jtems
@ & Itern

|0 |50 |100 ||150 |200 |250
s oo b b oo b b oo boode b rcoac oo b ocoa v boroa vl

Aol &

Layout | Item Properties | Guides

I’;’ = Item Properties @®
2} = Map 1

— SERER MR =
IFYEE :
= 3 ¥ Main Properties [
| = Scale 38108 | &

E - -
i-'u = Map rotation 0,00° |v| LET
= E CRS Use Project CRS - | |§|
A} . v Draw map canvas items

Rz

2 2 ¥ Lavers |~

1 item selected X: 140.892 mm y: 101.247 mm page: 1 |43.4% v | (———

6. Resize it by clicking and dragging the boxes on the edges:
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*Swellendam
Layout Edit View [tems AddItem Atlas Settings

BRLEEB R @Rk e L@ B @

|n ] |50 |1nn |150 |2nn |250 ‘300 ltems E®
oo bevac bbb b bovvoe b boror b bvern vl —
@ - Item

L | Map 1

‘|
(NN

o
[

A

50

Layout | Item Properties | Guides

Item Properties (E]ES]
Map 1

L ERER NE =

wEEOGE
|\|||I|
p

6l al
100

¥ Main Properties

4

| 2 Scale 38108 <
==
i =3 Map rotation 0,00 ° 1
= = CRS Use Project CRS - |[&
A — ¥ Draw map canvas items
=
¥ = w Lavers ¥

width: 270.196 mm height: 187.247 mm X: 25.0069 mm y: 20.7374 mm page: 1 43.4% v [k

Poznamka: Your map may look a lot different, of course! This depends on how your own project is set up.
But not to worry! These instructions are general, so they will work the same regardless of what the map itself
looks like.

7. Be sure to leave margins along the edges, and a space along the top for the title.

8. Zoom in and out on the page (but not the map!) by using these buttons:
e e
: 3 s : l@ Move item content
9. Zoom and pan the map in the main QGIS window. You can also pan the map using the ove ttem content ¢q0],

The map view updates as you zoom in or zoom out.

10. If, for any reason, the map view does not refresh correctly, you can force the map to refresh by clicking the

E Refresh view button.

Remember that the size and position you've given the map doesn’t need to be final. You can always come back
and change it later if you’re not satisfied. For now, you need to ensure that you've saved your work on this map.
Because a Print Layout in QGIS is part of the main map file, you must save your project.

=]
11. Go to the Layout » Save Project. This is a convenient shortcut to the one in the main dialog.

413 \ Follow Along: Adding a Title

Now your map is looking good on the page, but your readers/users are not being told what’s going on yet. They need
some context, which is what you’ll provide for them by adding map elements. First, let us add a title.

. T
1. Click on the Add Label 1y, ¢ton

2. Click on the page, above the map, accept the suggested values in the New Item Properties dialog, and a label
will appear at the top of the map.

3. Resize it and place it in the top center of the page. It can be resized and moved in the same way that you resized
and moved the map.
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As you move the title, you'll notice that guidelines appear to help you position the title in the center of the page.

However, there is also a tool in the Actions Toolbar to help position the title relative to the map (not the page):
|IZI
4. Click the map to select it

5. Hold in Shift on your keyboard and click on the label so that both the map and the label are selected.

I .
6. Look for the | Alienseleced tems kft byygton and click on the dropdown arrow next to it to reveal the positioning

options and click |i—| Align center:

QS M » )
|3|ﬂ'? Iltem Align Left
all . Align Center g
| Align Right
~ Align Top

-~ Align Center Vertical

Layi - Align Bottom

Now the label frame is centered on the map, but not the contents. To center the contents of the label:
1. Select the label by clicking on it.
2. Click on the Item Properties tab in the side panel of the layout window.

3. Change the text of the label to ,,Swellendam*:
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La

yout | Item Properties | Guides

Itemn Properties
Label

v

v

Main Properties

Sswellendam

Render as HTML

Insert an Expression...

Appearance
Font
N -

Horizontal margin | 0.00 mm

Font color

Vertical margin 0.00 mm
Horizontal alignment
Left Center Right (e Justify
Vertical alignment
e Top Middle Bottom

Position and Size

Rotation
Frame
Background

Item ID

]

4. Use this interface to set the font and alignment options under the Appearance section:

1. Choose a large but sensible font (the example will use the default font with a size of 36)

2. Set the Horizontal Alignment to Center.

You can also change the font color, but it’s probably best to keep it black as per the default.

5. The default setting is not to add a frame to the title’s text box. However, if you wish to add a frame, you

can do so:

1. In the Item Properties tab, scroll down until you see the Frame option.

2. Click the Frame checkbox to enable the frame. You can also change the frame’s color and width.

In this example, we won’t enable the frame, so here is our page so far:

41.

Lesson: Using Pri

nt Layout
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*Swellendam
Layout Edit View [tems AddItem Atlas Settings

BRLROR b ®kbkiss6 B8O 9 LE hhHl > P -
R SRR s S D A o] L] e ) e e

0 ltems =
@ a8 ltem

| | Swellendam

v 71 Map1

Aol &

Swellendam

13
[E EE Layout | Item Properties | Guides
!f? = Item Properties (E=]ES
g -
IPYEE
=
=.__n '—:
E
e
X:173.218 mm y: -4.26947 mm page: 1 |43.4% n | (———

To make sure that you don’t accidentally move these elements around now that you’ve aligned them, you can
lock items into place:

1. Select both the label and the map items

Fii
2. Click the % Lock Selected Items 1yy¢to in the Actions Toolbar.

Poznamka: Click the [@I Unlock All Ttems by tton in the Actions Toolbar to be able to edit the items again.

41.4 \ Follow Along: Adding a Legend

The map reader also needs to be able to see what various things on the map actually mean. In some cases, like the
place names, this is quite obvious. In other cases, it’s more difficult to guess, like the colors of the forests. Let’s add
a new legend.

1. Click on the &g Add Lezend pyion

2. Click on the page to place the legend, accept the suggested values in the New Item Properties dialog,

3. Alegend is added to the layout page, showing layers symbology as set in the main dialog.

4. As usual, you can click and move the item to where you want it:
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*Swellendam

Layout Edit View Items AddIitem Aklas Settings

BRORER R eRREe ¢ B© 00 QR bbb > ®P -

v Resize to fit contents

|o |50 |1on |150 |2ﬂn | ‘250 ‘300 ltems =5
v bbb b boraoa b bvooo v brvoao b bl vl —
'{rj 1 @ 8 ltem
p = | | Legend
é 3 Swellendam v Swellendam
o 3 end
| % . [ trining_data buidings v O Map 1
T 4 [ craining,_data restaurants
@ = e p—— =
2- o i st Layout | Item Properties | Guides
!f;’ = * Item Properties =]
ears
3 watar Legend
!'_6 ] =Df:h(m arvas a8
= dus O ¥ Main Properties [
IFYEERR
] [ fami
A Wi Title |Legend | & |
-1 0 grass
] D industriat
=== Map [ EMap 1 ]
9 0 rusidensi
2= =z -m'::":rlm Wrap text on | |
I-n ; W seeyard
|| < — - Arrangement | 3= Symbols on Left - |
| 2

0 —
X:243.36 mm y: 29.2763 mm page: 1 |43.4% ~ |

415 / Follow Along: Customizing Legend Items

Not everything on the legend is necessary, so let’s remove some unwanted items.

1. In the Item Properties tab, you’ll find the Legend items group.

2. Uncheck the L) Auto update box, allowing you to directly modify the legend items
3. Select the entry with buildings

4. Delete it from the legend by clicking the = button
You can also rename items.

1. Select a layer from the same list.

2. Click the @ Edit selected item properties button.
3. Rename the layers to Places, Roads and Streets, Surface Water, and Rivers.

You can also reorder the items:
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*Swellendam

Layout Edit View Items AddIitem Aklas Settings
BRLREB L @kiplLe |l © 0 SR, b > B2

|o |50 |1on |150 |2ﬂn | ‘250 ‘30
b b bvrra bbb bvvoe b bveor oo bovoe vl o

0
1

Swellendam

0 ltems

@

"]
N
O
O

Item

Sswellendam

.
|m - —-Eg::od"—' O 7] Map 1
— 1 L . B T e ——
[E EE £ famlant Layout | ltem Properties | Guides
!f,\‘z = =_:;::m. Item Properties (=]
!__:' E corasrvition O Lmﬂd
o = = i » Main Properti =
[E - e ain Properties
] B cometary w Legend Items
q - Roads and streets
m - I
| 3 P _ Auto update | Update All |
Fz ~ Rivers E
E M surface water
- v (2 landuse
7 [ farmland
E [ grass
1 M Farect =4

»

X:242.75mm y:-0.609924 mm page: 1

|43.4% - | O—7r=

As the legend will likely be widened by the new layer names, you may wish to move and resize the legend and or map.
This is the result:

*Swellendam

Layout Edit View |[tems AddItem Atlas Settings
BRRREOB @ ®kEkge | 0@ SR, b HE

|o |50 |100 |150 |200 | ‘250 ‘300 ltems B®
o v b bbb brvoe b oo bvree b oroa boahcbrroa v
@ 3 \' ] Item
p — Swellendam ] Swellendam
% 3 O 1 Map 1
|@ | a- | Layout | Item Properties =~ Guides
FA’ E Layout
. = Legend |‘
g - s > General Settings
. B surface waker
[E E s » Guides and Grid
o= = - v Export Settings
o o
g__ 5 caruen Export resolution | 300 dpi 2|
- -
= == I g sroen || Print as raster
= | Roads and siroets || Always export as vectors
o 2 Plces
A} 8_: e || save world file
¥ 3 ¥ Resize Layout to Content -

X:237.87 mm y: 11.5885 mm page: 1 |43.4% n | (=
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4.1.6 \ Follow Along: Exporting Your Map

Poznamka: Did you remember to save your work often?

Finally the map is ready for export! You’'ll see the export buttons near the top left corner of the layout window:

o B princLavout, jpterfaces with a printer. Since the printer options will differ depending on the model of printer
that you're working with, it’s probably better to consult the printer manual or a general guide to printing for

more information on this topic.

The other buttons allow you to export the map page to a file.

o g Brportas Tmage, gives you a selection of various common image formats to choose from. This is probably the

simplest option, but the image it creates is ,,dead* and difficult to edit.

. Exportas SVG: If you're sending the map to a cartographer (who may want to edit the map for publication),
it’s best to export as an SVG. SVG stands for ,,Scalable Vector Graphic®, and can be imported to programs like

Inkscape or other vector image editing software.

> S, - .
o 1/ Exportas PDF: If you need to send the map to a client, it’s most common to use a PDF, because it’s easier to
set up printing options for a PDF. Some cartographers may prefer PDF as well, if they have a program that

allows them to import and edit this format.

For our purposes, we’re going to use PDF.

1. Click the "L Exportas PDF 1y3¢ton

2. Choose a save location and a file name as usual. The following dialog will show up.
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PDF Export Options 0

lw| Export Options

Always export as vectors
v Append georeference information
v Export RDF metadata (title, author, etc.)

Text export | Always Export Text as Paths (Recommended) -

v Advanced Options

Disable tiled raster layer exports

v Simplify geometries to reduce output File size

@Help % cancel | Psave |

3. You can safely use the default values now and click Save.
QGIS will proceed to the map export and push a message on top of the print layout dialog as soon as it finishes.

4. Click the hyperlink in the message to open the folder in which the PDF has been saved in your system’s file
manager

5. Open it and see how your layout looks.
Everything is OK? Congratulations on your first completed QGIS map project!
6. Anything unsatisfying? Go back to the QGIS window, do the appropriate modifications and export again.

7. Remember to save your project file.
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4.1.7 In Conclusion

Now you know how to create a basic static map layout. We can go a step further and create a map layout that adapts
dynamically, with more layout items.

4.2 Lesson: Creating a Dynamic Print Layout

Now that you have learned to create a basic map layout we go a step further and create a map layout that adapts
dynamically to our map extent and to the page properties, e.g. when you change the size of the page. Also, the date
of creation will adapt dynamically.

4.2.1 / Follow Along: Creating the dynamic map canvas

1. Load the ESRI Shapefile format datasets protected_areas.shp, places.shp, rivers.shp and
water . shp into the map canvas and adapt its properties to suit your own convenience.

2. After everything is rendered and symbolized to your liking, click the h NewPrint Layout jeon in the Project

toolbar or choose Project » & New Print Layout. You will be prompted to choose a title for the new print
layout.

3. We want to create a map layout consisting of a header and a map of the region near Swellendam, South Africa.
The layout should have a margin of 7.5 mm and the header should be 36mm high.

4. Create a map item called main map on the canvas and go to the Layout panel. Scroll down to the Variables
section and find the Layout part. Here we set some variables you can use all over the dynamic print layout. Go
to the Layout panel and scroll down to the Variables section. The first variable will define the margin. Press the

Ifl-l-ll:| button and type in the name sw_layout_margin. Set the value to 7. 5. Press the I:II-:II-I:I button again
and type in the name sw_layout_height_header. Set the value to 36.

5. Now you are ready to create the position and the size of the map canvas automatically by means of the
variables. Make sure that your map item is selected, go to the Item Properties panel, scroll down to and

open the Position and Size section. Click the 4E| paa gefned override for X and from the Variables entry, choose
@sw_layout_margin.

6. Click the 4E] paia defined override for Y, choose Edit... and type in the formula:

[to_real (@sw_layout_margin) + to_real (@sw_layout_height_header)

)

7. You can create the size of the map item by using the variables for Width and Height. Click the €
Data defined override for Widsh and choose Edit ... again. Fill in the formula:

[@layout_pagewidth - @sw_layout_margin * 2 J

Click the 4 €] Data defined override for Height and choose Edit .... Here fill in the formula:

[@layout_pageheight — (@sw_layout_height_header - (@sw_layout_margin * 2

8. We will also create a grid containing the coordinates of the main canvas map extent. Go to Ifem Properties

again and choose the Grids section. Insert a grid by clicking the EI'IE-J button. Click on Modify grid ... and set
the Interval for X, Y and Offset according to the map scale you chose in the QGIS main canvas. The Grid type
Cross is very well suited for our purposes.
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4.2.2 / Follow Along: Creating the dynamic header

1. Insert a rectangle which will contain the header with the 3 Add Shape by (ton, Tn the Items panel enter the name
header.

2. Again, go to the Item Properties and open the Position and Size section. Using 4E] pata definea override  choose the
sw_layout_margin variable for X as well as for Y. Width shall be defined by the expression:

[@layout_pagewidth - @sw_layout_margin * 2

and Height by the sw_layout_height_header variable.

3. We will insert a horizontal line and two vertical lines to divide the header into different sections using the IE
Add Node Item ' (“reate a horizontal line and two vertical lines and name them Horizontal line,Vertical
line 1Vertical line 2.

1. For the horizontal line:
1. Set X to the variable sw_layout_margin

2. Set the expression for Y to:

[@sw_layout_margin + 8

3. Set the expression for Width to:

[@layout_pagewidth - (@sw_layout_margin * 3 - 53.5

2. For the first vertical line:

1. Set the expression for X to:

[@layout_pagewidth - @sw_layout_margin * 2 - 53.5 J

2. Set Y to the variable sw_layout_margin

3. The height must be the same as the header we created, so set Height to the variable
sw_layout_height_header.

3. The second vertical line is placed to the left of the first one.

1. Set the expression for X to:

[@1ayout_pagewidth - @sw_layout_margin * 2 - 83.5 J

2. Set Y to the variable sw_layout_margin

3. The height shall be the same as the other vertical line, so set Height to the variable
sw_layout_height_header.

The figure below shows the structure of our dynamic layout. We will fill the areas created by the lines with
some elements.
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4.2.3 / Follow Along: Creating labels for the dynamic header

1. The title of your QGIS project can be included automatically. The title is set in the Project Properties. Insert

a label with the @! AddLabel bytton and enter the name project title (variable). In the Main
Properties of the Items Properties Panel enter the expression:

[[%@project_title%]

Set the position of the label.

1. For X, use the expression:

[@sw_layout_margin + 3

2. For Y, use the expression:

[@sw_layout_margin + 0.25

3. For Width, use the expression:

[@layout _pagewidth - @sw_layout_margin *2 - 90

4. Enter 11.25 for Height
Under Appearance set the Font size to 16 pt.

2. The second label will include a description of the map you created. Again, insert a label and name it map
description. In the Main Properties enter the text map description. In the Main Properties we will
also include:

[printed on: [%format_date(now (), 'dd.MM.yyyy') %] ]

Here we used two Date and Time functions (now and format_date).
Set the position of the label.

1. For X, use the expression:
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[@sw_layout_margin + 3 J

2. For Y, use the expression:

[@sw_layout_margin + 11.5 J

3. The third label will include information about your organisation. First we will create some variables in the

Variables menu of the Item Properties. Go to the Layout menu, click the I:II-I:I-I:I button each time and enter the
names o_department, o_name, o_adress and o_postcode. In the second row enter the information
about your organisation. We will use these variables in the Main Properties section.

In Main Properties enter:

)

@Qo_name %]
@o_department %]
@o_adress %]
Qo_postcode %]

o° o o

o

[
[
[
[

Set the position of the label.

1. For X, use the expression:

[@1ayout_pagewidth - @sw_layout_margin - 49.5 ]

2. For Y, use the expression:

[@sw_layout_margin + 15,5 ]

3. For Width, use 49.00

4. For Height, use the expression:

{@sw_layout_height_header = 15,5 ]
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Layout @ Item Properties = Guides = Atlas

Item Properties (3]
Label

¥ Main Properties

[% @o_name%]

[% @0 department]
[% @o_adress%]

Pﬁ @o_postcode%|

Render as HTML

Insert an EKPFEESiGI"I...

4.2.4 / Follow Along: Adding pictures to the dynamic header

1. Use the " AddPicwre byton to place a picture above your label organisation information. After
entering the name organisation logo define the position and size of the logo:

1. For X, use the expression:

[@layout_pagewidth - @sw_layout_margin - 49.5 ]

2. For Y, use the expression:

[@sw_layout_margin + 3.5 ]

3. For Width, use 39.292
4. For Height, use 9.583
To include a logo of your organisation you have to save your logo under your home directory and enter the path
under Main Properties » Image Source.
2. Our layout still needs a north arrow. This will also be inserted by using A] Add North Arrow e wil] use the
default north arrow. Define the position:

1. For X, use the expression:

[@layout_pagewidth - @sw_layout_margin * 2 - 78 ]

2. For Y, use the expression:
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[@ sw_layout_margin + 9

3. For Width,use 21.027
4. For Height,use 21.157

4.2.5 / Follow Along: Creating the scalebar of the dynamic header

1. To insert a scalebar in the header click on & AddSeale Bar apnd place it in the rectangle above the north arrow.
In Map under the Main Properties choose your main map (Map 1). This means that the scale changes
automatically according to the extent you choose in the QGIS main canvas. Choose the Style Numeric. This
means that we insert a simple scale without a scalebar. The scale still needs a position and size.

1. For X, use the expression:

{@layout_pagewidth - @sw_layout_margin * 2 - 78

2. For Y, use the expression:

{@ sw_layout_margin + 1

3. For Width, use 25
4. For Height, use 8
5. Place the Reference point in the center.

Congratulations! You have created your first dynamic map layout. Take a look at the layout and check if everything
looks the way you want it! The dynamic map layout reacts automatically when you change the page properties. For

(| .
example, if you change the page size from DIN A4 to DIN A3, click the Fw/ Refreshview byon and the page design
is adapted.
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Printed on: 16.05.2015 A "Your postcode’ v v " horizontal line
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¥ Appearance e
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E X 0,050000000000 =
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=24 . * ' Blend mode Normal ~| I~
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4.2.6 What’s Next?

On the next page, you will be given an assignment to complete. This will allow you to practice the techniques you
have learned so far.

4.3 Assighment 1

Open your existing map project and revise it thoroughly. If you have noticed small errors or things you’d have liked
to fix earlier, do so now.

While customizing your map, keep asking yourself questions. Is this map easy to read and understand for someone
who’s unfamiliar with the data? If I saw this map on the Internet, or on a poster, or in a magazine, would it capture
my attention? Would I want to read this map if it wasn’t mine?

If you're doing this course at a \ Basic or / Intermediate level, read up on techniques from the
more advanced sections. If you see something you'd like to do in your map, why not try to implement it?

If this course is being presented to you, the course presenter may require you to submit a final version of your map,
exported to PDF, for evaluation. If you're doing this course by yourself, it’s recommended that you evaluate your own
map using the same criteria. Your map will be evaluated on the overall appearance and symbology of the map itself,
as well as the appearance and layout of the map page and elements. Remember that the emphasis for evaluating the
appearance of maps will always be ease of use. The nicer the map is to look at and the easier it is to understand at
a glance, the better.

Happy customizing!

4.3.1 In Conclusion

The first four modules have taught you how to create and style a vector map. In the next four modules, you’ll learn
how to use QGIS for a complete GIS analysis. This will include creating and editing vector data; analyzing vector
data; using and analyzing raster data; and using GIS to solve a problem from start to finish, using both raster and
vector data sources.
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KAPITOLA D

Module: Creating Vector Data

Creating maps using existing data is just the beginning. In this module, you’ll learn how to modify existing vector
data and create new datasets entirely.

5.1 Lesson: Creating a New Vector Dataset

The data that you use has to come from somewhere. For most common applications, the data exists already; but the
more particular and specialized the project, the less likely it is that the data will already be available. In such cases,
you’ll need to create your own new data.

The goal for this lesson: To create a new vector dataset.

5.1.1 \ Follow Along: The Layer Creation Dialog

Before you can add new vector data, you need a vector dataset to add it to. In our case, you’ll begin by creating new
data entirely, rather than editing an existing dataset. Therefore, you’ll need to define your own new dataset first.

1. Open QGIS and create a new blank project.

2. Navigate to and click on the menu entry Layer » Create Layer » New Shapefile Layer. You'll be presented
with the New Shapefile Layer dialog, which will allow you to define a new layer.
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.
File name
File encoding UTF-8 >
Geometry type Point v
Additional dimensions ‘@' None Z (+ M values) M values
EPSG:4326 - WG5S B4 v ||

New Field

Name

Type | abc Text data v

Length |80 Precision

Add to Fields List

Fields List

MName Type Length Precision

id Integer 10

Remowve Field

OK Cancel Help

Click ... for the File name field. A save dialog will appear.
Navigate to the exercise_data directory.
Save your new layer as school_property.shp.

It’s important to decide which kind of dataset you want at this stage. Each different vector layer type is ,,built
differently in the background, so once you’ve created the layer, you can’t change its type.

For the next exercise, we're going to create new features which describe areas. For such features, you'll need
to create a polygon dataset.

For Geometry Type, select Polygon from the drop down menu:

Geometry type ~ Polygon -

This has no impact on the rest of the dialog, but it will cause the correct type of geometry to be used when the
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vector dataset is created.

The next field allows you to specify the Coordinate Reference System, or CRS. CRS is a method of associating
numerical coordinates with a position on the surface of the Earth. See the User Manual on Working with
Projections to learn more.

For this example we will use the default CRS associated with this project, which is WGS84.

EP5G:4326 - WG5S 84 - ||

Next there is a collection of fields grouped under New Field. By default, a new layer has only one attribute,
the id field (which you should see in the Fields list) below. However, in order for the data you create to be
useful, you actually need to say something about the features you'll be creating in this new layer. For our current
purposes, it will be enough to add one field called name that will hold Text data and will be limited to text
length of 80 characters.

7. Replicate the setup below, then click the Add to Fields List button:

New Field

MName |name
Type |ab<Text data -
Length 80 Precision

Add to Fields List

8. Check that your dialog now looks like this:
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G
File name aining-Data-2.0\exercise_data\school_property.shp
File encoding UTF-8 >
Geometry type ~ Polygon -
Additional dimensions ‘@' None Z (+ M values) M values
EPSG:4326 - WGS 84 v ||
New Field
Name
Type | abc Text data v
Length |80 Precision
Add to Fields List
Fields List
MName Type Length Precision
id Integer 10
name String a0
Remove Feld
OK Cancel Help
9. Click OK

The new layer should appear in your Layers panel.

5.1.2 \ Follow Along: Data Sources

When you create new data, it obviously has to be about objects that really exist on the ground. Therefore, you'll need
to get your information from somewhere.

There are many different ways to obtain data about objects. For example, you could use a GPS to capture points in
the real world, then import the data into QGIS afterwards. Or you could survey points using a theodolite, and enter
the coordinates manually to create new features. Or you could use the digitizing process to trace objects from remote
sensing data, such as satellite imagery or aerial photography.

For our example, you’ll be using the digitizing approach. Sample raster datasets are provided, so you’ll need to import
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them as necessary.

1. Click on ﬂ Data Source Manager y¢op

Select :.. Raster on the left side.

2.
3. In the Source panel, click on the ... button:
4. Navigate to exercise_data/raster/.
5. Select the file 3420C_2010_327_RGB_LATLNG.tif.
6. Click Open to close the dialogue window.
x
B crowser Source type
+ Vector ) )
@) Fle ) Protocol: HTTR(S), cloud, etc.
-"!:_ Mesh Loliis -
, Delimited Text Raster Dataset(s) ercise_data\raster\3420C_2010_327_RGB_LATLNG.tf & .. |
‘% GeoPackage
¥ 4" Spatialite
DB2, DB2
m Virtual Layer
&2 wms/wmTs
L wes
g WES
4 ArcGIS Map Server
; - ArcGIS Feature Server
- GeoMNode
| Cose || Add || Hep |
7. Click Add and Close. An image will load into your map.
5.1. Lesson: Creating a New Vector Dataset 129



QGIS Training Manual

@ *Untitled Project - QGIS - [} X
Project Edit View Layer Settings Plugins Vector Raster Database Web Mesh Help

DEEREX Lo PPRABLNR @6 -5 55 83 =90
®R@V.awm @ o - =y @ : ® 2

Layers (E2]E3)
o @ ® T O -0
v ¥ 3420C 2010 327 RGB LATLNG
v! [ school_property

[ & Typetolocate (cul+k) | Ready Coordinate| 20.5018,34.0192 |% Scale 1:27241 |~ | @ Mognifier 100%  |*| Rotation [0.0° %/ [v/Render @ EPsGia3zs @

8. If you don’t see an aerial image appear, select the new layer, right click, and choose Zoom fo Layer in the
context menu.
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() *Untitled Project - QGIS

Project Edit View Layer Settings Plugins Vector Raster Datab:

DEBRRY QPRI PR
B@V.Aam @ /7 :

Layers &
v [l ® T - O

3420C ?2n1n 227 par 1LATING |
sl '® Zoom to Layer

o2 Show in Overview

Copy Layer
Rename Layer
1 Zoom to Native Resolution (100%)
Stretch Using Current Extent
L] Duplicate Layer
[l Remove Layer...
Change Data Source...
Set Layer Scale Visibility...
Set CRS
Export
Styles

Properties...

9. Click on the ﬁ-) ZoomIn bytton, and zoom to the area highlighted in blue below:
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(@ *Untitled Project - QGIS - O x
Project Edit View Layer Settings Plugins Vector Raster Database Web Mesh Help

DEBRRX OBFLPAIPRPALEENR &6 -5 -5-5 Im-9 -
R@V- AR B ) b Sl R 2

Layers (E2]E3)
o @ ® T O -0
v ¥ 3420C 2010 327 RGB LATLNG
v! [ school_property

[ & Typetolocate (cul+k) | Ready Coordinate| 20.4529,-34.0291 |¥ Scale 1:27241 |~ @ Magnifier 100%  |%| Rotation [0.0° *|v/Render @ epsGi36 @

Now you are ready to digitize these three fields:
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Before starting to digitize, let’s move the school_property layer above the aerial image.

1. Select school_property layer in the Layers pane and drag it to the top.

Layers e
o [l ® T &§~3 F 4

v [ school property
v 2 3420C 2010 327 RGB LATLNG

In order to begin digitizing, you’ll need to enter edit mode. GIS software commonly requires this to prevent you from
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accidentally editing or deleting important data. Edit mode is switched on or off individually for each layer.
To enter edit mode for the school_property layer:

1. Click on the school_property layer in the Layers panel to select it.

F/ .
2. Click on the .’/ Toggle Editing [ytton.

If you can’t find this button, check that the Digitizing toolbar is enabled. There should be a check mark next to
the View » Toolbars » Digitizing menu entry.

As soon as you are in edit mode, you'll see that some digitizing tools have become active:

. £ Capture Polygon

o / % Vertex Tool

Other relevant buttons are still inactive, but will become active when we start interacting with our new data.

Notice that the layer school_property in the Layers panel now has the pencil icon, indicating that it is in
edit mode.

e )
3. Click on the L3 Capwre Polyzon bytton to begin digitizing our school fields.

You'll notice that your mouse cursor has become a crosshair. This allows you to more accurately place the
points you’ll be digitizing. Remember that even when you're using the digitizing tool, you can zoom in and
out on your map by rolling the mouse wheel, and you can pan around by holding down the mouse wheel and
dragging around in the map.

The first feature you’ll be digitizing is the athletics field:

4. Start digitizing by clicking on a point somewhere along the edge of the field.

5. Place more points by clicking further along the edge, until the shape you're drawing completely covers the field.
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@ +Untitled Project - QGIS — O b4
Project Edit View Layer Settings Plugins Vector Raster Database Web Mesh Help

DEBREY 0 ALHAPD "Q  LEORS &&-NN-8-F;HE -~
BR@V:Z2Rm @ 4/ 8BR - b =g mE R A

Layers e
@l e T &-#H0

v! [ school property
v/ I 3420C_2010_327_RGB_LATLNG

| Q Type to locate (Ctri+K) | i 20.444140,-34.024140 | ¢[1:1308 <| @rfwowe |33 00° |2 VIRender @ epsGiaszs @

6. After placing your last point, right click to finish drawing the polygon. This will finalize the feature and show
you the Attributes dialog.

7. Fill in the values as below:

school_property - Feature Attributes

d |1 a |
name |Athleﬁr:s Field & |
OK || Cancel |

5.1. Lesson: Creating a New Vector Dataset 135



QGIS Training Manual

8. Click OK, and you have created a new feature!

Q@ *Untitled Project - QGIS - O X

Project Edit View Layer Settings Plugins Vector Raster Database Web Mesh Help

EERRY 0APLPNPP R RBLNR @& -N-8-%8E -
RQV.Am B 2/B%x- 6o mqRqE - @ A

Layers
o e Ta-BAO

v [# school property
v! ¥ 3420C_2010_327_RGB_LATLNG

| Q. Type to locate (Ctri+K) | i) 20.447232,-34.023345 | ¥ ¢ 1:1308 v @rlwoe 3]s looe  [f| VIRender @ epsci43s @

9. In the Layers panel select the school_property layer.

10. Right click and choose Open Attribute Table in the context menu.
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() *Untitled Project - QGIS

Project Edit View Layer Settings Plugins Vector Ras

NEERREY U 2K
RSV Z @B 47

Layers |
« Ml ® T &~5 & O '
7 school prisa l

v % 3420C 2( + Zoom to Layer

Zoom to Selection
“2 Show in Overview
Show Feature Count
Copy Layer
Rename Layer
L Duplicate Layer
[4 Remove Layer...
8 Open Attribute Table
|;.i" |TDggIe Editing
; Current Edits
Filter...
Change Data Source...
Set Layer Scale Visibility...
Set CRS
Export
Styles

Properties...

In the table you will see the feature you just added. While in edit mode you can update the attributes data by
double click on the cell you want to update.
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id name
1 1| Athletics Field

T show Al Features _

g LT ES D BE P E »

* || Update All || Update Selected

11. Close the attribute table.

12. To save the new feature we just created, click on n' Save Edits ¢t

Remember, if you've made a mistake while digitizing a feature, you can always edit it after you're done creating it. If
you’ve made a mistake, continue digitizing until you're done creating the feature as above. Then:

1. Click on /E;{ Vertex Tool ¢,

2. Hover the mouse over a vertex you want to move and left click on the vertex.

3. Move the mouse to the correct location of the vertex, and left click. This will move the vertex to the new

location.
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The same procedure can be used to move a line segment, but you will need to hover over the midpoint of the
line segment.

If you want to undo a change, you can press the b Undo bytton or Ctr1+2.
4. Remember to save your changes by clicking the -4 Save Edits hyton,

5. When done editing, click the y Toggle Editing ytton to get out of edit mode.
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513 \ Try Yourself Digitizing Polygons

Digitize the school itself and the upper field. Use this image to assist you:

Remember that each new feature needs to have a unique id value!

Poznamka: When you’re done adding features to a layer, remember to save your edits and then exit edit mode.

Poznamka: You can style the fill, outline and label placement and formatting of the school_property using
techniques learnt in earlier lessons.
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514 / Follow Along: Using Vertex Editor Table

Another way to edit a feature is to manually enter the actual coordinate values for each vertex using the Vertex Editor
table.

1. Make sure you are in edit mode on layer school_property.

2. If not already activated, click on /H;( Vertex Tool ¢t

3. Move the mouse over one of the polygon features you created in the school_property layer and right
click on it. This will select the feature and a Vertex Editor pane will appear.

Wertex Editor (& )
X Y r

0 20.4456 -34.0226 |
oo s |
2204457 -34.0251

3204453 -34.0247

4 20.4450 -34.0250

5/ 20.4441 -34.0241

6 20.4456 -34.0226

Poznamka: This table contains the coordinates for the vertices of the feature. Notice there are seven vertices
for this feature, but only six are visually identified in the map area. Upon closer inspection, one will notice that
row 0 and 6 have identical coordinates. These are the start and end vertices of the feature geometry, and are
required in order to create a closed polygon feature.

4. Click and drag a box over a vertex, or multiple vertices, of the selected feature.
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)

The selected vertices will change to a color blue and the Vertex Editor table will have the corresponding rows
highlighted, which contain the coordinates of the vertices.
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Q@ “basic_map - QGIS - O X
Project Edit View Layer Settings Plugins Vector Raster Database Web Mesh Help

DB mRR @@w@a@ﬂa PP, EBLO
LLAYA NS AN % & < = B - @

Browser (=]
QaTHO
<+ Favorites =

» IV Spatial Bookmarks
’ Project Home
+ [a] Home
v OC\
+ @ GeoPackace
Layers (=]
o @l®To-#FTDL

roads

[#] school_property

¥ 3420C 2010 327 RGB LATLNG

[

Vertex Editor 3]
X ' r

0 20.4456 34,0226

1 20.4469 -34.0238

2 20,4457 -34.0251

-34.0247

-34.0250

-34.0241

| Q. Type tolocate (Ctri+K) | Validi rdi| 20.447353,-34.025117 |9 ¢|1:1521

5. To update a coordinate, double left click on the cell in the table that you want to edit and enter the updated
value. In this example, the x coordinate of row 4 is updated from 20.4450 to 20.4444.
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Vertex Editor ®
X v r
0| 20.4456 -34.0226
1) 20,4469 -34.0238
2| 20.4457 -34,0251
3/ 20.4453 -34.0247
e |
5 20,444 -34.0241
6| 20.4456 -34.0226
Q Type to locate (Ctri+K) Validi rdii| 20.4441

6. After entering the updated value, hit the enter key to apply the change. You will see the vertex move to the
new location in the map window.

7. When done editing, click the f Toggle Editing tyytton to get out of edit mode, and save your edits.

5.1.5 \ Try Yourself Digitizing Lines

We are going to digitize two routes which are not already marked on the roads layer; one is a path, the other is a track.
Our path runs along the southern edge of the suburb of Railton, starting and ending at marked roads:
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Our track is a little further to the south:
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. Since you are working with a line feature, click on the

. If the roads layer is not yet in your map, then add the roads layer from the GeoPackage file
training-data.gpkg included in the exercise_data folder of the training data you downloaded.
You can read Follow Along: Loading vector data from a GeoPackage Database for a how-to.

. Create a new ESRI Shapefile line dataset called routes. shp in the exercise_data directory, with

attributes 1d and type (use the approach above to guide you.)

. Activate edit mode on the routes layer.

Va

Add Line byytton to initiate line digitizing mode.

. One at a time, digitize the path and the track on the routes layer. Try to follow the routes as accurately

as possible, adding additional points along corners or turns.

. Set the type attribute value to path or track.

. Use the Layer Properties dialog to add styling to your routes. Feel free to use different styles for paths and

tracks.

4 -
. Save your edits and toggle off editing mode by pressing the f/ Toggle Editing 1y, tton,
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Answer

The symbology doesn’t matter, but the results should look more or less like this:

QGIS 2.0.1-Dufour - basic_map.

[/ e e N pe 8 =0 5o /1 B
= o

o)

I 3420C.2010_327_AGB_LATLNG

el ™ landuse

Y Bontebok National Park Entrance Gate

g Eontebok Nations Park Recapton & Shop

[P Browser

Toggles the editing state of the current layer There is a new plugin available [Q§] Coordinate: 20,44958,-34.04065 Scale (19566 1+ [S/] ¥ Render £PSG4326 [§]

5.1.6 In Conclusion

Now you know how to create features! This course doesn’t cover adding point features, because that’s not really
necessary once you’ve worked with more complicated features (lines and polygons). It works exactly the same, except
that you only click once where you want the point to be, give it attributes as usual, and then the feature is created.

Knowing how to digitize is important because it’s a very common activity in GIS programs.

5.1.7 What’s Next?

Features in a GIS layer aren’t just pictures, but objects in space. For example, adjacent polygons know where they are
in relation to one another. This is called topology. In the next lesson you’ll see an example of why this can be useful.

5.2 Lesson: Feature Topology

Topology is a useful aspect of vector data layers, because it minimizes errors such as overlap or gaps.

For example: if two features share a border, and you edit the border using topology, then you won’t need to edit first
one feature, then another, and carefully line up the borders so that they match. Instead, you can edit their shared
border and both features will change at the same time.

The goal for this lesson: To understand topology using examples.
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5.21 / Follow Along: Snapping

Snapping makes topological editing easier. This will allow your mouse cursor to snap to other objects while you
digitize. To set snapping options:

1. Navigate to the menu entry Project » Snapping Options....

2. Set up your Snapping options dialog to activate the Landuse layer with Type vertex and tolerance 12 pixels:

Project Snapping Settings x

« | & Advanced Configuration_ | v Topological Editing Snapping on Intersection

Layer Type Tolerance Units Avoid overlap

® places
[ buildings
— roads
M water
rivers
v landuse vertex 12 pixels v
[T protected_areas

Q. Filter layers...

3. Make sure that the box in the Avoid overlap column is checked.

4. Leave the dialog.

5. Select the landuse layer and enter edit mode ( Jf )
6. Check (under View » Toolbars) that the Advanced Digitizing toolbar is enabled.

7. Zoom to this area (enable layers and labels if necessary):

*example - QGIS o

Project Edit View Layer Settings Plugins Vector Raster Database Web Mesh Processing Help

NEERRYE VPSP APPR A EBEINR

LAVALEN - TE% TN NERDE 0" B Q- PRSI K-
Q& -H-a-LEEH#IEL]7 LB BOARTANP S - HRR - R

Layers @6
¢ @ ®T & AL
v/ e places
v| [ buildings
v| — roads
v| [ water
v rivers
landuse =
< v
Browser (]E)
Lerv®e
» 7 Favorites
~ » " spatial Bookmarks
[ Project Home
[& Home
o/
@ GeoPackage
# SpatiaLite
@ Postclis
P mMssqQL
@ pB2
@ WMS/WMTS
@ XYZ Tiles
& wcs
) WFS / OGC API - Features
) ows
& ArcGismapServer
& ArcGisFeatureServer
¢ GeoNode

BxCRENS @

-

4 4
v vewow

ﬁﬂ‘ @@@n‘

&

v vy ww

N

Q, Type to locate (Ctrl+K) Coordinate| 20.48982,-34.00907 |9 Scale|1:14392 ~ | @ Magnifier| 100% < | Rotation | 0,0 <||v/ Render & EPSG4326 @
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8. Digitize this new (fictional) area shown in red:

Project Edit View Layer Settings Plugins Vector Raster Database Web Mesh Progessing Help

O O pLHAPPr A BELR
TAVEL LS =4 S ARG R 6" -B-@- BIRwFXX-
Q&-N-B-LEE#IZE /T MR VORRR AP - HFRR > ®

Layers @6
Q@ cawmva-wan
v/ e places
v| [ buildings
v — roads
v| [ water
v rivers

landuse 15

< v
Browser (]E)
erv®e
» Favorites
+ | » [ spatial Bookmarks
» [*¥ Project Home
¥ | » [& Home
y [0/
» @ GeoPackage

landuse - Feature Attributes

" Actions

SEHHABNSBNS

« |+ /# SpatiaLite
» @ postcis
i -
;hDABSEQL ogc_fid [999\ a|v
= <
K@ |» @ wMs/WMTS Full_id NULL
b @ XYZTiles .
osm_i NULL
» & wes - — B——
» & WFS / OGC API - Features.
» O ows
& ArcGisMapServer
& ArcGisFeatureServer
¢ GeoNode
a
Q Type to locate (Ctrl+K) Coordinate| 20.49231,-34.00731 |$§ Scale| 1:14392 ~ | @ Magnifier| 100% %| Rotation |0,0° | v/ Render & EPSG4326 @

9. When prompted, give it an OGC_FID of 999, but feel free to leave the other values unchanged.

If you are careful while digitizing, and allow the cursor to snap to the vertices of adjoining areas, you’ll notice
that there won’t be any gaps between your new area and the existing adjacent areas.

10. Note the @ undo and (ED redo tools in the Advanced Digitizing toolbar.

5.2.2 / Follow Along: Correct Topological Features

Topology features can sometimes need to be updated. In our study area, an area has been turned into forest, so the
landuse layer need an update. We will therefore expand and join some forest features in this area:
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*example - QGIS
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Instead of creating new polygons to join the forest areas, we are going to use the Vertex Tool to edit and join existing
polygons.

1. Enter edit mode (if it is not active already)

2. Select the /-9’2 Vertex Tool ],

3. Choose an area of forest, select a vertex, and move it to an adjoining vertex so that the two forest features meet:
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*example - QGIS
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4. Click on the other vertices and snap them into place.

The topologically correct border looks like this:
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Go ahead and join a few more areas using the Vertex Tool.

@
You can also use the £ Add Polyzon Feature 6] 6 fi]] the gap between the two forest polygons. If you have enabled
Avoid overlap, you don’t have to add every single vertex - they will be added automatically if your new polygon
overlaps the existing ones.

If you are using our example data, you should have a forest area looking something like this:
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Don’t worry if you have joined more, less or different areas of forest.

5.2.3 / Follow Along: Tool: Simplify Feature

Continuing on the same layer, we will test the %) Simplify Feature 46,]:
1. Click on it to activate it.

2. Click on one of the areas which you joined using either the Vertex Tool or Add Feature tool. You will see this
dialog:
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|J¢§ancel|l «/ OK ]

- |

Method | simplify by distance

:] Layer units

Tolerance ’ oloooo00
1 feature(s): 17 to 17 vertices (100%)

3. Modify the Tolerance and watch what happens:

|X§ancel|[ «/ OK ]

- |

Method | Simplify by distance

A
“ | Tolerance ’

1 feature(s): 17 to 5 vertices (29%)

|:] | Layer units

This allows you to reduce the number of vertices.

4. Click OK
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The advantage of this tool is that it provides you with a simple and intuitive interface for generalization. But notice that
the tool ruins topology. The simplified polygon no longer shares boundaries with its adjacent polygons, as it should.
So this tool is better suited for stand-alone features.

Before you go on, set the polygon back to its original state by undoing the last change.

5.24 / Try Yourself Tool: Add Ring

The AddRing t00] allows you to add an interior ring to a polygon feature (cut a hole in the polygon), as long as the
hole is completely contained within the polygon (touching the boundary is OK). For example, if you have digitized
the outer boundaries of South Africa and you need to add a hole for Lesotho, you would use this tool.

If you experiment with the tool, you may notice that the snapping options can prevent you from creating a ring inside
a polygon. So you are advised to turn off snapping before cutting a hole.

1. Disable snapping for the 1anduse layer using the @ Enable Snapping by tton (or use the shortcut s).

2. Use the AddRing t40] to create a hole in the middle of a polygon geometry.
3. Draw a polygon over the target feature, as if you were using the Add polygon (0],

4. When you right-click, the hole will be visible.

5. Remove the hole you just created using the £ Pelete Ring (0] Click inside the hole to delete it.

Answer

The exact shape doesn’t matter, but you should be getting a hole in the middle of your feature, like this one:
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¢ Undo your edit before continuing with the exercise for the next tool.
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5.2.5 / Try Yourself Tool: Add Part

The % Add Part t60] allows you to add a new part to a feature, that is not directly connected to the main feature. For
example, if you have digitized the boundaries of mainland South Africa, but you haven’t yet added the Prince Edward

Islands, you would use this tool to create them.

1. Select the polygon to which you wish to add the part by using the i::[‘!«% Select Features by area or single click 0]

2. Use the Add Part tool to add an outlying area.

3. Delete the part you just created using the % Delete Part 0],

Poznamka: Click inside the part to delete it.

Answer

1. First select the Bontebok National Park:
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2. Now add your new part:
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0606 QGIS 2.0.1-Dufour - basic_map.
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3. Undo your edit before continuing with the exercise for the next tool.

5.2.6 / Follow Along: Tool: Reshape Features

The ? Reshape Features 10] s used to extend a polygon feature or cut away a part of it (along the boundary).

Extending:

1. Select the polygon using the Q?; Select Features by area or single click ]

2. Left-click inside the polygon to start drawing.

3. Draw a shape outside the polygon. The last vertex should be back inside the polygon.
4. Right-click to finish the shape:
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Cut away a part:

1
1. Select the pOlngIl using the % Select Features by area or single click tool.
2. Click outside the polygon.

3. Draw a shape inside the polygon. The last vertex must be back outside the polygon.
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4. Right-click outside the polygon:

000 2.0.1-Dufou basic_map
DBRLORN QS PLPLAHNPLLAMS & @ B b &8 BE =0 30 /1 B

PRI )

S RBIVBRABBOIR®LC

. 06 Layers

» & . places

e R

b -l

2

E » ™V rivers

@ » @  school_property

% [ 14" 3420C_2010_327_RGB_LATLNG

W

%

Vi

)

Validation finished. Coordinate: 20.4733,-34.0967 Scale [1:19951 [+ [&/| (¥ Render EPSG:4326

The result of the above:
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5.2.7 / Try Yourself Tool: Split Features

ao. . S
The g% SplitFeatures ¢o0] js similar to the U Reshape Feawres t66] except that it does not delete either of the two parts.
Instead, it keeps them both.

We will use the tool to split a corner from a polygon.

1. First, select the 1anduse layer and re-enable snapping for it.

ao._ .
2. Select the @® SPlitFeatwres ¢60] and click on a vertex to begin drawing a line.
3. Draw the bounding line.

4. Click a vertex on the ,,opposite” side of the polygon you wish to split and right-click to complete the line:
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5. At this point, it may seem as if nothing has happened. But remember that the 1anduse layer is rendered
without border lines, so the new division line will not be shown.

6. Use the Q/E Select Features by area or single click 0] 1o select the part you just split out; the new feature will now be
highlighted:

160 Kapitola 5. Module: Creating Vector Data



QGIS Training Manual
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5.2.8 == Try Yourself Tool: Merge Features
Now we will re-join the feature you just split out to the remaining part of the polygon:

==
1. Experlment with the @Merge Selected Features and == Merge Attributes of Selected Features tools.

2. Note the differences.

Answer
 Use the Merge Selected Features tool, making sure to first select both of the polygons you wish to merge.

* Use the feature with the OGC_FID of 1 as the source of your attributes (click on its entry in the dialog, then
click the Take attributes from selected feature button):

If you're using a different dataset, it is highly likely that your original polygon’s OGC_FID will not be 1. Just choose
the feature which has an OGC_FID.
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8086 Merge feature attributes
OGC_FID | GEOMETRY | osm_id | osm_way_id | name | type | aeroway amenity | adminjeve | barrier |
Id Skip attribute _:I Feature 1 _H Feature 1 _:T Feature 1 _:I Feature 1 _H Feature 1 _:T Feature 1 _:I Feature 1 _H Feature 1 _:T Feature 1 _:I Fei
|1 H1 HNULL Hzasﬁag? ” NULL ”Bomebok National Park Hboundary ”NULL HNULL HNULL ”NULL ‘@
14 NULL 2855697 NULL Bontebok National Park boundary NULL NULL NULL NULL atior
Morge  Skipped 2855607 Bontebok National Park boundary natic

| ] | Take atiributes from selected feature

| & | Remove feature from selection

| Cancel | OK

Using the Merge Attributes of Selected Features tool will keep the geometries distinct, but give them the same attributes.

5.2.9 In Conclusion

Topology editing is a powerful tool that allows you to create and modify objects quickly and easily, while ensuring
that they remain topologically correct.

5.2.10 What’s Next?

Now you know how to digitize the shape of the objects easily, but adding attributes is still a bit of a headache! Next
we will show you how to use forms, making attribute editing simpler and more effective.

5.3 Lesson: Forms

When you add new data via digitizing, you're presented with a dialog that lets you fill in the attributes for that feature.
However, this dialog is not, by default, very nice to look at. This can cause a usability problem, especially if you have
large datasets to create, or if you want other people to help you digitize and they find the default forms to be confusing.

Fortunately, QGIS lets you create your own custom dialogs for a layer. This lesson shows you how.

The goal for this lesson: To create a form for a layer.

5.3.1 \ Follow Along: Using QGIS‘ Form Design Functionality

1. Select the roads layer in the Layers panel
Enter Edit Mode as before
Open the roads layer’s attribute table

Right-click on any cell in the table. A short menu will appear, that includes the Open form entry.

A

Click on it to see the form that QGIS generates for this layer
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Obviously it would be nice to be able to do this while looking at the map, rather than needing to search for a specific
street in the Attribute Table all the time.

1.

2.

Select the roads layer in the Layers panel

,
Using the QZS Identify Feawres 0], click on any street in the map.

The Identify Results panel opens and shows a tree view of the fields values and other general information about
the clicked feature.

At the top of the panel, check the Auto open form for single feature results checkbox in the %y Identify Settings

menu.

5. Now, click again on any street in the map. Along the previous Identify Results dialog, you'll see the now-familiar
form:
808 Attributes - roads

osm_id | 47587910| a

name | NULL

highway unclassified a |

waterway | NULL

aerialway | NULL

barrier | NULL

man_made NULL

other_tags | “lanes'=>"2" a|

[[Conco | (0K

6. Each time you click on a single feature with the Identify tool, its form pops up as long as the Auto open form

is checked.

5.3.2 \ Try Yourself Using the Form to Edit Values

If you
1.

2.

are in edit mode, you can use this form to edit a feature’s attributes.

Activate edit mode (if it isn’t already activated).

,
Using the Q& Identify Features 6] click on the main street running through Swellendam:
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Y 4 ® X *.
% XK S e : ¢ osmid  [2a8a08188

nams [Voortreic Sreet al

highway [tertiary al

waterway | NULL ‘

aerialway | NULL |

barrier [nuLe |

man_made |NULL |

other_tags |"Ianm"=>"2“

3. Edit its highway value to be secondary

4. Exit edit mode and save your edits

5. Open the Attribute Table and note that the value has been updated in the attributes table and therefore in the
source data

5.3.3 / Follow Along: Setting Form Field Types

It’s nice to edit things using a form, but you still have to enter everything by hand. Fortunately, forms have different
kinds of so-called widgets that allow you to edit data in various different ways.

1. Open the roads layer’s Properties...
2. Switch to the Fields tab. You'll see this:
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Layer Properties - roads | Fields

|/ | &)
,’i e Tem id -~ Name Alias Type Typename Length Precision Comment WMS WFS *
s 122 0 [fid glonglong Integer64 0 0 v v
W Source . . :
: abe 1 Full_id Qstring  String 255 0 v v
-
& Symbology ac 2 | osm_id Qstring  String 255 0 v v
a3 Labels abc 3 osm_type QString  String 255 0 v v
ac 5 lanes Strin strin 0 v v
d Diagrams Q < =
-~ ac §  maxspeed Qstring  String 255 0 v v
hy 3D View . .
abc 7 oneway Qstring  String 255 0 v v
[ 5 Fields ae 8 | ref QString  String 255 0 v v
Attributes . .
B abc 9 surface Qstring  String 255 0 v v
Joins abc 10 name Qstring  string 255 0 v v
_’l Augxiliary abc 11 embankment Qstring  String 255 0 v v
Storage . . .
@ abc 12 maxweight Qstring  String 255 0 v v -
AF} Actions
.| @Help || shyle - | JApply || X cancel || oK |
3. Switch to the Attributes Form tab. You'll see this:
Layer Properties - roads | Attributes Form
|Autogenerate - \ |E\ |Show form on add Feature (global settings) ~ |
) Information “ | Available widgets =
Fields
23 source fid
- Full_id
=" symbol osm_id
o Abehy osm_type
€= Labels highway
lanes
maxspeed
€D Masks oneway
- , ref
, Diagrams surface
name
W 3D View embankment
maxweight
E Fields destination:back...
destination:Fforward
Attributes Form destination:ref:ba...
destination:symb...
Joins cutting
access
ﬂ Augxiliary hgv
Storage Foot -
——— |
B oacions T “Jnopl | Xcancel [ doK_]

4. Click on the oneway row and choose Checkbox as Widget Type in the list of options:
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Layer Properties - roads | Attributes Form X

Autogenerate

“ Available widgets =
~ Fields
fid
full_id
osm_id
osm_type
highway
lanes

-||A

v General

Alias

Comment

v| Editable Label on top

Show form on add feature (global settings) ~

-

maxsEeed

ref

surface

name

embankment
maxweight
destination:backw...
destination:forward
destination:ref:ba...
destination:symbo...
cutting

access

hgv

foot

sac_scale

name:af
lanes:backward
lanes:forward
reg_ref

bicycle

cycleway v
sidewalk

service

bridge

it -8B B « & @

Classification
Color
Date/Time

Attachment
Hidden

Relation Reference
Text Edit

Unigue Values
Uuid Generator
Value Map

Value Relation

_

layer =

@Help

Style -~

5. Click OK

</ Apply

6. Enter edit mode (if the roads layer is not already in edit mode)

7. Click on the Q& Identify Features 6]

8. Click on the same main road you

chose earlier

-

#® Cancel

You will now see that the oneway attribute has a checkbox next to it denoting True (checked) or Fa 1 se (unchecked).

5.34 .ﬂ—. Try Yourself

Set a more appropriate form widget for

the highway field.

Answer

For the TYPE, there is obviously a limited amount of types that a road can be, and if you check the attribute table for
this layer, you’ll see that they are predefined.

1. Set the widget to Value Map and click Load Data from Layer.

2. Select roads in the Label dropdown and highway for both the Value and Description options:
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|2 | highway | QSiring ‘ String | 254

| R I P |

|° | | EERGeVRESEaARIE

[a I I

Attribute Edit Dialog "highway"

ms Line edit (¥ Editable
Classification || Label on top
ata Range

Unigue values
File name

Value map shown in the combo box.

Combo box with predefined items. Value is stored in the attribute

™ v
| ~ ~
& ~

Select data from atiributes in selected layer.

Enumeration
Immutable

Load Data from layer l [ Load Data from CSV file

Hidden

Checkbox Value Description

Text edit
Calendar 1 |

Layer
Value

Description

[ roads ;]

highway

View All

“
v

Value

Description

Value relation
UUID generator
Photo

Webview

Color

footway

footway

path

path

primary

primary

residential

residential

service

service

tertiary

tertiary

Remove Selected

el | [0k ]

3. Click OK three times.

4. If you use the Identify tool on a street now while edit mode is active, the dialog you get should look like this:

8006 Attributes - roads - -
osm_id 238808188
name Voortrek Street |
highway [ secondary 4]
waterway | NULL |
aerialway  NULL |
barrier 'NULL |
man_made ||
other_tags | "lanes'=>"2" a|

Cancel | (0K

5.3. Lesson: Forms

167



QGIS Training Manual

5.3.5 == Try Yourself Creating Test Data

You can also design your own custom form completely from scratch.
1. Create a simple point layer named test-data with two attributes:
¢ name (text)

* age (integer)

New GeoPackage Layer x

Database training_data.gpkg
Table name test-data

Geometry type Point >

Include Z dimension Include M values
EPSG:4326 - WGS 84 v ||
New Field
Name
Type 123 \Whole Number (integer) -

Maximum length

Fields List
Name Type Length
name text 80
age integer

v Advanced Options

Layer identifier test-data
Layer description

Feature id column | fid
Geometry column geometry

V| Create a spatial index

@ Help Ocancel Sok

2. Capture a few points on your new layer using the digitizing tools so that you have a little data to play with. You
should be presented with the default QGIS generated attribute capture form each time you capture a new point.

Poznamka: You may need to disable Snapping if still enabled from earlier tasks.
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test-data - Feature Attributes X

fid Autogenerate a| v
name richard a
age 23 =

Ocance

5.3.6 == Follow Along: Creating a New Form

Now we want to create our own custom form for the attribute data capture phase. To do this, you need to have QT
Designer installed (only needed for the person who creates the forms).
1. Start QT Designer.

2. In the dialog that appears, create a new dialog:

006 New Form

templates/torms
Dialog with Buttons Bottom

Dialog with Buttons Right
Dialog without Buttons
Main Window
Widget
Widgets
Cancel 0K
Embedded Design
Device: Nene
Screen Size: | Default size s
(v Show this Dialog on Startup
| Open.. | [ Recentw | | Close | [ Create |

3. Look for the Widget Box along the left of your screen (default). It contains an item called Line Edit.
4. Click and drag this item into your form. This creates a new Line Edit in the form.

5. With the new line edit element selected, you'll see its properties along the side of your screen (on the right by
default):
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10.
11.
12.

13.
14.

000

Property Editor

[Filter

lineEdit : QLineEdit

ar, = 7,

Praperty

Valug

lineEdit

-

enabled ™

» geometry [(80, 40), 113 x 21]

» sizePolicy [Expanding, Fixed, 0, 0]

»  minimumSize 0x0

» maximumSize 16777215 x 16777215

» sizelncrement 0x0

» baseSize 0x0
palette Inherited

» font A [Lucida Grande Ul, 13]
cursor | I1Beam
mouseTracking ™
focusPolicy StrongFocus
contextMenuPolicy | DefaultContextMenu
acceptDrops ™

» toolTip

b statusTip

» whatsThis

» accessibleName

» accessibleDescrip...
layoutDirection LeftToRight

autoFillBackground

styleSheet

» locale

English, SouthAfrica

p inputMethodHints ImhNone

\

» inputMask

b text
maxLength 32767
frame [21
echoMode Normal
cursorPosition 0

» alignment AlignLeft, AlignVCenter
dragEnabled ]
readOnly ]

p placeholderText

curanrifnvaShiles

| nniralMovaShile

Set its name to name.
Using the same approach, create a new Spin Box and set its name to age.

Add a Label with the text Add a New Person in a bold font (look in the object properties to find out how
to set this). Alternatively, you may want to set the title of the dialog itself (rather than adding a label).

Add a Label for your Line Edit and your Spin Box.
Arrange the elements to your own desire.
Click anywhere in your dialog.

Find the Lay Out in a Form Layout button (in a toolbar along the top edge of the screen, by default). This lays
out your dialog automatically.

Set the dialog’s maximum size (in its properties) to 200 (width) by 150 (height).

Your form should now look similar to this:
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8 -add_people.ui* |- [X

15. Save your new form as exercise_data/forms/add_people.ui

16. When it’s done saving, you can close Qf Designer

5.3.7 ﬂ'—- Follow Along: Associating the Form with Your Layer

Go back to QGIS
Double click the fest-data layer in the legend to access its properties.
Click on the Attributes Form tab in the Layer Properties dialog

In the Attribute editor layout dropdown, select Provide ui-file.

Al

Click the ellipsis button and choose the add_people.ui file you just created:

Layer Properties - test-data | Attributes Form *

Q Provide ui-file -

“ Edit Ul |/home/qgis-user/forms/add_people.ui

G’ Information

Available widgets

® v General
W\ Source ~ Fields
fid .
ES Al
& symbology name ias
g Comment
€= Labels Relations i
~ Other widgets | Editable Label on top
@ Masks QML Widget
HTML Widget v Widget Type
Diagrams
Text Edit
Wg 3D View
Multiline
E Fields
Attributes Form
Joins w Constraints
L Auxiliary
&1 storage Not null
(;‘.-G) Actions Unique
: Expression
. Display
” Expression description
& Rendering
) Enforce expression constraint
Variables
_ v Defaults
a Metadata
Default value
E Dependencies Preview
Legend Apply default value on update
QGIS Server
@Help Style -~

6. Click OK on the Layer Properties dialog

7. Enter edit mode and capture a new point

# || Show Form on add fFeature (global settings) ~

# Cancel

« Apply
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8. When you do so, you will be presented with your custom dialog (instead of the generic one that QGIS usually
creates).

9. If you click on one of your points using the Q% Identify Features 46,6] you can now bring up the form by right
clicking in the identify results window and choosing View Feature Form from the context menu.

10. If you are in edit mode for this layer, that context menu will show Edit Feature Form instead, and you can then
adjust the attributes in the new form even after initial capture.

5.3.8 In Conclusion

Using forms, you can make life easier for yourself when editing or creating data. By editing widget types or creating
an entirely new form from scratch, you can control the experience of someone who digitizes new data for that layer,
thereby minimizing misunderstandings and unnecessary errors.

5.3.9 Further Reading

If you completed the advanced section above and have knowledge of Python, you may want to check out this blog entry
about creating custom feature forms with Python logic, which allows advanced functions including data validation,
autocompletion, etc.

5.3.10 What’s Next?

Opening a form on identifying a feature is one of the standard actions that QGIS can perform. However, you can also
direct it to perform custom actions that you define. This is the subject of the next lesson.

5.4 ILSI akce

Now that you have seen a default action in the previous lesson, it is time to define your own actions.

An action is something that happens when you click on a feature. It can add a lot of extra functionality to your map,
allowing you to retrieve additional information about an object, for example. Assigning actions can add a whole new
dimension to your map!

Cil této lekce. Naucit se jak pfidat béznou akci.

In this lesson you will use the school_property layer you created previously. The sample data include photos of each
of the three properties you digitized. What we are going to do is to associate each property with its image. Then we
will create an action that will open the image for a property when clicking on the property.

5.4.1 |zakladni| Follow Along: pridat pole pro obrazky
The school_property layer has no way to associate an image with a property yet. First we will create a field for
this purpose.

1. Oteviit: guilabel: dialog Viastnosti vrstvy .

2. Klikni na: guilabel: kartu Pole.

3. Pfepnout rezim editace.
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Layer Properties - school_property | Fields

NE
d - 1Toggle editing mode t'pe Type name  Length Precision = Comment

1230 |id glonglong | Integer64 10 0 v

‘:{:\? Source

%" symbology

abc | name Qstring  String 80 0 v
€3 Labels

B Masks

- .
. [MELEIN S

W7 3D View
E 5 Fields

E Aktributes Form

1 4

Joins
s Auxiliary . @telp || style -  Japply | ®cancel || Jok |

4. Pridat novy sloupec:

Layer Properties - school_property | Fields

? LAl
fi [EEEETEE e + |New field jme Alias Type Type name Length Precision Comment

1230 |id glonglong | Integer64 10 0 v

‘:{:\\ Source . :
; ac 1 pame Qstring | String 80 0 Y

%~ symbology

€3 Labels

€D Masks

- .
. Diagrams

W7 3D View

5. Vlozit hodnoty niZe:
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Add Field

Name

Comment

Type

|image|

Text (string)

Provider type string

Length

il
-

% cancel | o OK |

6. After the field has been created, move to the Atributes Form tab and select the image field.

7. Set Widget Type to Attachment:

Layer Properties - school_property | Attributes Form x

G’ Information

‘:{:\} Source

¥ symbology

> .
" Diagrams

W# 3D View
ﬁ Fields

::E: Attributes For

Joins

L Auxiliary
&M Storage

«;@ Actions
- Display
Qj./ Rendering

Variables

l Metadata

ﬁ Dependencies
Legend

& qais server

8. Click OK in the Layer Properties dialog.

* | Available widgets

~ Other Widgets

v General

Alias
Comment
v| Editable

v Widget Type
Attachment

Path

Label on top

~ | @ || show form on add feature (global settings) ~

-

Default path |/home/tveite/Downloads/QGIS/QGISTrainin... || ... | €

Relative paths

Storage Mode

@ File paths
Directory paths

v Display Resource Path

v Display button to open File dialog

Filter

Use a hyperlink For document path (read-only)

-

</ Apply || % cancel oK

9. Pouzit: guilabel: nastroj identifikovat ke kliknuti na jednu ze tii funkci v: guilabel: vlastnost skolni viastosti.

Since you are still in edit mode, the dialog should be active and look like this:
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school_property - Feature Attributes .

Actions

id |2 |

name school campus

image

% cancel | &/ OK |

10. Kliknout na tlacitko prochazet ( guilabel:... vedle :guilabel: pole obrdzek ).

11. Select the path for your image. The images are in exercise_data/school_property_photos/ and
are named the same as the features they should be associated with.

12. Kliknout OK.
13. Pro spojeni vSechech obrazk se spravnymi funkcemi pouZit tuto metodu.

14. Uloz tvoje dpravy a opust’ rezim tprav.

5.4.2 |zakladni| Follow Along: vytvorit akci

1. Open the Actions tab for the school_property layer, and click on the Ifl-l-ll:| Add anew action b0,

Layer Properties - school_property | Actions x

Q, ¥ Action List

"i Information Description Short Title Action  Capture Action Scopes On Notification Only when editable
‘?\_“\\ Source

% symbology

€ Labels

€O Masks

- N
a Diagrams

W# 3D View

E Fields

E Attributes Form

Joins
4 »

ﬂ Auxiliary Storage Lk Create Default Actions

Actions Add a new action

» Show in Attribute Table

® Display _| @Help Style - «/ Apply || % Cancel

2. In the Add New Action dialog, enter the words Show Image into the Description field:
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Add New Action -~

Type Generic - Capture output

Description |Mandatory description
Short Mame |Leave empty to use only icon
lcon

Action Scopes

Field Scope
Layer Scope
v Canvas

v Feature Scope

Action Text

The action text defines what happens if the action is triggered.
The content depends on the type.

For the type Python the content should be python code
For other types it should be a file or application with optional parameters

1 3
| E Insert
Execute if notification matches

Enable only when editable

@Hel ¥ cancel
p L

o délat ddl, se lisi v zdvislosti na operaCnim systému, takZe vyber vhodny kurz a nésledu;:

¢ Okna
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Kliknout na :guilabel: rozbal Typ a vyber otevrit.
e Ubuntu Linux

Under Action, write eog for the Gnome Image Viewer, or write display to use ImageMagick.
Remember to put a space after the command!

* macOS
1. Klikni na Typ rozbal ho a vyber Mac.
2. Under Action, write open. Remember to put a space after the command!
Now you can continue writing the command.
Chces otevrit obrazek, a QGIS vi, kde obrdzek je. VSe co potiebujes je napsat Akce tam kde je obrazek.

3. Vyber obrdzek z nabidky:
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Add New Action i3

Type Generic - Capture output

Description |Mandatory description
Short Mame |Leave empty to use only icon
lcon

Action Scopes

Field Scope
Layer Scope
v Canvas

v Feature Scope

Action Text

The action text defines what happens if the action is triggered.
The content depends on the type.

For the type Python the content should be python code
For other types it should be a file or application with optional parameters

1 eoq- [%imageS]

4 b
123 id

abc name

@Help % Cancel

4. Click the Insert field button. QGIS will add the phrase [$ "image" %] in the Action Text field.
5. Click the OK button to close the Add New Action dialog
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6.

Click OK to close the Layer Properties dialog

Now it is time to test the new action:

1.

2.

Click on the school_property layer in the Layers panel so that it is highlighted.

: "@-\l‘- Run feature action : :
Find the ==z Runfeatureaction bytton (in the Attributes Toolbar).

Click on the down arrow to the right of this button. There is only one action defined for this layer so far, which
is the one you just created.

4.
5.

TN oo

Klikni na toto tlacitko a aktivuj néstroj.
Pouziti tohoto ndstroje, kliknutim na kteroukoli z tii Skolnich vlastnosti.

The image for that property should open.

5.4.3 |stfedni| Follow Along: vyhledavani na internetu

Let’s say we are looking at the map and want to know more about the area that a farm is in. Suppose you know nothing
of the area in question and want to find general information about it. Your first impulse, considering that you're using
a computer right now, would probably be to Google the name of the area. So let’s tell QGIS to do that automatically
for us!

1.

. Remove all the actions but the Open URL action with the short name Search Web using the

Otevti vlastnost tabulky pro nosi¢ vyuZivdni piidy.
We will be using the name field for each of our landuse areas to search Google.
Close the attribute table.
Go back to Actions in Layer Properties.
Click on the Create Default Actions button to add a number of pre-defined actions.
=
Remove the selected action by1¢ton below.
Double-click on the remaining action to edit it
Change the Description to Google Search, and remove the content of the Short Name field.
Make sure that Canvas is among the checked Action scopes.
o délat dl, se 1isi v zavislosti na operacnim systému, takze vyber vhodny kurz a nésledu;:
e Okna

Under T'ype, choose Open. This will tell Windows to open an Internet address in your default browser,
such as Internet Explorer.

¢ Ubuntu Linux

Under Action, write xdg—open. This will tell Ubuntu to open an Internet address in your default browser,
such as Chrome or Firefox.

¢ macOS

Under Action, write open. This will tell macOS to open an Internet address in your default browser, such
as Safari.
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Now you can continue writing the command

Whichever command you used above, you need to tell it which Internet address to open next. You want it to
visit Google, and to search for a phrase automatically.

Usually when you use Google, you enter your search phrase into the Google Search bar. But in this case, you
want your computer to do this for you. The way you tell Google to search for something (if you don’t want to
use its search bar directly) is by giving your Internet browser the address https://www.google.com/
search?gq=SEARCH_PHRASE, where SEARCH_PHRASE" is what you want to search for. Since we don’t
know what phrase to search for yet, we will just enter the first part (without the search phrase).

In the Action field, write https: //www.google.com/search?qg=. Remember to add a space after your
initial command before writing this in!

Now you want QGIS to tell the browser to tell Google to search for the value of name for any feature that you
could click on.

10. Select the name field.

11. Click Insert button:
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Edit Action -~

Type Generic - Capture output

Description |Google Search
Short Mame |Leave empty to use only icon
lcon

Action Scopes

Field Scope
Layer Scope
v Canvas

Feature Scope

Action Text

The action text defines what happens if the action is triggered.
The content depends on the type.

For the type Python the content should be python code
For other types it should be a file or application with optional parameters

1 xdg-open-http://www.google.com/search?q=[%name%]

1 b

| E Insert

Execute if notification matches || l

Enable only when editable
@Help % Cancel

What this means is that QGIS is going to open the browser and send it to the address https://www.

google.com/search?g=[% "name" %].[% "name" %] tells QGIS to use the contents of the
name field as the phrase to search for.
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So if, for example, the landuse area you click on is named Marloth Nature Reserve, QGIS is going to
send the browser to https://www.google.com/search?g=Marloth%20Nature%20Reserve,
which will cause your browser to visit Google, which will in turn search for ,Marloth Nature Reserve®.

12. If you have not done so already, set everything up as explained above.
13. Click the OK button to close the Add New Action dialog
14. Click OK to close the Layer Properties dialog

Now to test the new action.

@ .
1. With the landuse layer active in the Layers panel, click on the down arrow to the right of the &1& Run feature action

button, and select the only action (Google Search) defined for this layer.

2. Click on any landuse area you can see on the map. Your browser will now open, and will start a Google search
for the place that is recorded as that area’s name value.

Poznamka: If your action doesn’t work, check that everything was entered correctly; typos are common with this
kind of work!

5.4.4 === Follow Along: Open a Webpage Directly in QGIS

Above, you’ve seen how to open a webpage in an external browser. There are some shortcomings with this approach
in that it adds an unknowable dependency — will the end-user have the software required to execute the action on
their system? As you've seen, they don’t necessarily even have the same kind of base command for the same kind
of action, if you don’t know which OS they will be using. With some OS versions, the above commands to open the
browser might not work at all. This could be an insurmountable problem.

However, QGIS sits on top of the incredibly powerful and versatile Qt library. Also, QGIS actions can be arbitrary,
tokenized (i.e. using variable information based on the contents of a field attribute) Python commands!

Now you will see how to use a python action to show a web page. It is the same general idea as opening a site in
an external browser, but it requires no browser on the user’s system since it uses the Qt QWebView class (which
is a webkit based html widget) to display the content in a pop-up window.

Let us use Wikipedia this time. So the URL you request will look like this:
https://wikipedia.org/wiki/SEARCH_PHRASE
To create the layer action:
1. Open the Layer Properties dialog and head over to the Actions tab.
2. Set up a new action using the following properties for the action:
e Type: Python
* Description: Wikipedia
e Scope: Feature, Canvas

e Action Text:

from qgis.PyQt.QtCore import QUrl
from ggis.PyQt.QtWebKitWidgets import QWebView

myWV = QWebView (None)
myWV.load (QUrl ('https://wikipedia.org/wiki/ [$name%] "))
myWV . show ()
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Edit Action X

Type Python - Capture output
Description |wikipedia

Short Name |Leave empty to use only icon

lcon

Action Scopes

Layer
| Feature
¥ Canvas

Field

Form

Action Text

The action text defines what happens if the action is triggered.

The content depends on the type.

For the type Python the content should be Python code, if the action is triggered from a button
widget embedded in a drag and drop designer Form, the form instance is exposed to Python as
the formvariable.

For other types it should be a File or application with optional parameters.

1 from-qgis.PyQt.QtCore-import -QuUrl

2 from-qgis.PyQt.QtWebKitWidgets import  QwWebView

3

4 myWV =-QWebView(None)

5 myWv.load(QUrl("https://wikipedia.org/wiki/[%name%]"'))

6 mywv.show()

7
1 #
123 *|| £ Insert

Execute if notification matches

Enable only when editable

@ Help © cancel QoK

There are a couple of things going on here:

* [$name%] will be replaced by the actual attribute value when the action is invoked (as before).

¢ The code simply creates a new QWebView instance, sets its URL, and then calls show () on it to make
it visible as a window on the user’s desktop.

You could also use this approach to display an image without requiring that the users have a particular image
viewer on their system.

3. Try to use the methods described above to load a Wikipedia page using the Wikipedia action you just created.

5.4. ILSI akce 183



QGIS Training Manual

5.4.5 In Conclusion
Actions allow you to give your map extra functionality, useful to the end-user who views the same map in QGIS. Due

to the fact that you can use shell commands for any operating system, as well as Python, the sky is the limit in terms
of the functions you could incorporate!

5.4.6 What’s Next?

Now that you’ve done all kinds of vector data creation, you will learn how to analyze the data to solve problems. That
is the topic of the next module.
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Module: Vector Analysis

Now that you have edited a few features, you must want to know what else one can do with them. Having features
with attributes is nice, but when all is said and done, this doesn’t really tell you anything that a normal, non-GIS map
can’t.

The key advantage of a GIS is this: a GIS can answer questions.

For the next three modules, we’ll endeavor to answer a research question using GIS functions. For example, you are an
estate agent and you are looking for a residential property in Swellendam for clients who have the following criteria:

1. It needs to be in Swellendam.

2. It must be within reasonable driving distance of a school (say 1km).
3. It must be more than 100m squared in size.

4. Closer than 50m to a main road.

5. Closer than 500m to a restaurant.

Within the next few modules, we’ll harness the power of GIS analysis tools to locate suitable farm properties for this
new residential development.

6.1 Lesson: Reprojecting and Transforming Data

Let us talk about Coordinate Reference Systems (CRSs) again. We have touched on this briefly before, but haven’t
discussed what it means practically.

The goal for this lesson: To reproject and transform vector datasets.
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6.1.1 \ Follow Along: Projections

The CRS that all the data, as well as the map itself are in right now is called WGS84. This is a very common Geographic
Coordinate System (GCS) for representing data. But there’s a problem, as we will see.

1. Save your current map

2. Then open the map of the world which you will find under exercise_data/world/world.qgs
3. Zoom in to South Africa by using the Zoom In tool
4

. Try setting a scale in the Scale field, which is in the Statusbar along the bottom of the screen. While over South
Africa, set this value to 1: 5 000 000 (one to five million).

5. Pan around the map while keeping an eye on the Scale field

Notice the scale changing? That’s because you are moving away from the one point that you zoomed into at 1:5
000 000, which was at the center of your screen. All around that point, the scale is different.

To understand why, think about a globe of the Earth. It has lines running along it from North to South. These longitude
lines are far apart at the equator, but they meet at the poles.

In a GCS, you are working on this sphere, but your screen is flat. When you try to represent the sphere on a flat
surface, distortion occurs, similar to what would happen if you cut open a tennis ball and tried to flatten it out. What
this means on a map is that the longitude lines stay equally far apart from each other, even at the poles (where they
are supposed to meet). This means that, as you travel away from the equator on your map, the scale of the objects
that you see gets larger and larger. What this means for us, practically, is that there is no constant scale on our map!

To solve this, let’s use a Projected Coordinate System (PCS) instead. A PCS ,,projects” or converts the data in a way
that makes allowance for the scale change and corrects it. Therefore, to keep the scale constant, we should reproject
our data to use a PCS.

6.1.2 \ Follow Along: ,,On the Fly“ Reprojection

By default, QGIS reprojects data ,,on the fly“. What this means is that even if the data itself is in another CRS, QGIS
can project it as if it were in a CRS of your choice.

You can change the CRS of the project by clicking on the & Current projection hytton in the bottom right corner of
QGIS.

1. In the dialog that appears, type the word global into the Filter field. A few CRSs should appear in the
Predefined Reference Systems field below.

2. Select WGS 84 / NSIDC EASE-Grid 2.0 Global | EPSG:6933 entry by clicking on it, and then click OK.

Notice how the shape of South Africa changes. All projections work by changing the apparent shapes of objects
on Earth.

3. Zoomtoascaleof 1:5 000 000 again, as before.
4. Pan around the map.
Notice how the scale stays the same!
,On the fly“ reprojection is also used for combining datasets that are in different CRSs.

1. Add another vector layer to your map which has the data for South Africa only. You will find it
as exercise_data/world/RSA.shp.

2. Load it. A quick way to see its CRS is by hovering the mouse over the layer in the legend. It is EPSG:3410.
What do you notice?

The layer is visible even if it has a different CRS from the continents one.
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6.1.3 / Follow Along: Saving a Dataset to Another CRS

Sometimes you need to export an existing dataset with another CRS. As we will see in the next lesson, if you need
to make distance calculations on layer, it is always better to have the layer in a projected coordinate system.

Be aware that the ,on the fly* reprojection is related to the project and not to single layers. This means that a layer can
have a different CRS from the project even if you see it in the correct position.

You can easily export the layer with another CRS.

1.
2.
3.

Add the buildings dataset from training_data.gpkg
Right-click on the buildings layer in the Layers panel

Select Export » Save Features As... in the menu that appears. You will be shown the Save Vector Layer as...
dialog.

Click on the Browse button next to the File name field

Navigate to exercise_data/ and specify the name of the new layer as buildings_reprojected.
shp.

Change the value of the CRS. Only the recent CRSs used will be shown in the drop-down menu. Click on the
25 seectprjection button next to the drop-down menu.

The Coordinate Reference System Selector dialog will appear. In its Filter field, search for 34S.

Select WGS 84 / UTM zone 34S | EPSG:32734 from the list
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Coordinate Reference System Selector

Select the coordinate reference system for the vector file. The data points will be transformed fraom the layer
coordinate reference system.

Filter | ©. 345 a |
Recently used coordinate reference systems

Coordinate Reference System Authority 1D

WGS 84/ UTM zone 345 EPSG:32734

1

[»

Coordinate reference systems of the world Hide deprecated CRSs

wordinate Reference System Authority ID [
RGRDC 2005 / UTM zone 345 EPSG:4062
WGS 72 [ UTM zone 345 EP5G:32334
WGS 72BE / UTM zone 345 EP5G:32534

WG5S 84 / UTM zone 345 EP5G:32734

A

7

Selected CRS |WGS 84 / UTM zone 345

. ¥ i W g u
Extent: 18.00, -20.00, 24.00, 0.00 \ o
Projd: +proj=utm +zone=34 +south .’I ' = .
+datum=WGS84 +units=m +no_defs - g
| [@lHelp | | @cancel || Fok |

9. Leave the other options unchanged. The Save Vector Layer as... dialog now looks like this:
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Save Vector Layer as...

Format ESRI Shapefile

File name |ome/matteo/exercise_data/exercise_data/buildings_reprojected.shp &

Layer name
CRS EPSG:32734 - WGS 84 7 UTM zone 345 - | |
Encoding UTF-8 -

v | Add saved file to map

b Select fields to export and their export options
v Geometry

Geometry type Automatic =

» Extent (current: layer)
P Layer Options

P Custom Options

Help @ Cancel oK

10. Click OK

You can now compare the old and new projections of the layer and see that they are in two different CRS but they
are still overlapping.
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6.1.4 === Follow Along: Creating Your Own Projection
There are many more projections than just those included in QGIS by default. You can also create your own
projections.

1. Start a new map

2. Load the world/oceans. shp dataset

3. Go to Settings » Custom Projections... and you will see this dialog.

Custom Coordinate Reference System Definition x

v Define

You can define your own custom Coordinate Reference System (CRS) here. The definition must conform to a WKT or Proj string Format for specifying a CRS.

Name Parameters dh
=
Name
Format WKT (Recommended) -
Validate
Parameters
v Test

Use the text boxes below to test the CRS definition you are creating. Enter a coordinate where both the lat/long and the transformed result are known (for example by
reading off a map). Then press the calculate button to see if the CRS definition you are creating is accurate.

Geographic / WGS84 Destination CRS

Calculate

@Help Ocancel QoK

4. Click on the 'fl-:lll-:I Addnew CRS hytton to create a new projection
5. An interesting projection to use is called Van der Grinten I.Enter its name in the Name field.

This projection represents the Earth on a circular field instead of a rectangular one, as most other projections
do.

6. In Format, select WKT (Recommended)

7. Add the following string in the Parameters field:

(PROJCRS["unknown",
BASEGEOGCRS [ "unknown",
DATUM [ "unknown",
ELLIPSOID["unknown", 6371000,0,
LENGTHUNIT ["metre", 1,
ID["EPSG", 90011111,
PRIMEM["Greenwich", O,
ANGLEUNIT ["degree",0.0174532925199433],
ID["EPSG",8901]11,
CONVERSION["unknown",
METHOD ["Van Der Grinten"],

(continues on next page)
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(pokracujte na pfedchozi strénce)

PARAMETER["Longitude of natural origin", 0,
ANGLEUNIT ["degree",0.0174532925199433],
ID["EPSG",8802]],

PARAMETER["False easting",0,
LENGTHUNIT["metre", 1],
ID["EPSG",8806]],

PARAMETER["False northing", 0,
LENGTHUNIT["metre", 1],
ID["EPSG",8807]11,

CS[Cartesian, 2],
AXIS[" (E)",east,
ORDER[1],
LENGTHUNIT ["metre", 1,
ID["EPSG", 9001111,

AXIS[" (N)",north,
ORDER[2],
LENGTHUNIT["metre", 1,

ID["EPSG",9001]1]11]

Custom Coordinate Reference System Definition x

v Define

You can define your own custom Coordinate Reference System (CRS) here. The definition must conform to a WKT or Proj string Format for specifying a CRS.

Name Parameters o
Van der Grinten | PROJCRS["unknown" BASEGEOGCRS["unknown", DATUM["unknown" ELLIPSOID["unknown",6371000,0,LENGTHUNIT["metre",1,ID[... =
Name Van der Grinten |
Format WKT (Recommended) -
PROJCRS["unknown", “/| @ || validate

BASEGEOGCRS["unknown",
DATUM["unknown",
ELLIPSOID["unknown",6371000,0,
LENGTHUNIT["metre",1,
Parameters ID["EPSG",2001]]]],
PRIMEM["Greenwich",0,
ANGLEUNIT["degree",0.0174532525199433],
ID["EPSG",8901]]],
CONVERSION["unknown",
METHOD["Van Der Grinten"], -

b Test

@Help @cancel Qok

8. Click OK

9. Click on the % Current CRS hytton at the right of the status bar to change the project CRS
10. Choose your newly defined projection (search for its name in the Filter field)

11. On applying this projection, the map will be reprojected thus:
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L] *Untitled Project - QGIS 9e45223d42 [tm] - o x
Project Edit View Layer Settings Plugins Vector Raster Database Web Processing Help

 DERBREY Qe rRPPRLALRBIER e K-U-EE#I=-0 0

F/iBRR-FT=<bDoe “"qBE=ws99s QAR an- B &K s

Layers
: “BETE-B AL
v I

£

I3
L]

Browser ‘ Layers |

| @ Type to locate (ctr+k) 1 legend entries removed Coortinate | 2652139.4502093) | scale | 1218427020 ‘-I & Magnifier | 100% 2] Rotation [0.0°

[3][v] Render @ userao0o2s @

6.1.5 In Conclusion

Different projections are useful for different purposes. By choosing the correct projection, you can ensure that the
features on your map are being represented accurately.

6.1.6 Further Reading

Materials for the Advanced section of this lesson were taken from this article.

Read further information on Coordinate Reference Systems.

6.1.7 What’s Next?

In the next lesson you will learn how to analyze vector data using QGIS* various vector analysis tools.

6.2 Lesson: Vector Analysis

Vector data can also be analyzed to reveal how different features interact with each other in space. There are many
different analysis-related functions, so we won’t go through them all. Rather, we will pose a question and try to solve
it using the tools that QGIS provides.

The goal for this lesson: To ask a question and solve it using analysis tools.
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6.2.1 \ The GIS Process

Before we start, it would be useful to give a brief overview of a process that can be used to solve a problem. The way
to go about it is:

1. State the Problem
2. Get the Data
3. Analyze the Problem

4. Present the Results

6.2.2 \ The Problem

Let’s start off the process by deciding on a problem to solve. For example, you are an estate agent and you are looking
for a residential property in Swellendam for clients who have the following criteria:

1. It needs to be in Swellendam

2. It must be within reasonable driving distance of a school (say 1km)
3. It must be more than 100m squared in size

4. Closer than 50m to a main road

5. Closer than 500m to a restaurant

6.2.3 \ The Data

To answer these questions, we are going to need the following data:
1. The residential properties (buildings) in the area
2. The roads in and around the town
3. The location of schools and restaurants
4. The size of buildings

These data are available through OSM, and you should find that the dataset you have been using throughout this
manual also can be used for this lesson.

If you want to download data from another area, jump to the Introduction Chapter to read how to do it.

Poznamka: Although OSM downloads have consistent data fields, the coverage and detail does vary. If you find
that your chosen region does not contain information on restaurants, for example, you may need to chose a different
region.
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6.2.4 \ Follow Along: Start a Project and get the Data

We first need to load the data to work with.

1. Start a new QGIS project

2. If you want, you can add a background map. Open the Browser and load the OSM background map from the

XYZ Tiles menu.

*Untitled Project - QGIS [

Project Edit View Layer Settings Plugins Vector Raster Database Web Mesh Processing Help

DEBRRH O 8

LPRHIPPLRLILEBLORC

=g Q »
Dm_‘ %} Z m- TR = @
Layers @
e o [ ® T |7 9= gy <
~ [v| ¥ OpenStreetMap
Vo |
= \ C
&2
%
.\"a
% Swellend 5 ""'%
wellendam
M Browser (&]Es) . N
Q. LETHTO s ™ P L
L @ Postals E =
@' P MssQL S

% & pB2
S @ WMS/WMTS
&)~ |~ @ XYZTiles

= OpenStreetMap
Vo & wcs

a
» 47 WFS / OGC API - Features
K& |» @ ows
& ArcGisMapServer
&) ArcGisFeatureServer
¢ GeoNode

[l v
Q Type to locate (Ctri+K)

3. Inthe training_data.
chapter:

1. buildings
2. roads
3. restaurants

4. schools

i

1| 2271701,-4029807 |9 & 1:53229 | & r|100% | a|00° +| ¥/ Render & Epsi3ssT @

gpkg Geopackage database, you will find most the datasets we will use in this

Load them, and also 1anduse.sqglite.

4. Zoom to the layer extent to see Swellendam, South Africa

Before proceeding we will filter the roads layer, in order to have only some specific road types to work with.

Some roads in OSM datasets are listed as unclassified, tracks, path and footway. We want to
exclude these from our dataset and focus on the other road types, more suitable for this exercise.

Moreover, OSM data might not be updated everywhere, and we will also exclude NULL values.

5. Right click on the roads layer and choose Filter....

6. In the dialog that pops up we filter these features with the following expression:
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"highway" NOT IN ('footway', 'path', 'unclassified', 'track') AND "highway" IS.
—NOT NULL

The concatenation of the two operators NOT and IN excludes all the features that have these attribute values
in the highway field.

IS NOT NULL combined with the AND operator excludes roads with no value in the highway field.

Note the I?I icon next to the roads layer. It helps you remember that this layer has a filter activated, so some
features may not be available in the project.

The map with all the data should look like the following one:

tm_ch72 - QGIS B

Project Edit View Layer Settings Plugins Vector Raster Database Web Mesh Processing Help
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6.2.5 \ Try Yourself Convert Layers‘ CRS

Because we are going to be measuring distances within our layers, we need to change the layers‘ CRS. To do this, we
need to select each layer in turn, save the layer to a new one with our new projection, then import that new layer into

our map.

You have many different options, e.g. you can export each layer as an ESRI Shapefile format dataset, you can append
the layers to an existing GeoPackage file, or you can create another GeoPackage file and fill it with the new reprojected
layers. We will show the last option, so the training_data . gpkg will remain clean. Feel free to choose the best
workflow for yourself.

Poznamka: In this example, we are using the WGS 84 / UTM zone 34S CRS, but you should use a UTM CRS which
is more appropriate for your region.

1. Right click the roads layer in the Layers panel
2. Click Export —> Save Features As...
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. In the Save Vector Layer As dialog choose GeoPackage as Format

. Click on ... for the File name, and name the new GeoPackage vector_analysis

. Change the CRS to WGS 84 / UTM zone 34S

3
4
5. Change the Layer name to roads_34S
6
7. Click on OK:

Save Vector Layer as... o

Format GeoPackage -

File name ning-Data-release_3.10/exercise_data/vector analysis.gpkg

Layer name roads 34S

CRS EPSG:32734 - WGS 84 / UTM zone 345 - | | &

Encoding

[#| Select fields to export and their export options
v Geomekry

Geometry type Automatic -

[ Extent (current: layer)
P Layer Options

P Custom Options

@Help ¥ Add saved file to map | ¥ Cancel

L
)
o]
-~

This will create the new GeoPackage database and add the roads_ 345 layer.

8. Repeat this process for each layer, creating a new layer in the vector_analysis.gpkg GeoPackage file
with _34S appended to the original name.

On macOS, press the Replace button in the dialog that pops up to allow QGIS to overwrite the existing
GeoPackage.
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Poznamka: When you choose to save a layer to an existing GeoPackage, QGIS will add that layer next to the
existing layers in the GeoPackage, if no layer of the same name already exists.

9. Remove each of the old layers from the project

10. Once you have completed the process for all the layers, right click on any layer and click Zoom to layer extent
to focus the map to the area of interest.

Now that we have converted OSM data to a UTM projection, we can begin our calculations.

6.2.6 \ Follow Along: Analyzing the Problem: Distances From Schools
and Roads

QGIS allows you to calculate distances between any vector object.

1. Make sure that only the roads_34S and buildings_34S layers are visible (to simplify the map while
you're working)

2. Click on the Processing » Toolbox to open the analytical core of QGIS. Basically, all algorithms (for vector
and raster analysis) are available in this toolbox.

3. We start by calculating the area around the roads_34S by using the Buffer algorithm. You can find it in the
Vector Geometry group.
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Processing Toolbox

"ne0 A

Q

1 b . . . . A

() Recently used
(2 Cartography

(2} Database

() File tools

(2 Graphics

(2} Interpolation

(2} Layer tools

()} Network analysis
()} Raster analysis
() Raster terrain analysis
() Raster tools

() Vector analysis
(2} Vector creation
() Vector general
() Vector geometry

me Add geometry attributes
4% Aggregate

4% Boundary

4% Bounding boxes

= Centroids

+ Check validity

&% Collect geometries

# Concave hull (alpha shapes)

¥ Concave hull (k-nearest neighbaor)

4% Convert geometry type
& convex hull

4% Create layer from extent
4% Create wedge buffers

@ Delaunay triangulation
¥ Delete holes

4% Densify by count

4% Densify by interval

P Dissolve

4% Drape (set z-value from raster)
4# Drop M/Z values

¥ Eliminate selected polygons
4% Explode lines

4 Extend lines

¥ Extract specific vertices
"'* Extract vertices

4% Filter vertices by m value
4% Filter vertices by z value
4F Fix geometries

4% Geometry by expression
4 Interpolate point on line

i vrnn M hisensck ek

-

You can add more algorithms to the toolbox,
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Or you can type buf fer in the search menu in the upper part of the toolbox:

Strumenti di Processing &
w e O %)
| 2 buffer| & |

allc.

* (.} Geometria vettore
Buffer multi-anello (distanza costante)
Buffer su singalo lato
Create wedge buffers
Tapered buffers
Variable width buffer (by m-value)
v o GDAL
+ Geoprocessing di Vettori
- Buffer su singolo lato
aw Vettori buffer
- g GRASS
~ Raster (r.*)
@ r.buffer
& r.bufferlowmem
* Vettore (v.*)
@ v.buffer
-~ & SAGA
* Raster tools
& Raster buffer
& Raster proximity buffer
& Threshold raster buffer

= Wlmrtor aeneres |

4. Double click on it to open the algorithm dialog

5. Select roads_34S as Input layer, set Distance to 50 and use the default values for the rest of the parameters.
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»
Parameters | Log Buffer
Input layer . .
P y This algorithm computes a buffer area for all the
W/ roads_34S [EPSG:32734] v ||...|| @ features in an input layer, using a fixed or dynamic
distance.
Dist. The segments parameter controls the number of
Istance line segments to use to approximate a quarter circle
50,000000 @ % |meters K =N when creating rounded offsets.
Segments The end cap style parameter controls how line
s — endings are handled in the buffer.
d l The join style parameter specifies whether round,
el s miter or beveled joins should be used when
Round - offsetting corners in a line.
Join style The miter limit parameter is only applicable For
miter join styles, and conkrols the maximum
Round M distance from the offset curve to use when creating
Miter limit a mitered join.
2,000000 -

Dissolve result
Buffered

[Create temporary layer]

¥| Open output file after running algorithm

@Help Run as Batch Process... # Close

6. The default Distance is in meters because our input dataset is in a Projected Coordinate System that uses meter
as its basic measurement unit. You can use the combo box to choose other projected units like kilometers,
yards, etc.

Poznamka: If you are trying to make a buffer on a layer with a Geographical Coordinate System, Processing
will warn you and suggest to reproject the layer to a metric Coordinate System.

7. By default, Processing creates temporary layers and adds them to the Layers panel. You can also append the
result to the GeoPackage database by:

1. Clicking on the ... button and choose Save fo GeoPackage...
2. Naming the new layer roads_buffer_50m

3. Saving it in the vector_analysis.gpkg file
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»
Parameters ‘ Log Buffer
Input layer . .
P y R This algorithm computes a buffer area for all the
/" roads_34S [EPSG:32734] ~ | |- | |2| features in an input layer, using a fixed or dynamic
- distance.
Dista The segments parameter controls the number of
Istance line segments ko use to approximate a quarter circle
'50,000000 a |:| 'meters v | € | |when creating rounded offsets.
Segments The end cap style parameter controls how line
B |A| endings are handled in the buffer.
d | The join style parameter specifies whether round,
End cap style miter or beveled joins should be used when
'Round ~ || | offsetting cornersin a line.
Join style The miter limit parameter is only applicable For
miter join styles, and conkrols the maximum

| Round - | distance from the offset curve to use when creating
Miter limit a mitered join.

2,000000 2]

Dissolve result

Buffered
okg' table="roads_buffer_50m" (geom) | ... |

¥| Open output file after running algorithm

| 0% |
| @Help || RunasBatch Process... | | %cClose | l «/Run ]

8. Click on Run, and then close the Buffer dialog

Now your map will look something like this:
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*tm_ch72 - QGIS
Project Edit View Layer Settings Plugins Vector Raster Database Web Mesh Progessing Help
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/ -4 9 . @ ¥ e T
@ M-o-EEK =0 . R
Layers =)

o @ ® T &~F &L

v| — roads_34S
V; v| [l schools_34s
-] V! [[] restaurants_34S

2 roads_buffer 5om |

ﬁg ! [] buildings_34s

v [ landuse_34s
,n v [| ® openstreetMap

£

F‘_ Browser B&
gp. 270

(]

.

/

» 7 |Favorites e
@v » " spatial Bookmarks

» [¥ Project Home
% » [&] Home
R

» @ GeoPackage
\f;v » # spatiaLite
+ @ postcis
€50 » MssQL

DB2
b B WMS/WMTS
b XYZ Tiles

S oaure -
4 »
| @ Type to locate (ctrl+k) Coordinate| 2271541,4028794 |9 Scale|1:51359 |~ | @@ Magnifier 100% \:| Rotation |0,0° |2V Render @ Epsc3ss7 @

If your new layer is at the top of the Layers list, it will probably obscure much of your map, but this gives you all the
areas in your region which are within 50m of a road.

Notice that there are distinct areas within your buffer, which correspond to each individual road. To get rid of this
problem:

1. Uncheck the roads_buffer_50m layer and re-create the buffer with Dissolve results enabled.
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Parameters ‘ Log

Input layer
"/ roads_34S [EPSG:32734] <~ | .| @]

Distance

150,000000 @ || |meters ~| €&

Segments

E <]
End cap style

'Round -
Join style

'Round -
Miter limit

'2,000000 2]

issolve result

By Dissolve result

ok{python identifier: ‘DISSOLVE lgeom) | ... |

¥| Open output file after running algorithm

Buffer

This algorithm computes a buffer area for all the
features in an input layer, using a fixed or dynamic
distance.

The segments parameter controls the number of
line segments ko use to approximate a quarter circle
when creating rounded offsets.

The end cap style parameter controls how line
endings are handled in the buffer.

The join style parameter specifies whether round,
miter or beveled joins should be used when
offsetting corners in a line.

The miter limit parameter is only applicable For
miter join styles, and conkrols the maximum
distance from the offset curve to use when creating
a mitered join.

| 0%

| @Help || RunasBatch Process... |

2. Save the output as roads_buffer_50m_dissolved

3. Click Run and close the Buffer dialog

| %Close |l «/Run ]

Once you have added the layer to the Layers panel, it will look like this:
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*tm_ch72 - QGIS

Project Edit View Layer Settings Plugins Vector Raster Database Web Mesh Progessing Help

DeEREY O, RPPRH Q0 &I

/ = - . AT
@ M-e-L,EE% S =)0 . R
Layers (@S]

-} o« @l ® T &vF AL

roads_buffer 5om |
\/: v — roads_34S
= v [l schools_34s

] v [[] restaurants_34s
Eg W roads_buffer_s0m

¥ [ buildings_34s

,n v [l landuse_34s
f - ¥ OpenStreetMap

(+]

l" Browser @®
LeT®o

» 7 Favorites

@' » " spatial Bookmarks
» [¥ Project Home

% » |4 Home

@- r O/
» @ GeoPackage
\,/:v » / SpatiaLite
+ @ postGls
€ P MssQL
DB2
b B WMS/WMTS

b & XYZ Tiles

a5 e .
4 ]
| A Type to locate (Ctrl+K) Coordinate| 2271575030207 |9 Scale 151359~ | @@ Magnifier| 100% 2] Rotation [0.0° |2V Render @ Epsc3ss7 @

Now there are no unnecessary subdivisions.

Poznamka: The Short Help on the right side of the dialog explains how the algorithm works. If you need more
information, just click on the Help button in the bottom part to open a more detailed guide of the algorithm.

6.2.7 \ Try Yourself Distance from schools

Use the same approach as above and create a buffer for your schools.

It shall be 1 km in radius. Save the new layer in the vector_analysis.gpkg file
as schools_buffer_lkm_dissolved.

Answer

* Your buffer dialog should look like this:
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Buffer
Parameters Log ¢ Buffer
Input layer - This algorithm computes a buffer area
|C:jschco|5_34s [EPSG:32734] - | | .. ||®@]|| [forallthe features in an input layer,
o using a fixed or dynamic distance.
) The segments parameter controls the
Distance number of line segments to use to
- . . approximate a quarter circle when
|1.000000 a@ |'| kilometers ~ | 5, creating rounded offsets.
Segments The end cap style parameter controls
[s |:| how line endings are handled in the
buffer.
End cap style o N
The join style parameter specifies
| Round hd | whether round, miter or beveled joins
) should be used when offsetting corners
Join style in a line.
Round - T .
| oun | The miter limit parameter is only
Miter limit applicable for miter join styles, and
= controls the maximum distance from the
| 2.000000 |- offset curve to use when creating a
. mitered join.
v Dissolve result
Buffered
|ﬂgr:dbname='fhomejmattec.f\.rectcr_anaIysis.gpkg' table='sch00|s_buffer_lkm_d| | |
v Open output file after running algorithm
| 0% |
| [&Help | | Run as Batch Process... # Close | l &Run ]

The Buffer distance is 1 kilometer.

» The Segments to approximate value is set to 20. This is optional, but it’s recommended, because it makes the
output buffers look smoother. Compare this:
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To this:
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The first image shows the buffer with the Segments to approximate value set to 5 and the second shows the value set
to 20. In our example, the difference is subtle, but you can see that the buffer’s edges are smoother with the higher
value.

6.2.8 \ Follow Along: Overlapping Areas

Now we have identified areas where the road is less than 50 meters away and areas where there is a school within 1
km (direct line, not by road). But obviously, we only want the areas where both of these criteria are satisfied. To do
that, we will need to use the Intersect tool. You can find it in Vector Overlay group in the Processing Toolbox.

1. Use the two buffer layers as Input layer and Overlay layer, choose vector_analysis.gpkg GeoPackage
in Intersection with Layer name road_school_buffers_intersect. Leave the rest as suggested
(default).
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Intersection B

3 .
Parameters = Log Intersection
Input layer

This algorithm extracts the

-~ schools_buffer 1km [EPSG:32734] ||...|| @ overlapping portions of features
in the Input and Overlay layers.
Features in the output

Overlay layer Intersection layer are assigned
the attributes of the overlapping
~'roads_buffer_50m [EPSG:32734] = || .- [|®]| |Features from both the Input and

Overlay layers.

Input fields to keep (leave empty to keep all fields) [optional]
Overlay fields to keep (leave empty to keep all fields) [optional]

v Advanced parameters

Overlay fields prefix [optional]

Intersection

lysis.gpkg' table="road_school buffers_intersect" (geom)

¥| Open output file after running algorithm

@Help Run as Batch Process... # Close

o Pl e M e ma

2. Click Run.

In the image below, the blue areas are where both of the distance criteria are satisfied.
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3. You may remove the two buffer layers and only keep the one that shows where they overlap, since that’s what
we really wanted to know in the first place:

o *chapter_7 - QGIS 9e45223d42 [tm] - @

Project Edit View Layer Settings Plugins Vector Raster Database Web Processing Help
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Layers
L]
e ¢ BOTE BADL
v v [l road school buffers intersect
L VI roads_3as
~ v [ schools_34s
w v/ restaurants 345
V! [] buildings_3as
v [l 1anduse _34s
~OF
S
5 S
)
-
Browser | Layers
X Type to locate (Ctri+K) Llagend enties removed. Coortinta [2265730,8033115 | 9§ Scue (152255 |~ | @ Magnier | 100% 2| Rotaton (00" 2| VI Render @ EsoaeT @
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6.2.9 \ Follow Along: Extract the Buildings

Now you’ve got the area that the buildings must overlap. Next, you want to extract the buildings in that area.
1. Look for the menu entry Vector Selection » Extract by location within the Processing Toolbox

2. Selectbuildings_34S in Extract features from. Check intersect in Where the features (geometric predicate),
select the buffer intersection layer in By comparing to the features from. Save to the vector_analysis.
gpkg, and name the layer well_located_houses.

Extract by Location £

b .
Parameters | Log Extract by location

Extract Features from . .
This algorithm creates a new

-~ buildings_34s [EP5G:32734] || ... vector layer that only contains
matching features from an input

Where the features (geometric predicate) layer. The criteria for adding

v intersect touch Features to the resulting layer is
defined based on the spatial
contain overlap relationship between each
disjoint are within Feature and the fFeatures in an
additional layer.
equal Cross

By comparing to the features from

~ road_school_buffers_intersei > | | ... || @

Extracted (location)

.g' table="well_located houses" (geom)

¥ Open output file after running algorithm

| 0%

@Help Run as Batch Process... # Close

3. Click Run and close the dialog

4. You will probably find that not much seems to have changed. If so, move the well_located_houses layer to the
top of the layers list, then zoom in.
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*chapter_7 - QGIS 9e45223d42 [tm]

The red buildings are those which match our criteria, while the buildings in green are those which do not.

5. Now you have two separated layers and can remove buildings_34S from the layer list.

6.2.10 / Try Yourself Further Filter our Buildings

We now have a layer which shows us all the buildings within 1km of a school and within 50m of a road. We now
need to reduce that selection to only show buildings which are within 500m of a restaurant.

Using the processes described above, create a new layer called houses_restaurants_500m which further filters your
well_located_houses layer to show only those which are within 500m of a restaurant.

Answer
To create the new houses_restaurants_500m layer, we go through a two step process:

1. First, create a buffer of 500m around the restaurants and add the layer to the map:
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Buffer

Parameters | Log | Buffer
Input layer

This algorithm computes a buffer area

[~ restaurants_345 [EP5G:32734] - || .. ? for all the features in an input layer,
l = ‘ l_J u using a fixed or dynamic distance.

[ se t nly
. : The segments parameter controls the
Distance number of line segments to use to
- . approximate a quarter circle when
| 500.000000 a |" [meters ‘ \=4 creating rounded offsets.
Segments The end cap style parameter controls
|5 |¢I how line endings are handled in the
buffer.
End cap style o .
The join style parameter specifies
| Round b | ¢ | whether round, miter or beveled joins
) " | should be used when offsetting corners
Join style in a line.
Round - . :
l I The miter limit parameter is only
Miter limit applicable for miter join styles, and
= controls the maximum distance from the
| 2.000000 |v‘ offset curve to use when creating a
mitered join.
Dissolve result )
Buffered

hejm atteo/vector_analysis.gpkg' table="houses_restaurants_500m" (geom) sql= | .

Open output file after running algorithm

[ 0% /|

[ [&|Help I [ Run as Batch Process... ¥ Close ‘ l Run ]

L *chapter_7 - QGIS 9e45223d42 [tm] - a x
Project Edit View Layer Settings Plugins Vector Raster Database Web Processing Help
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Browser | Layers
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2. Next, extract buildings within that buffer area:
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Extract by Location

Parameters | Log | Extract by location

el T This algorithm creates a new vector

layer that only contains matching
features from an input layer. The criteria
for adding features to the resulting layer
is defined based on the spatial
relationship between each feature and

| 2 well_located_houses [EPS5G:32734] - | |:|

Where the features (geometric predicate)

intersect | | touch

| | contain | | overlap the features in an additional layer.
| disjoint | | are within
| | equal || cross

By comparing to the features from

| (2 restaurants_buffer_500m [EPSG:32734] - |[..][®]
[ Selected features only

Extracted (location)

|1attec{vectcr_analysis.gpkg' table="restaurants_buffer_500m" {geom) 5q|=| |_|

Open output file after running algorithm

[ 0% | |

| [@Help || Run as Batch Process... | | # Close |[ «Run ]

Your map should now show only those buildings which are within 50m of a road, 1km of a school and 500m of
a restaurant:
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6.2.11 \ Follow Along: Select Buildings of the Right Size
To see which buildings are of the correct size (more than 100 square meters), we need to calculate their size.

1. Select the houses_restaurants_500m layer and open the Field Calculator by clicking on the ==l Open Field Calculator
button in the main toolbar or in the attribute table window

2. Select Create a new field, set the Output field name to AREA, choose Decimal number (real) as Output field
type, and choose $Sarea from the Geometry group.

Field Calculator x|

¥ Create a new Field Update existing Field

Create virtual field
Output field name |AREA
Qutput field type | Decimal number (real) -

Output field length Precision

Expression | Function Editor

=AW D )8 Q Searc... function $area =
$area d - . = Returns the area of the current
» Date and Time
» Fields and Values fe‘:ature. The area calculated by
» Files and Paths this function respects both the
} Fuzzy Matching current project’s ellipsoid setting
» General and area unit settings. For
~ Geometry example, if an ellipsoid has been
anile at_vertex set for the project then the
calculated area will be ellipsoidal,
Output preview: 1501.0355253089597 area ~| Land if no ellinsoid is set then the |~
o You are editing information on this layer but the layer is currently not in edit mode. If you click

OK, edit mode will automatically be turned on.
@Help % Cancel « OK

The new field AREA will contain the area of each building in square meters.

3. Click OK. The AREA field has been added at the end of the attribute table.

A

4. Click the & Togele Editing bytton to finish editing, and save your edits when prompted.

5. In the Source tab of the layer properties, set the Provider Feature Filter to "AREA >= 100.
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Query Builder X

Set provider filter on houses_restaurants_500m
Fields Values

old_name = Q search...
addr:erf

internet_access

level

sport

man_made

layer Sample All

height
= Use unfiltered layer

v Operators
= < = LIKE % IM MNOT IN

<= = 1= ILIKE AND OR NOT

Provider specific Filter expression

== 100

1 b

©@Help Test Clear * cancel

6. Kliknout OK.

Your map should now only show you those buildings which match our starting criteria and which are more than 100
square meters in size.

6.2.12 \ Try Yourself

Save your solution as a new layer, using the approach you learned above for doing so. The file should be saved within
the same GeoPackage database, with the name solution.

6.2.13 In Conclusion

Using the GIS problem solving approach together with QGIS vector analysis tools, you were able to solve a problem
with multiple criteria quickly and easily.
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6.2.14 What’s Next?

In the next lesson, we will look at how to calculate the shortest distance along roads from one point to another.

6.3 Lesson: Network Analysis

Calculating the shortest distance between two points is a common GIS task. Tools for this can be found in the
Processing Toolbox.

The goal for this lesson: learn to use Network analysis algorithms.

6.3.1 \ Follow Along: The Tools and the Data

You can find all the network analysis algorithms in the Processing » Network Analysis menu. You can see that there
are many tools available:

Processing Toolbox (&)
L IUNON- RIS AEN
A Search...
» (9 Recently used
» @ Cartography
» @ Database
» @ File tools
» @ GPS
» @ Interpolation
» @ Layer tools
» @ Mesh
~ @ Network analysis
. Service area (from layer)
.. Service area (from point)
.. Shortest path (layer to point)
.. Shortest path (poeint to layer)
. Shortest path (peint to point)
@ Plots
@ Raster analysis

=

=

=

¥ Raster creation

=

@ Raster terrain analysis

=

C Raster tools

=

@ Vector analysis

=

@ Vector creation

=

@ Vector general
@ Vector geometry
@ Vector overlay

=

=

=

@ Vector selection
@ Vector table

@ Vector tiles

v dm GDAL

» @ GRASS

=

=

Open the project exercise_data/network_analysis/network.ggz. It contains two layers:
* network_points

* network_lines
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The network_lines layer has already a style that helps to understand the road network.

The shortest path tools provide ways to calculate either the shortest or the fastest path between two points of a network,
given:

* start and end points selected on the map
* start point selected on the map and end points taken from a point layer
* start points taken from a point layer and end point selected on the map

Let’s start.

6.3.2 \ Calculate the shortest path (point to point)

The Network analysis » Shortest path (point to point) allows you to calculate the shortest distance between two
manually selected points on the map.

In this example we will calculate the shortest (not fastest) path between two points.
1. Open the Shortest path (point to point) algorithm
2. Select network_lines for Vector layer representing network
3. Use Shortest for Path type to calculate

Use these two points as starting and ending points for the analysis:

6.3. Lesson: Network Analysis 217



QGIS Training Manual

Starting Point

-

Ending Peint

4. Click on the ... button next to Start point (x, y) and choose the location tagged with Starting Point inthe
picture. Enable the snapping options for an accurate selection. The coordinates of the clicked point are added.

5. Do the same thing, but choosing the location tagged with Ending point for End point (x, y)
6. Click on the Run button:

Shortest Path (Point to Point)

Parameters || Log Shortest path (point to
Vector layer representing network pOInt)

'/ network_lines [EPSG:32734] - B X | .. - i i

v - - This algorithm computes optimal

(shortest or fastest) route between
given start and end points.

Path type to calculate
Shortest -
Start point
-337683.461296,14891793.324881 [EP5G:32734]
End point
-338394.378190,14891385.941820 [EP5G:32734]

p Advanced Parameters
Shortest path

[Create tempor.

ary layer]

V| Open output file after running algorithm

0% Cancel

i Aide Advanced - Run as Batch Process... ~" Run | @ Fermer |

7. A new line layer is created representing the shortest path between the chosen points. Uncheck the
network_lines layer to see the result better:
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*network - QGIS 9e45223d42 [tm]

-nEEME =208

Ending Paint

8. Open the attribute table of the output layer. It contains three fields, representing the coordinates of the start
and end points and the cost.

We chose Shortest as Path type to calculate, so the cost represent the distance, in layer units, between the
two locations.

In our case, the shortest distance between the chosen points is around 1 000 meters:

Shortest path — Features Total: 1, Filtered: 1, Selected: 0

& s T E QP P E E 6 F
start = end cost
11-337683.461296, 14891793.3249 -338394.37819, 148913859418 906,4072543701861

- Show All Features _

Now that you know how to use the tool, feel free to test other locations.

6.3.3 / Try Yourself Fastest path

With the same data of the previous exercise, try to calculate the fastest path between the two points.

How much time do you need to go from the start to the end point?

Answer

1. Open Network Analysis » Shortest Path (Point to Point) and fill the dialog as:
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Shortest Path (Point to Point)

Parameters | Log Shortest path (point to
Vector layer representing network pOInt)

5 F° 1 o - ! . .

V' network_lines [EPSG:32734] @gj] Q% = This algorithm computes optimal

d Feature (shortest or fastest) route between
i given start and end points.

Path type to calculate

Fastest =

Start point

-337683.461296,14891793.324881 [EP5G:32734]
End point

-338394.378190,14891385.941820 [EP5G:32734]

p Advanced Parameters
Shortest path

[Create temporary layer]

V| Open output file after running algorithm

0% Cancel

B Aide Advanced - Run as Batch Process... v Run | @ Fermer

2. Make sure that the Path type to calculate is Fastest.
3. Click on Run and close the dialog.

4. Open now the attribute table of the output layer. The cost field contains the travel time between the two points
(as fraction of hours):

Shortest path — Features Total: 1, Filtered: 1, Selected: 0
7 & LT E & D ¥ B = & &
start end cost

1]|-337683.461296, 14891793.3249 -338394.37819, 14891385.9418 0,018128145087403721

| Show All Features _

6.3.4 / Follow Along: Advanced options

Let us explore some more options of the Network Analysis tools. In the previous exercise we calculated the fastest
route between two points. As you can imagine, the time depends on the travel speed.

We will use the same layers and starting and ending points of the previous exercises.
1. Open the Shortest path (point to point) algorithm

2. Fill the Input layer, Start point (x, y) and End point (x, y) as we did before
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3. Choose Fastest as the Path type to calculate
4. Open the Advanced parameter menu

5. Change the Default speed (km/h) from the default 50 value to 4
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Shortest Path (Point to Point)

Parameters | Log

Shortest path (point to

Vector layer representing network

point)

| /" network_lines [EPSG:32734]

This algerithm computes optimal

Selected featuras only

Path type to calculate

(shortest or fastest) route between
given start and end points.

| Fastest

Start point

-337683.461206,14891793.324881 [EPSG:32734] [ o |

End point

-338394.378190,14891385.041820 [EPSG:32734] | |:|

w Advanced Parameters

Direction field [optional]

Walue for forward direction [optional]

WValue for backward direction [optional]

Walue for both directions [optional]

Default direction

| Both directions

Speed field [optional]

Default speed (km/h)

4,000000 a@ |2
Topology tolerance
0,000000 | |meters  + |
Shortest path
|[C reate temporary layer] | | oo
v | Open output file after running algorithm
‘ 0% | Cancel
| i aide | | Advanced '| | Run as Batch Process... ~ Run | | & Fermer |

6. Click on Run

7. Once the algorithm is finished, close the dialog and open the attribute table of the output layer.
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The cost field contains the value according to the speed parameter you have chosen. We can convert the cost
field from hours with fractions to the more readable minutes values.

8. Open the field calculator by clicking on the = icon

9. Add a new field to store the path cost in minutes.

Shortest path — Field Calculator

¥| Create a new field Update existing field
Create virtual field
Output field name |minutes
Output field type 1.2 Decimal Number (real) -
Output field length | 10 | Precision 3 -
Expression Function Editor
8 L L Q, Searc group field =
"cost" * 60 » Date and Time Double-click to add field name to expression
~ Fields and Values string. =
feature
geometry Values | O Search...
id
NULL All Unique 10 Samples
= i - ! * ) | | ( ) ||\ abc start
abc end
Feature 51296, 14891793.3249 ~
1.2 cost

Preview: 13,506108815552794 + Files and Paths

i Aide

v 0Ok | & Annuler

That’s it! Now you know how many minutes it will take to get from one point to the other one if the whole network

speedisat 4 km/h.

6.3.5 == Shortest path with speed limit

The Network analysis toolbox has other interesting options. Looking at the following map:
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we would like to know the fastest route considering the speed limits of each road (the labels represent the speed
limits in km/h). The shortest path without considering speed limits would of course be the purple path. But in that
road the speed limit is 20 km/h, while in the green road you can go at 100 km/h!

As we did in the first exercise, we will use the Network analysis » Shortest path (point to point) and we will manually
choose the start and end points.

1. Open the Network analysis » Shortest path (point to point) algorithm
Select network_lines for the Vector layer representing network parameter
Choose Fastest as the Path type to calculate

Select the Start point (x, y) and End point (x, y) as we did before

Open the Advanced parameters menu

A

Choose the speed field as the Speed Field parameter. With this option the algorithm will take into account the
speed limits for each road.
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Shortest Path (Point to Point)

Parameters | Log

Vector layer representing network

|/ network_lines [EPSG:32734]

d featur

L
m

ect

o
b

s only

Path type to calculate

Shortest path (point to
point)

This algorithm computes optimal
(shortest or fastest) route between
given start and end points.

| Fastest

Start point

|—337683.461 2096,14891793.324881 [EPSG:32734]

End point

|—33 8394.378190,14891385.941820 [EP5G:32734]

w Advanced Parameters

Direction field [optional]

Value for forward direction [optional]

Value for backward direction [optional]

Value for both directions [optional]

Default direction

| Both directions

Speed field [optional]

|l-2 spead

Default speed (km/h)

50,000000

Topology tolerance

0,000000 2| [meters  ~ |
Shortest path
|[C reate temporary layer] | |:
v| Open output file after running algorithm
‘ 0% | Cancel
| H pide | | Advanced - | | Run as Batch Process... +" Run | | & Fermer |

7. Click on the Run button

8. Turn off the network_1lines layer to better see the result
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As you can see the fastest route does not correspond to the shortest one.

6.3.6 / Service area (from layer)

The Network Analysis » Service area (from layer) algorithm can answer the question: given a point layer, what are
all the reachable areas given a distance or a time value?

Poznamka: The Nerwork Analysis » Service area (from point) is the same algorithm, but it allows you to manually
choose the point on the map.

Given a distance of 250 meters we want to know how far we can go on the network from each point of the
network_points layer.

1. Uncheck all the layers except network_points

Open the Network Analysis » Service area (from layer) algorithm
Choose network_1ines for Vector layer representing network
Choose network_points for Vector layer with start points
Choose Shortest in Path type to calculate

Enter 250 for the Travel cost parameter

N o AR

Click on Run and close the dialog
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vice Area (From Layer)

Parameters ‘ Log

Vector layer representing network

L=

d featur

m

eCt

o]
T

s only

Path type to calculate

/" network_lines [EPSG:32734] LN

| Shortest - |
Vector layer with start points
- netwark_points [EPSG:32734] -6 X
Selected features only
Travel cost (distance for 'Shortest’, time for ‘Fastest')
250,000000 H

p Advanced Parameters

Service area (lines) [optional]

[Create temporary layer]

v Open output file after running algerithm

Service area (boundary nodes) [optional]

Service area (from layer)

This algorithm creates a new vector with all
the edges or parts of edges of a network line
layer that can be reached within a distance
or a time, starting from features of a point
layer. The distance and the time (both
referred to as "travel cost”) must be specified
respectively in the network layer units or in
hours.

[Skip output] | |:
Open output file after running algorithm
| 0% | Cancel
| i Aide | | Advanced -~ | Run as Batch Process... ~ Run | | @ Fermer |

The output layer represents the maximum path you can reach from the point features given a distance of 250

meters:
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0 *network - QGIS 9e45223d42 [tm]
Project Edit View Layer Settings Plugins Vector Raster Database Web Processing Help
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Cool isn’t it?

6.3.7 In Conclusion

Now you know how to use Network analysis algorithm to solve shortest and fastest path problems.

We are now ready to perform some spatial statistic on vector layer data. Let’s go!

6.3.8 What’s Next?

Next you’ll see how to run spatial statistics algorithms on vector datasets.

6.4 Lesson: Spatial Statistics

Poznamka: Lesson developed by Linfiniti and S Motala (Cape Peninsula University of Technology)

Spatial statistics allows you to analyze and understand what is going on in a given vector dataset. QGIS includes many
useful tools for statistical analysis.

The goal for this lesson: To know how to use QGIS® spatial statistics tools within the Processing Toolbox.
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6.4.1 \ Follow Along: Create a Test Dataset

We will create a random set of points, to get a dataset to work with.
To do so, you will need a polygon dataset to define the area you want to create the points in.
We will use the area covered by streets.

1. Start a new project

2. Add your roads dataset, as well as srtm_41_19 (elevation data) found in exercise_data/raster/
SRTM/.

Poznamka: You might find that the SRTM DEM layer has a different CRS to that of the roads layer. QGIS
is reprojecting both layers in a single CRS. For the following exercises this difference does not matter, but feel
free to reproject (as shown earlier in this module).

3. Open Processing toolbox

4. Use the Vector Geometry w» Minimum bounding geometry tool to generate an area enclosing all the roads by
selecting Convex Hull as the Geometry Type:

Minimum Bounding Geomekry %

>

Parameters | Log Minimum bounding
Input layer geo metry
/" roads [EPSG:4326] v|...]| 9

This algorithm creates geometries which
enclose the features from an input layer.

Field (optional, set if features should be grouped by class) [optional] | | Numerous enclosing geometry types are
supported, including bounding boxes
(envelopes), oriented rectangles, circles

-

Geometry type and convex hulls.

Convex Hull - Optionally, the Features can be grouped by
) a Field. If set, this causes the output layer

Bounding geometry to contain one Feature per grouped value

[Create temporary layer] with a minimal geometry covering just the

features with matching values.
¥| Open output File after running algorithm

@Help Run as Batch Process... # Close

As you know, if you don’t specify the output, Processing creates temporary layers. It is up to you to save the
layers immediately or at a later stage.
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Creating random points

¢ Create 100 random points in this area using the tool at Vector Creation » Random points in layer bounds, with
a minimum distance of 0. O:

Random Points in Layer Bounds

Parameters | Log ' Random 3
Input layer points in
= Bounding geometry [EPSG:4326] ~ | | ... | @ Iayer bounds

This algorithm
creates a new point
layer with a given

| 100| & :l number of random
points, all of them
within the extent of

Number of points

Minimum distance between points

0,000000 | degrees A\ | |agivenlayer A
, distance factor can
Random points be specified, to

avoid points being
too close to each
v Open output File after running algorithm other.

[Create temporary layer]

| 0%

@Help Run as Batch Process... # Close

Poznamka: The yellow warning sign tells you that that parameter concerns distances. The Bounding geometry
layer is in a Geographical Coordinate System and the algorithm is just reminding you this. For this example
we won’t use this parameter so you can ignore it.

If needed, move the generated random point to the top of the legend to see them better:
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Project Edit View Layer Settings Plugins Vector Raster Database Web Mesh Progessing Help
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» @ GeoPackage
¥ | » # spatialite >
Q Type to locate (Ctrl+K) rdil| 20.083,34.046 | :[1:324314 |~ @ n|100% 2 s |00 | ¥/ Render @ EPSG4326 @

Sampling the data

To create a sample dataset from the raster, you'll need to use the Raster Analysis w Sample raster values algorithm.
This tool samples the raster at the locations of the points and adds the raster values in new field(s) depending on the

number of bands in the raster.
1. Open the Sample raster values algorithm dialog

2. Select Random_points as the layer containing sampling points, and the SRTM raster as the band to get
values from. The default name of the new field is rvalue_N, where N is the number of the raster band. You

can change the name of the prefix if you want.
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Sample Raster Values *

»
parameters | Log Sample raster
Input Point Layer values
©" Random points [EPSG:4326] - 2 This algorithm creates
a new vector layer
with the same
Raster Layer to sample attributes of the input
" srtm_41_19 [EPSG:32733] w||...|| |layerandthe raster
values corresponding
|w| Advanced parameters on the point location.
Output column prefix If the raster layer has
more than one band,
rvalue all the band values are
sampled.

sampled Points

[Create temporary layer]

v Open output file after running algorithm

| 0%

@Help Run as Batch Process... # Close

3. Press Run

Now you can check the sampled data from the raster file in the attribute table of the Sampled Points layer. They
will be in a new field with the name you have chosen.

A possible sample layer is shown here:
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The sample points are classified using the rvalue_1 field such that red points are at a higher altitude.

You will be using this sample layer for the rest of the statistical exercises.

6.4.2 \ Follow Along: Basic Statistics

Now get the basic statistics for this layer.

1. Click on the E Show statistical summary jo0n in the Attributes Toolbar. A new panel will pop up.
2. In the dialog that appears, specify the Sampled Points layer as the source.
3. Select the rvalue_1 field in the field combo box. This is the field you will calculate statistics for.

4. The Statistics Panel will be automatically updated with the calculated statistics:
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Statistics & ]
. sampled Points v |
Va 1.2 rvalue_1 ~|| €|
* Statistic Value
',3 Count 100
BB sum 14148
9, |Mean 141.48
ﬁ: Median 122.5
Fﬁ_ st dev (pop) 89.4792
'u' St dev (sample) 89.93
@ Minimum 18
-
% Maximum 737
@ RE!I"IQE 719
w
Minority 18
+
Majorikty 120
&
Variety 78
Q1 97
Q3 163.5
IQR 66.5

Missing (null) values 0

|

Selected featuresonly 7 &2

W g

| Statistics | Layers  Browser

| Q Type to locate (Ctrl+K) |

234 Kapitola 6. Module: Vector Analysis



QGIS Training Manual

Poznamka: You can copy the values by clicking on the Copy Statisties To Clipboard ytton and paste the results

into a spreadsheet.

5. Close the Statistics Panel when done
Many different statistics are available:

Count
The number of samples/values.

Sum
The values added together.

Mean
The mean (average) value is simply the sum of the values divided by the number of values.

Median

If you arrange all the values from smallest to greatest, the middle value (or the average of the two middle values,

if N is an even number) is the median of the values.

St Dev (pop)

The standard deviation. Gives an indication of how closely the values are clustered around the mean. The

smaller the standard deviation, the closer values tend to be to the mean.

Minimum
The minimum value.

Maximum
The maximum value.

Rozsah
The difference between the minimum and maximum values.

Q1
First quartile of the data.

Q3
Third quartile of the data.

Missing (null) values
The number of missing values.

6.4.3 \ Follow Along: Compute statistics on distances between points

1. Create a new temporary point layer.
2. Enter edit mode, and digitize three points somewhere among the other points.
Alternatively, use the same random point generation method as before, but specify only three points.
3. Save your new layer as distance_points in the format you prefer.
To generate statistics on the distances between points in the two layers:

1. Open the Vector Analysis » Distance matrix tool.

2. Selectthe distance_points layer as the input layer, and the Sampled Points layer as the target layer.

3. Set it up like this:
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Distance Matrix

Parameters | Log Distance matrix

Input point layer This algorithm creates a table

Distance Points [EPSG:4326] || . ||D containing a distance matrix, with
distances between all the pointsin a
points layer.

Input unigue 1D field
123 id -
Target point layer
Sampled Points [EP5G:4326] (.|| D

Target unique ID field

123 id -
Output matrix type

Summary distance matrix {mean, std. dev., min, max) -
Use only the nearest (k) target points
[2] =

Distance matrix

[Create temporary layer]

v Open output file after running algorithm

| 0%

&2 he un as Batc rocess... ase un
@|Help R Batch P % Cl @R

4. If you want you can save the output layer as a file or just run the algorithm and save the temporary output layer
later.

5. Click Run to generate the distance matrix layer.

6. Open the attribute table of the generated layer: values refer to the distances between the distance_points features
and their two nearest points in the Sampled Points layer:

] Distance matrix :: Features Total: 3, Filtered: 3, Selected: 0 - o x
/ ™ T =€ & h T E & D B R e e
InputiD MEAN STDDEW MIN MAX
1 1 401.87013 235.74757 166.12256 637.61770
2 2 653.19728 229.72430 423.47299 882.92158
3 0 1005.87036 296.03133 709.83903 1301.90169

T Show All Features _ = |

With these parameters, the Distance Matrix tool calculates distance statistics for each point of the input layer with
respect to the nearest points of the target layer. The fields of the output layer contain the mean, standard deviation,
minimum and maximum for the distances to the nearest neighbors of the points in the input layer.
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6.4.4 \ Follow Along: Nearest Neighbor Analysis (within layer)

To do a nearest neighbor analysis of a point layer:
1. Choose Vector analysis » Nearest neighbor analysis.
2. In the dialog that appears, select the Random points layer and click Run.

3. The results will appear in the Processing Result Viewer Panel.

Processing Toolbox E3]
*‘t R "-- l‘:' = ¥ "th

I.--lh
o,

» (1) Recently used =
» (2 Cartography
b () Database

b () File Fnnls b

Results Viewer ]

* Nearest neighbour [04:51:51]

Algorithm: Nearest neighbour =
File path: /tmp/processing MXcuYE/
6aa2320aecdf41d4adbesed45440fF23
be/OUTPUT HTML FILE.html -

4. Click on the blue link to open the html page with the results:

6.4. Lesson: Spatial Statistics 237



QGIS Training Manual

Mozilla Firefox

Jtmp/processing MXcuYE/« X
G | @ File:///tmp/processing MXcu' =+ X =

Observed mean distance: 1408.03338044153

Expected mean distance: 0.01577808561

Nearest neighbour index: 89239.81118148957

Number of points: 100

Z-Score: 1707201.00974689284

6.4.5 \ Follow Along: Mean Coordinates

To get the mean coordinates of a dataset:
1. Start Vector analysis » Mean coordinate(s)
2. In the dialog that appears, specify Random points as Input layer, and leave the optional choices unchanged.
3. Click Run.
Let us compare this to the central coordinate of the polygon that was used to create the random sample.
1. Start Vector geometry w Centroids
2. In the dialog that appears, select Bounding geometry as the input layer.
As you can see, the mean coordinates (pink point) and the center of the study area (in green) don’t necessarily coincide.

The centroid is the barycenter of the layer (the barycenter of a square is the center of the square) while the mean
coordinates represent the average of all node coordinates.
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6.4.6 \ Follow Along: Image Histograms

The histogram of a dataset shows the distribution of its values. The simplest way to demonstrate this in QGIS is via the
image histogram, available in the Layer Properties dialog of any image layer (raster dataset).

1. In your Layers panel, right-click on the srtm_41_19 layer

2. Select Properties

3. Choose the Histogram tab. You may need to click on the Compute Histogram button to generate the graphic.
You will see a graph that shows the frequency distribution for the raster values.
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Layer Properties - srtm_41_19 | Histogram

3 i i
£ Information Raster Histogram
¥ Source 6000 7
& symbology 5000 ]
!J'_i Transparency ]
. 4000 -
{*~ Histogram = ]
> ]
U ]
& Rendering € 3000 4
c -
1] i
@R Pyramids i .
. 2000 -
a Metadata ]
Legend 1000 -
QGIS Server 1
n _' _J_,...--—-—w-..,_“_ . _ L

0 200 400 600 800 1000 1200 1400

Pixel Value
® Band 1
& PrefsfActions. [ |
Set min/max style For Band 1 -
Min 0 EW
Max 1548 EW
©Help Style - « Apply || % Cancel  OK

=]
4. The graph can be exported as an image with the Save plot hyytton

5. You can see more detailed information about the layer in the Information tab (the mean and max values are
estimated, and may not be exact).

The mean value is 332 . 8 (estimated to 324.3), and the maximum value is 1 6 99 (estimated to 1548)! You can zoom
in the histogram. Since there are a lot of pixels with value 0, the histogram looks compressed vertically. By zooming
in to cover everything but the peak at 0, you will see more details:
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Layer Properties - srtm_41_19 | Histogram

[
=

f’i’ Information

Raster Histogram

A% source .

% symbology 150 -
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|

Qﬁj Rendering
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m Metadata

Legend

QGIS Server
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Poznamka: If the mean and maximum values are not the same as above, it can be due to the min/max value

calculation. Open the Symbology tab and expand the Min / Max Value Settings menu. Choose @ Min /max and click
on Apply.

Keep in mind that a histogram shows you the distribution of values, and not all values are necessarily visible on the
graph.
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6.4.7 \ Follow Along: Spatial Interpolation

Let’s say you have a collection of sample points from which you would like to extrapolate data. For example, you
might have access to the Sampled points dataset we created earlier, and would like to have some idea of what the
terrain looks like.

1. To start, launch the GDAL w Raster analysis w Grid (IDW with nearest neighbor searching) tool in the Processing
Toolbox.

For Point layer select Sampled points
Set Weighting power to 5. 0

In Advanced parameters, set Z value from field to rvalue_1

A

Finally click on Run and wait until the processing ends
6. Close the dialog

Here is a comparison of the original dataset (left) to the one constructed from our sample points (right). Yours may
look different due to the random nature of the location of the sample points.

As you can see, 100 sample points aren’t really enough to get a detailed impression of the terrain. It gives a very
general idea, but it can be misleading as well.

6.4.8 / Try Yourself Different interpolation methods

1. Use the processes shown above to create a set of 10 000 random points

Poznamka: If the number of points is really big, the processing time can take a long time.

2. Use these points to sample the original DEM
3. Use the Grid (IDW with nearest neighbor searching) tool on this dataset.
4. Set Power and Smoothing to 5.0 and 2 . 0, respectively.

The results (depending on the positioning of your random points) will look more or less like this:
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This is a better representation of the terrain, due to the greater density of sample points. Remember, larger samples
give better results.

6.4.9 In Conclusion

QGIS has a number of tools for analyzing the spatial statistical properties of datasets.

6.4.10 What's Next?

Now that we have covered vector analysis, why not see what can be done with rasters? That is what we will do in the
next module!
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Module: Rasters

We've used rasters for digitizing before, but raster data can also be used directly. In this module, you'll see how it’s
done in QGIS.

7.1 Lesson: Working with Raster Data

Raster data is quite different from vector data. Vector data has discrete features with geometries constructed out of
vertices, and perhaps connected with lines and/or areas. Raster data, however, is like any image. Although it may
portray various properties of objects in the real world, these objects don’t exist as separate objects. Rather, they are
represented using pixels with different values.

During this module you are going to use raster data to supplement your existing GIS analysis.

The goal for this lesson: To learn how to work with raster data in QGIS.

741 \ Follow Along: Loading Raster Data

Raster data can be loaded with the same methods we used for vector data. However we suggest to use the Browser
Panel.

1. Open the Browser Panel and expand the exercise_data/raster folder.
2. Load all the data in this folder:

* 3320C_2010_314_RGB_LATLNG.tif

e 3320D_2010_315_RGB_LATLNG.tif

e 3420B_2010_328_RGB_LATLNG.tif

¢ 3420C_2010_327_RGB_LATLNG.tif

You should see the following map:
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There we have it - four aerial images covering our study area.

7.1.2 \ Follow Along: Create a Virtual Raster

Now as you can see from this, your solution layer lies across all four images. What this means is that you are going
to have to work with four rasters all the time. That’s not ideal. It would be better to have one file to work with.

Luckily, QGIS allows you to do exactly this, and without needing to actually create a new raster file. You can create
a Virtual Raster. This is also often called a Catalog, which explains its function. It’s not really a new raster. Rather,
it is a way to organize your existing rasters into one catalog: one file for easy access.

To make a catalog we will use the Processing » Toolbox.
1. Open the Build virtual raster algorithm from the GDAL w» Raster miscellaneous;
2. In the dialog that appears, click on the ... button next to the Input layers parameter and check all the layers or

use the Select All button;

3. Uncheck Place each input file into a separate band. Notice the text field below. What this dialog is actually
doing is that it is writing that text for you. It is a long command that QGIS is going to run.

Poznamka: Keep in mind that you can copy and paste the text in the 0SGeo Shell (Windows user)
or Terminal (Linux and OSX users) to run the command. You can also create a script for each GDAL
command. This is very handy when the procedure is taking a long time or when you want to schedule specific
tasks. Use the Help button to get more help on the syntax of the command.

4. Finally click on Run.

Poznamka: As you know from the previous modules, Processing creates temporary layers by default. To save the
file click on the ... button.
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Build Virtual Raster X

Parameters | Log

Input layers E

Resolution

Average

v Place each input file into a separate band
Allow projection difference

v Advanced parameters

Add alpha mask band to VRT when source raster has none

Override projection for the output file [optional]

Resampling algorithm
Nearest Neighbour -

Nodata value(s) For input bands (space separated) [optional]

Additional command-line parameters [optional]

Virtual
[Save to temporary File]
v Open output file after running algorithm

GDAL/OGR console call

gdalbuildvrt -resolution average -separate -r nearest -input_File_list /tmp/
processing_waXvap/9e7966068f424564a9ca71decadc15F9/buildvrtinputFiles.txt /
tmp/processing waXvap/219f32d6606644108251F5ad770a7945/0OUTPUT.vrt -

| 0%

@Help Run as Batch Process... % Close «/ Run

You can now remove the original four rasters from the Layers Panel and leave only the output virtual catalog raster.
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713 == Transforming Raster Data

The above methods allow you to virtually merge datasets using a catalog, and to reproject them ,,on the fly*. However,
if you are setting up data that you’ll be using for quite a while, it may be more efficient to create new rasters that are
already merged and reprojected. This improves performance while using the rasters in a map, but it may take some
time to set up initially.

Reprojecting rasters

Open Warp (reproject) from GDAL w» Raster projections.

You can also reproject virtual rasters (catalogs), enable multithreaded processing, and more.
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Warp (Reproject) o

Parameters Log

Input layer
" Virtual [EPSG:4326] -
Source CRS [optional]

Target CRS [optional]
Project CRS: EPSG:4326 - WGS 84 v ||
Resampling method to use

Nearest Neighbour -
Nodata value for output bands [optional]

Mot set

Output file resolution in target georeferenced units [optional]
Mokt set

P Advanced parameters
Reprojected

[Save to temporary file]
¥ Open output File after running algorithm
GDAL/OGR console call

gdalwarp -t_srs EPSG:4326 -r near -of GTiff /tmp/
processing E3t0r2/4d43521175294d8a8F7935de8c0d5¢ca3/OUTPUT.vrt /tmp/
processing_E3t0r2/cf35Ff6625870499798aa2930475ab4b1/OUTPUT.LIF

| 0%
©@Help Run as Batch Process... % Close «' Run

Merging rasters

If you need to create a new raster layer and save it to disk you can use the merge algorithm.

Poznamka: Depending on how many raster files you are merging and their resolution, the new raster file created can
be really big. Consider instead to create a raster catalog as described in the Create a Virtual Raster section.

1. Click on the Merge algorithm from the GDAL w Raster miscellaneous menu.

2. As we did for the Create a Virtual raster, use the ... button to choose which layers you want to merge.
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You can also specify a Virtual raster as input, and then all of the rasters that it consists of will be processed.

3. If you know the GDAL library, you can also add your own options by opening the Advanced parameters menu.

Parameters | Log

Input layers

Grab pseudocolor table from First layer
Place each input file into a separate band
Output data type
Float32 v

P Advanced parameters
Merged

[Save to temporary file]
¥ Open output File after running algorithm
GDAL/OGR console call

gdal_merge.py -ot Float32 -of GTiff -o /tmp/

processing E3t0r2/517F150854b344bc9f4588a6e9884e32/OUTPUT.LIF --optfile
Jemp/processing E3t0r2/44e87c4b7bdf44533a9552e0d6695F3b/
mergelnputFiles.txt

| 0%
©@Help Run as Batch Process... % Close « Run

7.1.4 In Conclusion

QGIS makes it easy to include raster data into your existing projects.
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7.1.5 What’s Next?

Next, we'll use raster data that isn’t aerial imagery, and see how symbolization is useful in the case of rasters as well.

7.2 Lesson: Changing Raster Symbology

Not all raster data are aerial photos. There are many other forms of raster data, and in many of those cases, it
is essential to symbolize the them so that they becomes properly visible and useful.

The goal for this lesson: To change the symbology for a raster layer.

7.21 \ Try Yourself

1. Use the Browser Panel to load srtm_41_19.tif, found under exercise_data/raster/SRTM/
2. Zoom to the extent of this layer by right-clicking on it in the Layers panel and selecting Zoom to Layer.

This dataset is a Digital Elevation Model (DEM). 1t is a map of the elevation (altitude) of the terrain, allowing us to
see where the mountains and valleys are, for example.

While each pixel of the dataset of the previous section contained color information, in a DEM, each pixel contains
elevation values.

Once the DEM is loaded, you will notice that it is a grayscale representation:
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QGIS has automatically applied a stretch to the pixel values of the image for visualization purposes, and we will learn
more about how this works as we continue.

7.2.2 \ Follow Along: Changing Raster Layer Symbology

You have two different options to change the raster symbology:
1. Within the Layer Properties dialog, by right-clicking on the layer in the Layer tree and selecting the Properties
option. Then switch to the Symbology tab
2. By clicking on the “;\\"/ Open the Layer Styling panel byton right above the Layers panel (shortcut F 7). This will open
the Layer Styling panel, where you can switch to the (\( Symbology tahy

Choose the method you prefer to work with.

7.2.3 \ Follow Along: Singleband gray

When you load a raster file, if it is not a photo image like the ones of the previous section, the default style is set to
a grayscale gradient.

Let’s explore some of the features of this renderer.
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Layer Properties - srtm_41_19 | Symbology x

v Band Rendering

G’ Information

Render type | Singleband gray

'{_‘\‘_- Source

& symbology

Gray band Band 1 (Gray)

Color gradient | Black to white

l_g Transparency Min |0 Max 1548
= Histogram E:R;:‘a:etment Stretch to MinMax -
.}/ Rendering ¥ Min / Max Value Settings
&R Pyramids User defined
m Metadata E(I)J::]L'I:ISE?E 20 [3/-980 [7/%
Legend * Min / max
QGIS Server :gszga?rd_ deviation x 2,00
Statistics extent whole raster -
Accuracy Estimate (Faster) -
w Color Rendering
Blending mode | Mormal -  Reset
Brightness —F 0 = [Cuntrast —F 0 =
Saturation = | 0 = [Grayscale Off -
Hue Colorize Strength il

¥ Resampling

Zoomed: in | Nearest neighbour ~ | out | Nearest neighbour - | Oversampling 2,00 |3

Thumbnail Legend Palette

/oK

# Cancel

The default Color gradient is set to Black to white, meaning that low pixel values are black and while high
values are white. Try to invert this setting to White to black and see the results.

Very important is the Contrast enhancement parameter: by default it is set to St retch to MinMax meaning that
the pixel values are stretched to the minimum and maximum values.

Look at the difference with the enhancement (left) and without (right):
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But what are the minimum and maximum values that should be used for the stretch? The ones that are currently under
Min / Max Value Settings. There are many ways to calculate the minimum and maximum values and use them for the
stretch:

1. User Defined: you enter the Min and Max values manually

2. Cumulative count cut: this is useful when you have some extreme low or high values. It cuts the 2% (or the
value you choose) of these values

3. Min / max: the Real or Estimated minimum and maximum values of the raster

4. Mean +/- standard deviation: the values will be calculated according to the mean value and the standard
deviation

7.2.4 \ Follow Along: Singleband pseudocolor

Grayscales are not always great styles for raster layers. Let’s try to make the DEM more colorful.

¢ Change the Render type to Singleband pseudocolor. If you don’t like the default colors loaded, select another
Color ramp

¢ Click the Classify button to generate a new color classification

« If it is not generated automatically click on the OK button to apply this classification to the DEM
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Layer Properties - srtm_41_19 | Symbology

o :
@ Information Render type |Singleband pseudocolor v|

bl ;
‘& Source Band |Band 1 (Gray) -

& symbology Min 0 | Max 1548 |
P Min / Max Value Settings

!g Transparency

(et Interpolation ' Linear - |
. Color ramp | [ - H
4 Rendering =
Label unit | |
B Pyramids sufFix
, value Color  Label
! Metadata
Legend
387 387
E QGIS Server
774 774
1161 1161
1548 . 1548
Mode  Continuous  ~ | Classes | |

Clip out of range values

v Color Rendering -

. @Help || style - | JApply | %cancel || JOK |

You'll see the raster looking like this:
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This is an interesting way of looking at the DEM. You will now see that the values of the raster are again properly
displayed, going from blue for the lower areas to red for the higher ones.

7.2.5 Follow Along: Changing the transparency
Sometimes changing the transparency of the whole raster layer can help you to see other layers covered by the raster
itself and better understand the study area.

To change the transparency of the whole raster switch to the Transparency tab and use the slider of the Global Opacity
to lower the opacity:
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Layer Properties - srtm_41_19 | Transparency
w Global Opacity

Information _F 55.6 % =
Source w No Data Value

Symbology

Additional no data value

i
2

<

-

*
LP’. Transparency

: w Custom Transparency Options

I_ﬂ Histogram

P Transparency band | None -
4 Rendering o

Transparent pixel list
B Pyramids From To Percent Transparent o
ah Metadata [ o
. =l
& qGis server

5]

[B|Help Style - W Apply @ cancel

More interesting is changing the transparency for some pixel values. For example in the raster we used you can see
a homogeneous color at the corners. To set these pixels as transparent, go to Custom Transparency Options in the
Transparency tab.

* By clicking on the EH Add vatues mamaty button, you can add a range of values and set their transparency
percentage

. 7] - .
» For single values the [ Aad vatues trom dispay 1440 i more useful

. L7 ; . . . .
« Click on the " Add values from display bygeon. The dialog disappears, and you can interact with the map.
* Click on the homogeneous color in a corner of the DEM

* You will see that the transparency table will be filled with the clicked values:
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v Global Opacity

Layer Properties - srtm_41_19 | Transparency

1/100,0% 2/

",_f Information

:t"- Source v No Data Value

% symbology

Additional no data value |

Lr Transparency

Histogram [»| Custom Transparency Options
Rendering Transparency band |None - |
Transparent pixel list

B Pyramids P P -
From To Percent Transparent |$|
B Metadata 1/o 0 100 8]
Legend |§|
58 Qais server (=]
=]
=]

| @Help || style -|

* Click on OK to close the dialog and see the changes.

| Japply || %cancel || oK |

See? The corners are now 100% transparent.
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7.2.6 In Conclusion

These are some the basic functions to get you started with raster symbology. QGIS also gives you many other
options, such as symbolizing a layer using paletted/unique values, representing different bands with different colors
in a multispectral image, or making an automatic hillshade effect (useful only with DEM raster files).

7.2.7 Reference

The SRTM dataset was obtained from http://srtm.csi.cgiar.org/

7.2.8 What’s Next?

Now that we can see our data displayed properly, let’s investigate how we can analyze it further.

7.3 Lesson: Terrain Analysis

Certain types of rasters allow you to gain more insight into the terrain that they represent. Digital Elevation Models
(DEMs) are particularly useful in this regard. In this lesson you will use terrain analysis tools to find out more about
the study area for the proposed residential development from earlier.

The goal for this lesson: To use terrain analysis tools to derive more information about the terrain.

7.3.1 \ Follow Along: Calculating a Hillshade

We are going to use the same DEM layer as in the previous lesson. If you are starting this chapter from scratch, use
the Browser panel and load the raster/SRTM/srtm_41_19.tif.

The DEM layer shows you the elevation of the terrain, but it can sometimes seem a little abstract. It contains all the
3D information about the terrain that you need, but it doesn’t look like a 3D object. To get a better impression of the
terrain, it is possible to calculate a hillshade, which is a raster that maps the terrain using light and shadow to create
a 3D-looking image.

We are going to use algorithms in the Raster » Raster terrain analysis menu.
1. Click on the Hillshade menu

2. The algorithm allows you to specify the position of the light source: Azimuth has values from 0 (North) through
90 (East), 180 (South) and 270 (West), while the Vertical angle sets how high the light source is (0 to 90
degrees).

3. We will use the following values:
e Zfactorat 1.0
* Azimuth (horizontal angle) at 300 . 0°

e Vertical angle at 40 . 0°
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vertical

300g

angle

4. Save the file in a new folder exercise_data/raster_analysis/ with the name hillshade
5. Finally click on Run

You will now have a new layer called hillshade that looks like this:

T ——— S
‘ A A e
-
pr i

4 ol iz
% f ,lg’%, fﬂ%}?;
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That looks nice and 3D, but can we improve on this? On its own, the hillshade looks like a plaster cast. Can’t we use
it together with our other, more colorful rasters somehow? Of course we can, by using the hillshade as an overlay.

7.3.2 \ Follow Along: Using a Hillshade as an Overlay

A hillshade can provide very useful information about the sunlight at a given time of day. But it can also be used for
aesthetic purposes, to make the map look better. The key to this is setting the hillshade to being mostly transparent.

1.

A

Change the symbology of the original srtm_41_19 layer to use the Pseudocolor scheme as in the previous
exercise

Hide all the layers except the srtm_41_19 and hillshade layers

Click and drag the srtm_41_19 to be beneath the hillshade layer in the Layers panel

Set the hillshade layer to be transparent by clicking on the Transparency tab in the layer properties
Set the Global opacity to 50%.

You'll get a result like this:

6.

Switch the hillshade layer off and back on in the Layers panel to see the difference it makes.

Using a hillshade in this way, it’s possible to enhance the topography of the landscape. If the effect doesn’t seem
strong enough to you, you can change the transparency of the hillshade layer; but of course, the brighter the hillshade
becomes, the dimmer the colors behind it will be. You will need to find a balance that works for you.

Remember to save the project when you are done.
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7.3.3 Follow Along: Finding the best areas

Think back to the estate agent problem, which we last addressed in the Vector Analysis lesson. Let us imagine that
the buyers now wish to purchase a building and build a smaller cottage on the property. In the Southern Hemisphere,
we know that an ideal plot for development needs to have areas on it that:

¢ are north-facing
 with a slope of less than 5 degrees
 But if the slope is less than 2 degrees, then the aspect doesn’t matter.

Let’s find the best areas for them.

7.3.4 / Follow Along: Calculating the Slope

Slope informs about how steep the terrain is. If, for example, you want to build houses on the land there, then you
need land that is relatively flat.

To calculate the slope, you need to use the Slope algorithm of the Processing » Raster terrain analysis.
1. Open the algorithm
2. Choose srtm_41_19 as the Elevation layer
3. Keep the Z factor at 1.0
4. Save the output as a file with the name s1ope in the same folder as the hillshade
5. Click on Run

Now you'll see the slope of the terrain, each pixel holding the corresponding slope value. Black pixels show flat terrain
and white pixels, steep terrain:
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7.3.5 / Try Yourself Calculating the aspect
Aspect is the compass direction that the slope of the terrain faces. An aspect of 0 means that the slope is North-facing,
90 East-facing, 180 South-facing, and 270 West-facing.

Since this study is taking place in the Southern Hemisphere, properties should ideally be built on a north-facing slope
so that they can remain in the sunlight.

Use the Aspect algorithm of the Processing » Raster terrain analysis to get the aspect layer saved along with the
slope.

Answer

Set your Aspect dialog up like this:
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(&) Aspect >

Parameters | Log Aspect

Elevation layer
g This algorithm calculates the aspect of the Digital

0" orim_41_19 [EPSG:32733] - .. Terrain Model in input. The final aspect raster layer
contains values from O to 360 that express the
Z factar slope direction: starting from Morth (0% and
continuing dockwise.
1.000000 =
Aspect
QGIS-Training-Data/exerdse_data fraster_analysis/aspect. tif
v | Open output file after running algorithm
0% Cancel
Run as Batch Process... Run | Close Help

Your result:

£ 5 eh

. 3=
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7.3.6 / Follow Along: Finding the north-facing aspect
Now, you have rasters showing you the slope as well as the aspect, but you have no way of knowing where ideal
conditions are satisfied at once. How could this analysis be done?
The answer lies with the Raster calculator.
QGIS has different raster calculators available:
* Raster » Raster Calculator
* In processing:
— Raster Analysis » Raster calculator
— GDAL » Raster miscellaneous » Raster calculator
— SAGA » Raster calculus » Raster calculator

Each tool is leading to the same results, but the syntax may be slightly different and the availability of operators may
vary.
We will use Raster Analysis » Raster calculator in the Processing Toolbox

1. Open the tool by double clicking on it.

» The upper left part of the dialog lists all the loaded raster layers as name@N, where name is the name
of the layer and N is the band.

« In the upper right part you will see a lot of different operators. Stop for a moment to think that a raster
is an image. You should see it as a 2D matrix filled with numbers.

2. North is at 0 (zero) degrees, so for the terrain to face north, its aspect needs to be greater than 270 degrees or
less than 90 degrees. Therefore the formula is:

[aspect@l <= 90 OR aspect@l >= 270 }

3. Now you have to set up the raster details, like the cell size, extent and CRS. This can be done manually or it
can be automatically set by choosing a Reference layer. Choose this last option by clicking on the ...
button next to the Reference layer(s) parameter.

4. In the dialog, choose the aspect layer, because we want to obtain a layer with the same resolution.
5. Save the layer as aspect_north.

The dialog should look like:
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() Raster Calculator o

Parameters | Log Raster calculator

Expression
This algorithm allows performing algebraic operations using
ter | 1
I_ay\ers Operatnrs raster layers.

The resulting layer will have its values computed according to
aspect@1 | + | = || s | sin || log10 | AND | an expression, The expression can contain numerical values,
hillshade@1 operators and references to any of the layers in the current
slope@1 | = | / || acos | asin || In | OR | praject. The following functions are also supported:
srtm_41_19@1 .

‘ ~ | | sart | | tan | | atan | | ( | | ) ‘ -sin{), cos(), tan(), atan2{), In{), log10(
‘ < | | > | | - | | = | | <= | | = ‘ The extent, cell size, and output CRS can be defined by the
user, If the extent is not specified, the minimum extent that
‘ b | | N | | | covers selected reference layer(s) will be used. If the cell size
abs min max is not specified, the minimum cell size of selected reference
layer(s) will be used. If the output CRS is not specified, the
Expression CRS of the first reference layer will be used,

The cell size is assumed to be the same in both X and ¥ axes.
aspect@] <= 90 OR aspect@1 »= 270

Layers are referred by their name as displayed in the laver list

and the number of the band to use (based on 1), using the

pattern layer_name@band number', For instance, the first
band from a layer named DEM will be referred as DEM@1.

Expression is valid WWhen using the calculator in the batch interface or from the

console, the files to use have to be spedified. The
Predefined expressions corresponding layers are referred using the base name of the
file (without the full path). For instance, if using a layer at
path/tofmy/rasterfile. tif, the first band of that layer will be
referred as rasterfile. if@1.

|ND\|"[ = | | Add... || save.

Reference layer(s) (used for automated extent, cellsize, and CRS) [optional]

| linputs selected | |:|

Cell size (use 0 or empty to set it automatically) [optional]

| 0.000000 a [z
Output extent [optional]

|Not set

Qutput CRS [optional]
Output
|D: fdev fgithub/QGIS-Training-Data/exercise_data/raster_analysis/aspect_north, tif

v | Open output file after running algorithm

| 0% | Cancel

|Run as Batch Process... Run J | Close | Help |

6. Finally click on Run.

Your result will be this:
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The output values are 0 or 1. What does it mean? For each pixel in the raster, the formula we wrote returns whether
it matches the conditions or not. Therefore the final result will be False (0) and True (1).

7.3.7 / Try Yourself More criteria

Now that you have done the aspect, create two new layers from the DEM.
* The first shall identify areas where the slope is less than or equal to 2 degrees
» The second is similar, but the slope should be less than or equal to 5 degrees.

e Save them under exercise_data/raster_analysis as slope_lte2.tif and slope_1lte5.
tif.

Answer
* Set your Raster calculator dialog up with:
¢ the following expression: slope@l <= 2

* the s1lope layer as the Reference layer(s)
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() Raster Calculator e
S ]

Parameters Log Raster calculator

Expression

This algorithm allows performing algebraic operations using
raster layers.

Layers Operators
The resulting layer will have its values computed according to
aspect@1 | + | = || s | sin || log10 | AND | an expression, The expression can contain numerical values,
aspect_north@1 operators and references to any of the layers in the current
hillshade@1 | - | / || acos | asin || n | OR | project. The following functions are also supported:
slope@1 .
srtm_41_19@1 | e | sqrt || tan | atan | ( | ) | sin(), cos(), tan(), atan2(), In{), log10(
‘ < | | > | | - | | = | | <= | | = ‘ The extent, cell size, and output CRS can be defined by the
user, If the extent is not specified, the minimum extent that
‘ b | | N | | | covers selected reference layer(s) will be used. If the cell size
abs min max is not specified, the minimum cell size of selected reference
layer(s) will be used. If the output CRS is not specified, the
Exxpression CRS of the first reference layer will be used,
The cell size is assumed to be the same in both X and ¥ axes.
“slope@1” <=2
Layers are referred by their name as displayed in the laver list
and the number of the band to use (based on 1), using the
pattern layer_name@band number', For instance, the first
band from a layer named DEM will be referred as DEM@1.
Expression is valid When using the calculator in the batch interface or from the
console, the files to use have to be spedified. The
Predefined expressions corresponding layers are referred using the base name of the
= file (without the full path). For instance, if using a layer at
path/tofmy/rasterfile. tif, the first band of that layer will be
MNDVI v || add || save referred as rasterfile, if@1.

Reference layer(s) (used for automated extent, cellsize, and CRS) [optional]

| linputs selected | |:|

Cell size {use 0 or empty to set it automatically) [optional]

| 0.000000 a [z
Output extent [optional]
|Not set | |_,|

Output CRS [optional]

| - |®
Qutput

|D:fdEvfg\ﬂ']ubIQGIS—Training-DaiBj'exerdse_damfraster_analysisjslupe_ltez.ﬁf & || ,l

v | Open output file after running algorithm

| 0% | Cancel

| Run s Batch Process.. Run J | Close | Help |

* For the 5 degree version, replace the 2 in the expression and file name with 5.
Your results:

¢ 2 degrees:
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* 5 degrees:
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7.3.8 / Follow Along: Combining Raster Analysis Results

Now you have generated three raster layers from the DEM:
* aspect_north: terrain facing north
* slope_lte2: slope equal to or below 2 degrees
* slope_lte5: slope equal to or below 5 degrees

Where the condition is met, the pixel value is 1. Elsewhere, it is 0. Therefore, if you multiply these rasters, the pixels
that have a value of 1 for all of them will get a value of 1 (the rest will get 0).

The conditions to be met are:
* at or below 5 degrees of slope, the terrain must face north
* at or below 2 degrees of slope, the direction that the terrain faces does not matter.

Therefore, you need to find areas where the slope is at or below five degrees AND the terrain is facing north, OR the
slope is at or below 2 degrees. Such terrain would be suitable for development.

To calculate the areas that satisfy these criteria:
1. Open the Raster calculator again

2. Use this expression in Expression:

270 Kapitola 7. Module: Rasters



QGIS Training Manual

[( aspect_north@l = 1 AND slope_lte5@l1 = 1 ) OR slope_lte2@l = 1 ]

3. Set the Reference layer(s) parameter to aspect_north (it does not matter if you choose another - they have
all been calculated from srtm_41_19)

4. Save the output under exercise_data/raster_analysis/asall_conditions.tif
5. Click Run
Vysledek:

Rada: The previous steps could have been simplified using the following command:

[((aspect@l <= 90 OR aspect@l >= 270) AND slope@l <= 5) OR slope@l <= 2 }
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7.3.9 / Follow Along: Simplifying the Raster

As you can see from the image above, the combined analysis has left us with many, very small areas where the
conditions are met (in white). But these aren’t really useful for our analysis, since they are too small to build anything
on. Let us get rid of all these tiny unusable areas.

1. Open the Sieve tool (GDAL » Raster Analysis in the Processing Toolbox)

2. Set the Input file to all_conditions, and the Sieved to all_conditions_sieve.tif (under
exercise_data/raster_analysis/).

3. Set the Threshold to 8 (minimum eight contiguous pixels), and check Use 8-connectedness.

Sieve
Parameters | Log
Input layer =
& all_condition [EPSG:32733] -
Threshold
8

L

v Use B-connectedness

Do not use the default validity mask for the input band
Validity mask [optional]

Sieved
fhome/matteo/exercise_data/exercise_data/raster_analysis/all_conditions_sieve.tif

v | Open output file after running algorithm
GDAL/OGR conscle call

0%

|®|Help Run as Batch Process... # Close ¢ Run

Once processing is done, the new layer will be loaded.
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____ﬁ

_——___

What is going on? The answer lies in the new raster file’s metadata.

4. View the metadata under the Information tab of the Layer Properties dialog. Look the
STATISTICS_MINIMUM value:

Layer Properties - all_conditions_sieve | Information

Information from provider
@ Information
Mame  all_conditions_sieve

3 Path 1ome/matieo/exercis: ita e xercise italfraster analysis
\& Source R
CRS EPSG:32733 - WGS 84 / UTM zone 335 - Projected
Extent 9469491.2754000000422520,61%60%9.34080000035486476 ¢
1038119.773099999991 2454 62502946 9956000000238419

%" symbology

l,_g Transparency Unit meters
Width 837
B Histogram Height 661
Datatype Float32 - Thirty two bit floating point
"/ Rendering GDAL Driver Description  GTiff
GDAL Driver Metadata GedTIFF
‘ Pyramids Dataset Description  /home/mattec/exercise_data/exercise_data/raster_analysis/
all_conditions_sieve.tif
m [REELEE] Compression
Band 1 * STATISTICS_APPROXIMATE=YES
" * STATISTICS_MAXIMUM=1
Legend * STATISTICS MEAN=-266696562.2513
e NSNS =-2147483648
QGIS Server * STATISTICS_STDDEWV=708237202.43956
More information * AREA_OR_POINT=Area

Dimensions  X: 837 ¥: 661 Bands: 1
Origin  269491.6.2503e+6
Pixel Size 8§1.9934.-81.9934

ldentification 3

[E|Help Style - o Apply @ cancel
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This raster, like the one it is derived from, should only feature the values 1 and 0, but it has also a very large
negative number. Investigation of the data shows that this number acts as a null value. Since we are only after
areas that weren'’t filtered out, let us set these null values to zero.

5. Open the Raster Calculator, and build this expression:

L(all_conditions_sieve@l <= 0) =0 }

This will maintain all non-negative values, and set the negative numbers to zero, leaving all the areas with value
1 intact.

6. Save the output under exercise_data/raster_analysis/ as all_conditions_simple.
tif.

Your output looks like this:

This is what was expected: a simplified version of the earlier results. Remember that if the results you get from a tool
aren’t what you expected, viewing the metadata (and vector attributes, if applicable) can prove essential to solving
the problem.

7.3.10 / Follow Along: Reclassifying the Raster

We have used the Raster calculator to do calculations on raster layers. There is another powerful tool that we can use
to extract information from existing layers.

Back to the aspect layer. We know now that it has numerical values within a range from 0 through 360. What we
want to do is to reclassify this layer to other discrete values (from 1 to 4), depending on the aspect:

¢ 1 = North (from 0 to 45 and from 315 to 360);
e 2 = East (from 45 to 135)
¢ 3 = South (from 135 to 225)
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e 4 = West (from 225 to 315)
This operation can be achieved with the raster calculator, but the formula would become very very large.
The alternative tool is the Reclassify by table tool in Raster analysis in the Processing Toolbox.
1. Open the tool
2. Choose aspect as the Input raster layer

3. Click on the ... of Reclassification table. A table-like dialog will pop up, where you can choose the minimum,
maximum and new values for each class.

4. Click on the Add row button and add 5 rows. Fill in each row as the following picture and click OK:

Minimum  Maximum Value | o OK |
10 45 1 * Cancel
2/315 360 1 Add Row
3 45 135 2

Remove Row(s)
4135 225 3

The method used by the algorithm to treat the threshold values of each class is defined by the Range boundaries.

Remove All

5. Save the layer as reclassified.tif inthe exercise_data/raster_analysis/ folder
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Reclassify by Table .

»
Paramelers | Log RECIESSif}'
Raster layer hy table
=" Aspect [EPSG:32733] - This algorithm
Band number reclassifies a
g raster band by
Band 1 (Gray) - assigning new

class values
based on the
ranges specified
in a fixed table.

Reclassification table

v Advanced parameters

Output no data value

-9999 000000 -
Range boundaries
min < value <= max -

Use no data when no range matches value
Output data type
Float32 -

Reclassified raster

rcise_data/raster_analysis/reclassified.sdat

v Open output File after running algorithm

| 0%

@Help Run as Batch Process... ¥ Close

6. Click on Run

If you compare the native aspect layer with the reclassified one, there are not big differences. But by looking at the
legend, you can see that the values go from 1 to 4.

Let us give this layer a better style.
1. Open the Layer Styling panel
2. Choose Paletted/Unique values, instead of Singleband gray
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3. Click on the Classify button to automatically fetch the values and assign them random colors:

Layer Styling & X
| B reclassified - |
o 8= Paletted/Unique values - 3
Band 'Band 1 (Gray) - |
Color ramp | Random colors |;|
Value Color Label _
1 . 1
2 2
3 . 3
4 4
| Classify o || =] Delete All ] o]

Layer Rendering

Blending mode 'Normal - |

|E| |E| v Live update | ' Apply |

| Layer Styling | Processing Toolbox

The output should look like this (you can have different colors given that they have been randomly generated):
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With this reclassification and the paletted style applied to the layer, you can immediately differentiate the aspect areas.

7.3.11 \ Follow Along: Querying the raster

Unlike vector layers, raster layers don’t have an attribute table. Each pixel contains one or more numerical values
(singleband or multiband rasters).

All the raster layers we used in this exercise consist of just one band. Depending on the layer, pixel values may
represent elevation, aspect or slope values.
How can we query the raster layer to get the value of a pixel? We can use the Q& Identify Features byt |

1. Select the tool from the Attributes toolbar.

2. Click on a random location of the srm_41_19 layer. Identify Results will appear with the value of the band at
the clicked location:
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Identify Results E]ES)
W g G Biv

Feature Value
* 0 srtm 41 19
srtm 41 19
Band 1 592
b (Derived)

Mode Current layer -

View Tree - Help

3. You can change the output of the Identify Results panel from the current tree mode to a table one by
selecting Table in the View menu at the bottom of the panel:

Identify Results e
Layer FID Attribute Value

1/srtm_41 19 1 Band 1 592

View Table ~ Help

Clicking each pixel to get the value of the raster could become annoying after a while. We can use the Value Tool
plugin to solve this problem.

1. Go to Plugins » Manage/Install Plugins...
2. In the All tab, type value t in the search box
3. Select the Value Tool plugin, press Install Plugin and then Close the dialog.
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Plugins | All (539) .
& All A value t &«

| )
F ] Installed

e Value Tool qk

bl Qgis plugin to display in table or plot values from raster layers

(or mesh layers, from version 3.0.5) at the current mouse

%% Install from ZIP o
position

.ﬁ SEEEGE Qgis plugin to display in table or plot values from raster layers (or mesh layers, from
version 3.0.5) at the current mouse position

If this plugin is useful for you, please consider to make a donation of any value to the
Maintainer

WIWWWW 84 rating vote(s), 136917 downloads

Tags raster, mesh
More info homepage bug tracker code repository
Author Jorge Almerio (maintainer)

Available version 3.06

Install Plugin
@Help % Close

The new Value Tool panel will appear.

Tip: If you close the panel you can reopen it by enabling it in the View » Panels » Value Tool or by clicking
on the icon in the toolbar.

4. To use the plugin just check the Enable checkbox and be sure that the srtm_41_19 layer is active (checked)
in the Layers panel.

5. Move the cursor over the map to see the value of the pixels.

Layers @@
o [l ® T &, -BF & L

HEEEEEEN

== srtm 41 19

Browser Layers
Value Tool [E5]
v| Enable

Table | Graph = Options

Decimals |2 |%

Layer Value
1/srtm_41.19  76.0

Coordinate: (997960.378142, 6216696.900344)
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6. But there is more. The Value Tool plugin allows you to query all the active raster layers in the Layers panel.
Set the aspect and slope layers active again and hover the mouse on the map:

Layers [E]ES]
N 2 3= gt
b v B slope

b |V ¥ aspect

b s

b -

3 :.'

3 :.'

3 -

2 -

bV B srtm_41_19

Browser Layers
Value Tool B®E
v Enable

Table | Graph = Options

Decimals |2 |3

Layer Value
1|slope 56.08386993...
2|aspect 173.8803253...

3/stm 41 19 328.0

Coordinate: (1001434.695838, 6227891.924031)

7.3.12 In Conclusion

You've seen how to derive all kinds of analysis products from a DEM. These include hillshade, slope and aspect
calculations. You've also seen how to use the raster calculator to further analyze and combine these results. Finally
you learned how to reclassify a layer and how to query the results.

7.3.13 What's Next?

Now you have two analyses: the vector analysis which shows you the potentially suitable plots, and the raster analysis
that shows you the potentially suitable terrain. How can these be combined to arrive at a final result for this problem?
That’s the topic for the next lesson, starting in the next module.
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Module: Completing the Analysis

You now have two halves of an analysis: a vector and a raster part. In this module, you’ll see how to combine them.
You will conclude the analysis and present the final results.

8.1 Lesson: Raster to Vector Conversion

Converting between raster and vector formats allows you to make use of both raster and vector data when solving
a GIS problem, as well as using the various analysis methods unique to these two forms of geographic data. This
increases the flexibility you have when considering data sources and processing methods for solving a GIS problem.

To combine a raster and vector analysis, you need to convert the one type of data to the other. Let’s convert the raster
result of the previous lesson to a vector.

The goal for this lesson: To get the raster result into a vector that can be used to complete the analysis.

8.1.1 / Follow Along: The Raster to Vector Tool

Start with the map from the last module, raster_analysis.qggs. There you should have the
all_conditions_simple.tif calculated during the previous exercises.

¢ Click on Raster » Conversion » Polygonize (Raster to Vector). The tool dialog will appear.

* Set it up like this:
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Polygonize (Raster to Vector) X

Parameters | Log
Input layer
# all_conditions_simple [EPSG:32733] -
Band number
Band 1 (Gray) -
Name of the field to create
suitable
Use 8-connectedness

v Advanced parameters

Additional command-line parameters [optional]

Vectorized
ease_3.10/exercise_data/residential_development/all_terrain.shp

v! Open output file after running algorithm
GDAL/OGR console call

gdal_polygonize.py /home/hari/Desktop/QGIS-Training-Data-
release_3.10/exercise_data/raster_analysis/all_conditions_simple.tif
/home/hari/Desktop/QGIS-Training-Data-release_3.10/
exercise_data/residential_development/all_terrain.shp -b 1 -f "ESRI

Shapefile" all terrain suitable -
| 0%
[ElHelp Run as Batch Process... # Close #Run

* Change the field name (describing the values of the raster) to suitable.
 Save the layer under exercise_data/residential_development asall_terrain.shp.

Now you have a vector file which contains all the values of the raster, but the only areas you’re interested in are those
that are suitable; i.e., those polygons where the value of suitable is 1. You can change the style of this layer if you
want to have a clearer visualization of it.

8.1.2 / Try Yourself

Refer back to the module on vector analysis.
* Create a new vector file that contains only the polygons where suitable has the value of 1.

e Save the new file under exercise_data/residential_development/
as suitable_terrain.shp.

Answer

1. Open the Query Builder by right-clicking on the all_terrain layer in the Layers panel, and selecting the Properties
» Source tab.

2. Then build the query "suitable" = 1.
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3. Click OK to filter out all the polygons where this condition isn’t met. When viewed over the original raster, the
areas should overlap perfectly:

Polygonize (Raster to Vector) X

Parameters | Log
Input layer
" all_conditions_simple [EPSG:32733] -
Band number
Band 1 (Gray) v
Name of the field to create
suitable
Use 8-connectedness

v Advanced parameters

Additional command-line parameters [optional]

Vectorized
ease_3.10/exercise_data/residential_development/all_terrain.shp
v! Open output file after running algorithm

GDAL/OGR console call

gdal_polygonize.py /home/hari/Desktop/QGIS-Training-Data- =
release_3.10/exercise_data/raster_analysis/all_conditions_simple.tif
/home/hari/Desktop/QGIS-Training-Data-release _3.10/
exercise_data/residential_development/all_terrain.shp -b 1 -f "ESRI
Shapefile" all_terrain suitable -

| 0%
[BHelp Run as Batch Process... # Close #Run

4. You can save this layer by right-clicking on the all_terrain layer in the Layers panel and choosing Save As...,
then continue as per the instructions.

8.1.3 / Follow Along: The Vector to Raster Tool
Although unnecessary for our current problem, it’s useful to know about the opposite conversion from the one
performed above. Convert to raster the suitable_terrain.shp vector file you just created in previous step.

¢ Click on Raster » Conversion » Rasterize ( Vector to Raster) to start this tool, then set it up as in the screenshot
below:
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Rasterize (Vector to Raster) x

Parameters | Log
Input layer
all_terrain [EPSG:32733] || .- |[|®

Field to use for a burn-in value [optional]

123 SUITABLE -
A fixed value to burn [optional]
0.000000 -

Output raster size units
Pixels -

Width/Horizontal resolution

837.000000 =
Height/Vertical resolution
616.000000 -

Output extent (xmin, xmax, ymin, ymax)
54,1037709.8059691756,6196099.3408,6250051.015321028 [EPSG:32733]
Assign a specified nodata value to output bands [optional]

0.000000 =

v Advanced parameters

Additional creation options [optional]

Profile | Default -
Name Value
0%
& Help Run as Batch Process... # Close #Run

* Input layer is all_terrain.

* Field name is suitable.

 Qutput raster size units is Pixels.

» Width and Height are 837 and 661, respectively.
* Get the Output extent from the all_terrain layer.

¢ Set output file Rasterized to exercise_data/residential_development/
raster_conversion.tif.

Poznamka: The size of the output image is specified here to be the same as the original raster which was vectorized.
To view the dimensions of an image, open its metadata (Metadata tab in the Layer Properties).

* Click OK on the dialog to begin the conversion process.

* When it is complete, gauge its success by comparing the new raster with the original one. They should match
up exactly, pixel for pixel.
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8.1.4 In Conclusion

Converting between raster and vector formats allows you to widen the applicability of data, and need not lead to data
degradation.

8.1.5 What’s Next?

Now that we have the results of the terrain analysis available in vector format, they can be used to solve the problem
of which buildings we should consider for the residential development.

8.2 Lesson: Combining the Analyses

Using the vectorized results of the raster analysis will allow you to select only those buildings on suitable terrain.

The goal for this lesson: To use the vectorized terrain results to select suitable plots.

8.2.1 / Try Yourself

1. Save your current map (raster_analysis.qgs).

2. Open the map which you created during the vector analysis earlier (you should have saved the file
as analysis.qggs).

3. In the Layers panel, enable these layers:
o hillshade,
e solution (or buildings_over_100)

4. In addition to these layers, which should already be loaded in the map from when you worked on it before, also
add the suitable_terrain.shp dataset.

5. If you are missing some layers, you should find them in exercise_data/
residential_development/

6. Use the Intersection tool (Vector » Geoprocessing Tools) to create a new vector layer called new_solution.
shp which contains only those buildings which intersect the suitable_terrain layer.

You should now have a layer showing certain buildings as your solution, for example:
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8.2.2 / Try Yourself Inspecting the Results

Look at each of the buildings in your new_solution layer. Compare them with the suitable_terrain layer by changing
the symbology for the new_solution layer so that it has outlines only. What do you notice about some of the buildings?
Are they all suitable just because they intersect with the suitable_terrain layer? Why or why not? Which ones would
you deem to be unsuitable?

Answer

You may notice that some of the buildings in your new_solution layer have been ,sliced” by the Intersection tool.
This shows that only part of the building - and therefore only part of the property - lies on suitable terrain. We can
therefore sensibly eliminate those buildings from our dataset.

8.2.3 / Try Yourself Refining the Analysis

You can see from the results that some buildings which were included were not really suitable, so we can now refine
the analysis.

‘We want to ensure that our analysis returns only those buildings which fall entirely within the suitable_terrain layer.
How would you achieve this? Use one or more Vector Analysis tools and remember that our buildings are all over
100m squared in size.

Answer

At the moment, your analysis should look something like this:
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Consider a circular area, continuous for 100 meters in all directions.

If it is greater than 100 meters in radius, then subtracting 100 meters from its size (from all directions) will result in
a part of it being left in the middle.
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Therefore, you can run an interior buffer of 100 meters on your existing suitable_terrain vector layer. In the output of
the buffer function, whatever remains of the original layer will represent areas where there is suitable terrain for 100
meters beyond.

To demonstrate:
1. Go to Vector » Geoprocessing Tools » Buffer(s) to open the Buffer(s) dialog.
2. Set it up like this:
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8.0.8 Buffer(s)

Input vector layer

'
SN

[ suitable_terrain_345

| | Use only selected features

Segments to approximate |10 |v)

(=) Buffer distance -100
() Buffer distance field
suitable :

[EI Dissolve buffer results

Output shapefile

suitable_terrain_continuous_100m.shp | Browse

[Ef.ﬂ.dd result to canvas

'_ || Close | [ OK |

3. Use the suitable_terrain layer with 10 segments and a buffer distance of —100. (The distance is automatically
in meters because your map is using a projected CRS.)

4. Save the output in exercise_data/residential_development/
as suitable_terrain_continuous100m. shp.

5. If necessary, move the new layer above your original suitable_terrain layer.

Your results will look like something like this:
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QGIS - analysis
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6. Now use the Select by Location tool (Vector » Research Tools » Select by location).
7. Set up like this:

0 6 Select by location

e TR Ry P S A e PR Ny e mm

Select features in:

4k

[ new_solution

that intersect features in:

4 W
—

[ suitable_terrain_continuous_100m

|| Use selected features only

Modify current selection by:

4k

[ creating new selection

™ Add result to canvas

[ | [ Close ] H

8. Select features in new_solution that intersect features in suitable_terrain_continuous100m.shp.

This is the result:
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4

The yellow buildings are selected. Although some of the buildings fall partly outside the new
suitable_terrain_continuous100m layer, they lie well within the original suitable_terrain layer and therefore
meet all of our requirements.

9. Save the selection under exercise_data/residential_development/ as final_answer.
shp.

8.2.4 In Conclusion

You have now answered the original research question, and can offer an opinion (with reasons, backed by analysis)
for a recommendation regarding which property to develop.

8.2.5 What’s Next?

Next you will present these results as part of your second assignment.

8.3 Assignment

Using the print layout, make a new map representing the results of your analysis. Include these layers:
¢ places (with labels),
* hillshade,
e solution (or new_solution),
* roads and
« either aerial_photos or DEM.

Write a short explanatory text to accompany it. Include in this text the criteria that were used in considering a house for
purchase and subsequent development, as well as explaining your recommendations for which buildings are suitable.
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8.4 Lesson: Supplementary Exercise

In this lesson, you will be guided through a complete GIS analysis in QGIS.

Poznamka: Lesson developed by Linfiniti Consulting (South Africa) and Siddique Motala (Cape Peninsula
University of Technology)

8.4.1 Problem Statement

You are tasked with finding areas in and around the Cape Peninsula that are suitable habitats for a rare fynbos plant
species. The extent of your area of investigation covers Cape Town and the Cape Peninsula between Melkbosstrand
in the north and Strand in the south. Botanists have provided you with the following preferences exhibited by the
species in question:

« It grows on east facing slopes

* It grows on slopes with a gradient between 15% and 60%

* It grows in areas that have a total annual rainfall of > 1000 mm

* It will only be found at least 250 m away from any human settlement

+ The area of vegetation in which it occurs should be at least 6000 m? in area

As a student at the University, you have agreed to search for the plant in four different suitable areas of land. You
want those four suitable areas to be the ones that are closest to the University of Cape Town where you live. Use your
GIS skills to determine where you should go to look.

8.4.2 Solution Outline

The data for this exercise can be found in the exercise_data/more_analysis folder.

You are going to find the four suitable areas that are closest to the University of Cape Town.

The solution will involve:
1. Analyzing a DEM raster layer to find the east facing slopes and the slopes with the correct gradients
2. Analyzing a rainfall raster layer to find the areas with the correct amount of rainfall

3. Analyzing a zoning vector layer to find areas that are away from human settlement and are of the correct size

8.4.3 Follow Along: Setting up the Map

1. Click on the & Current CRS hytton in the lower right corner of the screen. Under the CRS tab of the dialog that
appears, use the ,Filter” tool to search for ,,33S*. Select the entry WGS 84 / UTM zone 33S (with EPSG code
32733).

2. Click OK

=] .
3. Save the project file by clicking on the Save Project t0]bar button, or use the Project » Save As... menu item.

Save it in a new directory called Rasterprac, that you should create somewhere on your computer. You will
save whatever layers you create in this directory as well. Save the project as your_name_fynbos.ggs.
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8.4.4 Loading Data into the Map

In order to process the data, you will need to load the necessary layers (street names, zones, rainfall, DEM, districts)
into the map canvas.

For vectors...

10.
11.
12.

SAE I

Click on the ‘! Open Data Source Manager yy¢10n in the Data Source Manager Toolbar, and enable the " Vector

tab in the dialog that appears, or use the Layer » Add Layer » vl.‘: Add Vector Layer... menu item

Ensure that ® File is selected

Click on the ... button to browse for vector dataset(s)

In the dialog that appears, open the exercise_data/more_analysis/Streets directory
Select the file St reet_Names_UTM33S.shp

Click Open.

The dialog closes and shows the original dialog, with the file path specified in the text field next to Vector
dataset(s). This allows you to ensure that the correct file is selected. It is also possible to enter the file path in
this field manually, should you wish to do so.

Click Add. The vector layer will be loaded into your map. Its color is automatically assigned. You will change
it later.

Rename the layer to Streets
1. Right-click on it in the Layers panel (by default, the pane along the left-hand side of the screen)
2. Click Rename in the dialog that appears and rename it, pressing the Ent er key when done

Repeat the vector adding process, but this time select the Generalised_Zoning_Dissolve_UTM33S.
shp file in the Zoning directory.

Rename it to Zoning.
Load also the vector layer admin_boundaries/Western_Cape_UTM33S. shp into your map.

Rename itto Districts.

For rasters...

Click on the ‘! Open Data Source Manager hytton and enable the ECI Raster tab in the dialog that appears, or use

the Layer » Add Layer » FD Add Raster Layer... menu item

Ensure that ' ® File is selected
Navigate to the appropriate file, select it, and click Open

Do this for each of the following two raster files, DEM/SRTM.tif and rainfall/reprojected/
rainfall.tif

Rename the SRTM raster to DEM and the rainfall raster to Rainfall (with an initial capital)
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8.4.5 Changing the layer order

Click and drag layers up and down in the Layers panel to change the order they appear in on the map so that you can
see as many of the layers as possible.

Now that all the data is loaded and properly visible, the analysis can begin. It is best if the clipping operation is done
first. This is so that no processing power is wasted on computing values in areas that are not going to be used anyway.

8.4.6 Find the Correct Districts

Due to the aforementioned area of investigation, we need to limit our districts to the following ones:

Bellville

Cape

Goodwood

Kuils River

Mitchells Plain

Simon Town

Wynberg

. Right-click on the Districts layer in the Layers panel.

In the menu that appears, select the Filter... menu item. The Query Builder dialog appears.

You will now build a query to select only the candidate districts:

1.

S

In the Fields list, double-click on the NAME_ 2 field to make it appear in the SOL where clause text field
below

Click the IN button to append it to the SQL query

Open the brackets

Click the All button below the (currently empty) Values list.

After a short delay, this will populate the Values list with the values of the selected field (NAME_ 2).
Double-click the value Be11ville in the Values list to append it to the SQL query.

Add a comma and double-click to add Cape district

Repeat the previous step for the remaining districts

Close the brackets

The final query should be (the order of the districts in the brackets does not matter):

"NAME_2" in ('Bellville', 'Cape', 'Goodwood', 'Kuils River',
'Mitchells Plain', 'Simon Town', 'Wynberg')

Poznamka: You can also use the OR operator; the query would look like this:

"NAME_2" = 'Bellville' OR "NAME_2" = 'Cape' OR

"NAME_2" = 'Goodwood' OR "NAME_2" = 'Kuils River' OR
"NAME_2" = 'Mitchells Plain' OR "NAME_2" = 'Simon Town' OR
"NAME_2" = 'Wynberg'

Click OK twice.

The districts shown in your map are now limited to those in the list above.
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8.4.7 Clip the Rasters

Now that you have an area of interest, you can clip the rasters to this area.

1.

10.

Open the clipping dialog by selecting the menu item Raster » Extraction » Clip Raster by Mask Layer...

2. In the Input layer dropdown list, select the DEM layer
3.
4

In the Mask layer dropdown list, select the Districts layer

. Scroll down and specify an output location in the Clipped (mask) text field by clicking the ... button and choosing

Save to File...
1. Navigate to the Rasterprac directory
2. Enter a file name - DEM_clipped.tif

3. Save

Make sure that i Open output file after running algorithm is checked
Click Run

After the clipping operation has completed, leave the Clip Raster by Mask Layer dialog open, to be able to reuse
the clipping area

Select the Rainfall raster layer in the Input layer dropdown list and save your output
asRainfall_clipped.tif

Do not change any other options. Leave everything the same and click Run.
After the second clipping operation has completed, you may close the Clip Raster by Mask Layer dialog

Save the map

Align the rasters

For our analysis we need the rasters to have the same CRS and they have to be aligned.

First we change the resolution of our rainfall data to 30 meters (pixel size):

1.

2.
3.
4.
5.

6.

In the Layers panel, ensure that Rainfall_clipped isthe active layer (i.e., it is highlighted by having been
clicked on)

Click on the Raster » Projections » Warp (Reproject)... menu item to open the Warp (Reproject) dialog
Under Resampling method to use, select Bilinear from the drop down menu
Set Output file resolution in target georeferenced units to 30

Scroll down to Reprojected and save the output in your rainfall/reprojected directory
asRainfall30.tif.

Make sure that i Open output file after running algorithm is checked

Then we align the DEM:

1.

In the Layers panel, ensure that DEM_ c1ipped is the active layer (i.e., it is highlighted by having been clicked
on)

Click on the Raster » Projections » Warp (Reproject)... menu item to open the Warp (Reproject) dialog
Under Target CRS, select Project CRS: EPSG:32733 - WGS 84 / UTM zone 33S from the drop down menu
Under Resampling method to use, select Bilinear from the drop down menu

Set Output file resolution in target georeferenced units to 30

Scroll down to Georeferenced extents of output file to be created. Use the button to the right of the text box to
select Calculate from Layer » Rainfall30.
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7. Scroll down to Reprojected and save the output in your DEM/ reprojected directory as DEM30.t1if.

8. Make sure that o Open output file after running algorithm is checked

In order to properly see what’s going on, the symbology for the layers needs to be changed.

8.4.8 Changing the symbology of vector layers

1. In the Layers panel, right-click on the Streets layer

Select Properties from the menu that appears

Switch to the Symbology tab in the dialog that appears

Click on the Line entry in the top widget

Select a symbol in the list below or set a new one (color, transparency, ...)

Click OK to close the Layer Properties dialog. This will change the rendering of the Streets layer.

N o AR

Follow a similar process for the Zoning layer and choose an appropriate color for it

8.4.9 Changing the symbology of raster layers

Raster layer symbology is somewhat different.
1. Open the Properties dialog for the Rainfall30 raster layer

2. Switch to the Symbology tab. You'll notice that this dialog is very different from the version used for vector
layers.

Expand Min/Max Value Settings

Ensure that the button Mean +/- standard deviation is selected
Make sure that the value in the associated box is 2. 00

For Contrast enhancement, make sure it says Stretch to MinMax
For Color gradient, change it to White to Black

Click OK

® N AW

The Rainfall30 raster, if visible, should change colors, allowing you to see different brightness values for
each pixel

9. Repeat this process for the DEM30 layer, but set the standard deviations used for stretching to 4. 00

8.4.10 Clean up the map

1. Remove the original Rainfall and DEM layers, as well as Rainfall_clipped and DEM_clipped
from the Layers panel:

 Right-click on these layers and select Remove.

Poznamka: This will not remove the data from your storage device, it will merely take it out of your
map.

2. Save the map

3. You can now hide the vector layers by unchecking the box next to them in the Layers panel. This will make
the map render faster and will save you some time.
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8.4.11 Create the hillshade

In order to create the hillshade, you will need to use an algorithm that was written for this purpose.

1.
2.
3.

4,
5.
6.

In the Layers panel, ensure that DEM30 is the active layer (i.e., it is highlighted by having been clicked on)
Click on the Raster » Analysis » Hillshade... menu item to open the Hillshade dialog

Scroll down to Hillshade and save the output in your Rasterprac directoryas hillshade.tif

Make sure that . Open output file after running algorithm is checked
Click Run

Wiait for it to finish processing.

The new hillshade layer has appeared in the Layers panel.

1.

Right-click on the hil1lshade layer in the Layers panel and bring up the Properties dialog

2. Click on the Transparency tab and set the Global Opacity slider to 20%
3.
4

Click OK

. Note the effect when the transparent hillshade is superimposed over the clipped DEM. You may have to change

the order of your layers, or click off the Rainfall30 layer in order to see the effect.

8.4.12 Slope

5.
6.

. Click on the Raster » Analysis » Slope... menu item to open the Slope algorithm dialog

Select DEM30 as Input layer

Check i Slope expressed as percent instead of degrees. Slope can be expressed in different units (percent or
degrees). Our criteria suggest that the plant of interest grows on slopes with a gradient between 15% and 60%.
So we need to make sure our slope data is expressed as a percent.

Specify an appropriate file name and location for your output.

Make sure that i Open output file after running algorithm is checked
Click Run

The slope image has been calculated and added to the map. As usual, it is rendered in grayscale. Change the symbology
to a more colorful one:

1.

Open the layer Properties dialog (as usual, via the right-click menu of the layer)

2. Click on the Symbology tab

3. Where it says Singleband gray (in the Render type dropdown menu), change it to Singleband pseudocolor
4.
5
6

Choose Mean +/- standard deviation x for Min / Max Value Settings with a value of 2. 0

. Select a suitable Color ramp

. Click Run
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8.4.13 Try Yourself Aspect

Use the same approach as for calculating the slope, choosing Aspect... in the Raster » Analysis menu.

Remember to save the project periodically.

8.4.14 Reclassifying rasters

1. Choose Raster » Raster calculator...

2. Specify your Rasterprac directory as the location for the Output layer (click on the ... button), and save it
as slopelb5_60.tif

3. Ensure that the Open output file after running algorithm box is selected.

In the Raster bands list on the left, you will see all the raster layers in your Layers panel. If your Slope layer
is called slope, it will be listed as s1ope@1. Indicating band 1 of the slope raster.

4. The slope needs to be between 15 and 60 degrees.

Using the list items and buttons in the interface, build the following expression:

[(slope@l > 15) AND (slope@l < 60) }

5. Set the Output layer field to an appropriate location and file name.
6. Click Run.
Now find the correct aspect (east-facing: between 45 and 135 degrees) using the same approach.

1. Build the following expression:

[(aspect@l > 45) AND (aspect@l < 135) }

You will know it worked when all of the east-facing slopes are white in the resulting raster (it’s almost as if they are
being lit by the morning sunlight).

Find the correct rainfall (greater than 1000 mm) the same way. Use the following expression:

[Rainfall30@l > 1000 ]

Now that you have all three criteria each in separate rasters, you need to combine them to see which areas satisfy all
the criteria. To do so, the rasters will be multiplied with each other. When this happens, all overlapping pixels with
a value of 1 will retain the value of 1 (i.e. the location meets the criteria), but if a pixel in any of the three rasters
has the value of O (i.e. the location does not meet the criteria), then it will be 0 in the result. In this way, the result
will contain only the overlapping areas that meet all of the appropriate criteria.

8.4.15 Combining rasters

1. Open the Raster Calculator (Raster » Raster Calculator...)

2. Build the following expression (with the appropriate names for your layers):

[[aspect45_135] * [slopel5_60] * [rainfall_1000] }

3. Set the output location to the Rasterprac directory

4. Name the output raster aspect_slope_rainfall.tif

5. Ensure that i Open output file after running algorithm is checked
6. Click Run
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The new raster now properly displays the areas where all three criteria are satisfied.
Save the project.

The next criterion that needs to be satisfied is that the area must be 250 m away from urban areas. We will satisfy
this requirement by ensuring that the areas we compute are inside rural areas, and are 250 m or more from the edge
of the area. Hence, we need to find all rural areas first.

8.4.16 Finding rural areas

1. Hide all layers in the Layers panel
2. Unhide the Zoning vector layer

3. Right-click on it and bring up the A#tribute Table dialog. Note the many different ways that the land is zoned
here. We want to isolate the rural areas. Close the Attribute table.

4. Right-click on the Zoning layer and select Filter... to bring up the Query Builder dialog

5. Build the following query:

["Gen_Zoning" = 'Rural'

See the earlier instructions if you get stuck.

6. Click OK to close the Query Builder dialog. The query should return one feature.
You should see the rural polygons from the Zoning layer. You will need to save these.

1. In the right-click menu for Zoning, select Export » Save Features As....

2. Save your layer under the Rasterprac directory

3. Name the output file rural. shp

4. Click OK

5. Save the project

Now you need to exclude the areas that are within 2 50m from the edge of the rural areas. Do this by creating a negative
buffer, as explained below.

8.4.17 Creating a negative buffer

1. Click the menu item Vector » Geoprocessing Tools » Buffer...

2. In the dialog that appears, select the rural layer as your input vector layer (Selected features only should not
be checked)

3. Set Distance to —250. The negative value means that the buffer will be an internal buffer. Make sure that the
units are meters in the dropdown menu.

. Check o Dissolve result
. In Buffered, place the output file in the Rasterprac directory, and name it rural_buffer.shp
. Click Save

. Click Run and wait for the processing to complete

o N N »n b

. Close the Buffer dialog.

Make sure that your buffer worked correctly by noting how the rural_buffer layer is different from the
rural layer. You may need to change the drawing order in order to observe the difference.

9. Remove the rural layer

10. Save the project
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Now you need to combine your rural_buffer vector layer with the aspect_slope_rainfall raster. To
combine them, we will need to change the data format of one of the layers. In this case, you will vectorize the raster,
since vector layers are more convenient when we want to calculate areas.

8.4.18 Vectorizing the raster

1. Click on the menu item Raster » Conversion » Polygonize (Raster to Vector)...
Select the aspect_slope_rainfall raster as Input layer

Set Name of the field to create to suitable (the default field name is DN - Digital number data)

A

Save the output. Under Vectorized, select Save file as. Set the location to Rasterprac and name the file
aspect_slope_rainfall_all.shp.

Ensure that . Open output file after running algorithm is checked
6. Click Run

e

7. Close the dialog when processing is complete

All areas of the raster have been vectorized, so you need to select only the areas that have a value of 1 in the
suitable field. (Digital Number.

1. Open the Query Builder dialog (right-click - Filter...) for the new vector layer
2. Build this query:

["suitable" =1

3. Click OK

4. After you are sure the query is complete (and only the areas that meet all three criteria, i.e. with a value of
1 are visible), create a new vector file from the results, using the Export » Save Features As... in the layer’s
right-click menu

5. Save the file in the Rasterprac directory

6. Name the file aspect_slope_rainfall_1.shp

7. Remove the aspect_slope_rainfall_all layer from your map
8. Save your project

When we use an algorithm to vectorize a raster, sometimes the algorithm yields what is called ,Invalid geometries*,
i.e. there are empty polygons, or polygons with mistakes in them, that will be difficult to analyze in the future. So, we
need to use the ,,Fix Geometry“ tool.

8.4.19 Fixing geometry

1. In the Processing Toolbox, search for ,,Fix geometries®, and Execute... it
2. For the Input layer, select aspect_slope_rainfall_1

3. Under Fixed geometries, select Save file as, and save the output to Rasterprac and name the file
fixed_aspect_slope_rainfall.shp.

4. Ensure that i Open output file after running algorithm is checked
5. Click Run
6. Close the dialog when processing is complete

Now that you have vectorized the raster, and fixed the resulting geometry, you can combine the aspect,
slope, and rainfall criteria with the distance from human settlement criteria by finding the intersection of the
fixed_aspect_slope_rainfall layer and the rural_buffer layer.
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8.4.20 Determining the Intersection of vectors

9.

® Nk w N

Click the menu item Vector » Geoprocessing Tools w Intersection...

In the dialog that appears, select the rural_buffer layer as Input layer

For the Overlay layer, select the fixed_aspect_slope_rainfall layer

In Intersection, place the output file in the Rasterprac directory

Name the output file rural_aspect_slope_rainfall.shp

Click Save

Click Run and wait for the processing to complete

Close the Intersection dialog.

Make sure that your intersection worked correctly by noting that only the overlapping areas remain.

Save the project

The next criteria on the list is that the area must be greater than 6000 m?. You will now calculate the polygon areas
in order to identify the areas that are the appropriate size for this project.

8.4.21 Calculating the area for each polygon

1.
2.

7.
8.

9.

Open the new vector layer’s right-click menu

Select Open attribute table
Click the § Tosgle editing pyit0n in the top left corner of the table, or press Ctrl+e

Click the f==] Open field calculator 1y,¢t6n in the toolbar along the top of the table, or press Ctr1+i

In the dialog that appears, make sure that i Create new field is checked, and set the Output field name to
area The output field type should be a decimal number (real). Set Precision to 1 (one decimal).

In the Expression area, type:

[$area

J

This means that the field calculator will calculate the area of each polygon in the vector layer and will then
populate a new integer column (called area) with the computed value.

Click OK

Do the same thing for another new field called id. In Field calculator expression, type:

[$id

This ensures that each polygon has a unique ID for identification purposes.

Click # Toggleediting 4o5in and save your edits if prompted to do so

8.4.
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8.4.22 Selecting areas of a given size

Now that the areas are known:

1.

2.

Build a query (as usual) to select only the polygons that are larger than 6000 m?. The query is:

["area" > 6000

Save the selection in the Rasterprac directory as a new vector layer called suitable_areas.shp.

You now have the suitable areas that meet all of the habitat criteria for the rare fynbos plant, from which you will
pick the four areas that are nearest to the University of Cape Town.

8.4.23 Digitize the University of Cape Town

1.

A

10.

11.
12.

13.
14.
15.

Create a new vector layer in the Rasterprac directory as before, but this time, use Point as Geometry type
and name it university.shp

Ensure that it is in the correct CRS (Project CRS:EPSG:32733 - WGS 84 / UTM zone 339)
Finish creating the new layer (click OK)
Hide all layers except the new university layer and the St reets layer.
Add a background map (OSM):
1. Go to the Browser panel and navigate to XYZ Tiles » OpenStreetMap
2. Drag and drop the OpenStreetMap entry to the bottom of the Layers panel

Using your internet browser, look up the location of the University of Cape Town. Given Cape Town’s unique
topography, the university is in a very recognizable location. Before you return to QGIS, take note of where
the university is located, and what is nearby.

Ensure that the St reet s layer clicked on, and that the university layer is highlighted in the Layers panel
Navigate to the View » Toolbars menu item and ensure that Digitizing is selected. You should then see a toolbar
icon with a pencil on it ( ' Toggle editing) Thjs is the Toggle Editing button.

Click the Toggle editing button to enter edit mode. This allows you to edit a vector layer

[ I ] i ..
Click the ® £3 AddPointFeature byyteon which should be nearby the & Togele editing byton

With the Add feature tool activated, left-click on your best estimate of the location of the University of Cape
Town

Supply an arbitrary integer when asked for the 1d

Click OK

Click the [_j Save Layer Edits fytton

Click the Toggle editing button to stop your editing session

Save the project
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8.4.24 Find the locations that are closest to the University of Cape Town
1. Go to the Processing Toolbox, locate the Join Attributes by Nearest algorithm (Vector general » Join Attributes
by Nearest) and execute it
2. Input layer should be university, and Input layer 2 suitable_areas
3. Set an appropriate output location and name (Joined layer)

4. Set the Maximum nearest neighbors to 4

5. Ensure that i Open output file after running algorithm is checked
6. Leave the rest of the parameters with their default values
7. Click Run

The resulting point layer will contain four features - they will all have the location of the university and its attributes,
and in addition, the attributes of the nearby suitable areas (including the i d), and the distance to that location.

1. Open the attribute table of the result of the join

2. Note the 1d of the four nearest suitable areas, and then close the attribute table

3. Open the attribute table of the suitable_areas layer

4. Build a query to select the four suitable areas closest to the university (selecting them using the id field)
This is the final answer to the research question.

For your submission, create a fully labeled layout that includes the semi-transparent hillshade layer over an appealing
raster of your choice (such as the DEM or the slope raster, for example). Also include the university and the
suitable_areas layer, with the four suitable areas that are closest to the university highlighted. Follow all the
best practices for cartography in creating your output map.
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KAPITOLA 9

Module: Plugins

Plugins allow you to extend the functionality QGIS offers. In this module, you’ll be shown how to activate and use
plugins.

9.1 Lesson: Installing and Managing Plugins

To begin using plugins, you need to know how to download, install and activate them. To do this, you will learn how
to use the Plugin Installer and Plugin Manager.

The goal for this lesson: To understand and use QGIS* plugin system.

9.1.1 \ Follow Along: Managing Plugins

1. To open the Plugin Manager, click on the menu item Plugins » Manage and Install Plugins.

2. In the dialog that opens, find the Processing plugin:
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() Plugins | All (1081)

% Al
™
F -: Installed

.

Not installed

*‘ New

o

Install from ZIP

# Settings

4. Click Close.

9.1

1 processing

@ maps2WinBUGS -
& Mascaret

= Maxent Model

@ Merge Selected Features (Pro
2 MOJXML Loader

& MOPST

@ MOS-Adeupa-CE

o Metworks

2 NTw2 Datum Transformations

g OrfecToolbox provider

= ORS Tools

@ PAT - Precision Agriculture Tc
. PCRaster Tools

@ Pelias Geocoding

# PostGIS geoprocessing tools
@ Potential Slope Failure for pro
% Processing

@ Processing R Provider

% Processing 5aga MextGen Prc _

This is a core plugin, so you can't uninstall it
Processing

Spatial data processing framework for QGIS

Spatial data processing framework for QGIS

Category
More info
Author

Installed version

Upgrade All

L

Analysis

homepage bug tracker code repository
Victor Olaya

2.12.99

Uninstall Plugin Reinstall Plugin

Close Help

Click in the box next to this plugin and uncheck it to deactivate it.

Looking at the menu, you will notice that the Processing menu is is now gone. This means that many of the

processing functions you have been using before have disappeared! For example look at the Vector » and Raster
» menus. This is because they are part of the Processing plugin, which needs to be activated to use them.

2\

Open the Plugin Manager again and reactivate the Processing plugin by clicking in the checkbox next to it.

Close the dialog. The Processing menu and functions should be available again.

Follow Along: Installing New Plugins

The list of plugins that you can activate and deactivate draws from the plugins that you currently have installed. To
install new plugins:

1. Select the Not Installed option in the Plugin Manager dialog. The plugins available for you to install will be
listed here. This list will vary depending on your existing system setup.
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@ Plugins | Mot installed (1063) X
L processing

@ AGT - Archaeclogical Geophy = Not installed plugins
@ Append Features to Layer

& Arrblerm Here you see the list of all plugins available in the repositories,
i Mot installed % Batch Hillshader but which are not yet installed.
@ BecaGls Click on the name to see details.
Install from ZIP # BoundaryDelineation You can change the sorting via the context menu (right click).
& Buffer Without Overlaps A plugin can be downloaded and installed by clicking on it's
ﬁ Settings # Cartography Tools name, and then click the 'Install plugin' button.

@ Contour plugin

= Coregistration

% Customize ToolBars

= Danish Address Tools

@ Degree to DMS table converty
. Disconnected Islands

@ Dissolve Adjacent Polygons
= DMS to degree table converte
- dzetsaka : Classification tool
@ Easy Processing Tool

@ Equi Processing ~ || Upgrade al Uninstall Plugin Reinstall Plugin

Cloze Help

2. Find information about the plugin by selecting it in the list

@ Plugins | Not installed {1069) ES

= CZML Billboard Maker -

= D3 Data Visualzation Data Plotly ]’;

= DA
i Mot installed # Danish Address Tools D3 Plots for QGIS
Data Plothy

2 Install from ZIP # Data-Driven Input Mask Draw D3 plots in QGIS

& DataFxplorer: Data Analysis a X
* Settings # Datafordeler W W 95 rating vote(s), 189842 downloads

(o ]
E ] Instalied

# Dataforsyningen

# DataGrandEst Tags vector, python, d3, plots, graphs,
* DataSud datavis, dataplotly, dataviz

Date/T Terol -
* Uate/Time loals More info homepage bug tracker code

& Datos Espaciales de Referenc repository

& DaumAP

& DB Style Manager . i )

= DBGI Available version (stable) 4.0.2 updated at uto jun 27
09:25:41 2023

Author Matteo Ghetta (Faunalia)

# DDG Street Images

# Deactivate Active Labels

= debugvs 1 L]
# Deepness: Deep Neural Reme _ Upgrade A tnstall Fiugin

Case Help

3. Install the one(s) you are interested in by clicking the Install Plugin button below the plugin information panel.

Poznamka: if the plugin has some error it will be listed in the Invalid tab. You can then contact the plugin owner to
fix the problem.
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9.13 \ Follow Along: Configuring Additional Plugin Repositories

The plugins that are available to you for installation depend on which plugin repositories you are configured to use.

QGIS plugins are stored online in repositories. By default, only the official repository is active, meaning that you can
only access plugins that are published there. Given the diversity of available tools, this repository should meet most
of your needs.

It is possible, however, to try out more plugins than the default ones. First, you want to configure additional repositories.
To do this:

1. Open the Settings tab in the Plugin Manager dialog

@ Plugins | Settings X
i, Al Check for Updates on Startup -

If this function is enabled, QGIS will inform you whenever a plugin update is available. Otherwise, fetching
E : Installed repositories will be performed during opening of the Plugin Manager window.

w Vv Show also Experimental Plugins

Not installed

Experimental plugins are generally unsuitable for production use. These plugins are in early stages of
Install from ZIP development, and should be considered 'incomplete’ or ‘proof of concept’ tools. QGIS does not recommend installing these
plugins unless you intend to use them for testing purposes.

v Show also Deprecated Plugins

Deprecated plugins are generally unsuitable for production use. These pluginz are unmaintained, and should be
considered 'obsolete’ tools. QGIS does not recommend installing these plugins unless you still need it and there are no other
alternatives available.

Plugin Repositories

Status MName URL
@ connected QGIS sluzbeni repozitorij dodataka https://plugins.qgis.org/plugins/plugins.xml?qgis=3.32

1 Reload Repository | Zoadd. | Edit. . Delete | [+

Cloze Help

2. Click Add to find and add a new repository.

3. Provide a Name and URL for the new repository you want to configure and make sure the Enabled checkbox
is selected.
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Repository details

Name Faunalia

URL https:/fwww.faunalia.eu/ggis/plugins.xml

Parameters

Authentication Clear | Edit
Enabled v

o conce

4. You will now see the new plugin repo listed in the list of configured Plugin Repositories

Plugins | Settings

e Al Check for updates on startup

ry
E ] Installed

7% Not installed

& Invalid w v/ Show also experimental plugins
%% Install from ZIP Note: Experimental plugins are generally unsuitable for production use. These plugins are in early stages of development,

and should be considered 'incomplete’ or 'proof of concept’ tools. QGIS does not recommend installing these plugins unless
you intend to use them for testing purposes.

v Show also deprecated plugins

Plugin repositories

Status Name URL

@ connected Faunalia https:ffwww.faunalia.eu/qgis/plugins.xml?qgis=3.2
[©] connected QGIS Official Plugin Repository https://plugins.qgis.org/plugins/plugins.xmi?qgis=3.2

Reload all repesitories Add... Delete

Help * Close

5. You can also select the option to display Experimental Plugins by selecting the Show also experimental plugins
checkbox.

6. If you now switch back to the Not Installed tab, you will see that additional plugins are available for installation.

7. To install a plugin, click on it in the list and then on the Install plugin button.
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9.1.4 In Conclusion

Installing plugins in QGIS should be straightforward and effective!

9.1.5 What’s Next?

Next we’ll introduce you to some useful plugins as examples.

9.2 Lesson: Useful QGIS Plugins

Now that you can install, enable and disable plugins, let’s see how this can help you in practice by looking at some
examples of useful plugins.

The goal for this lesson: To familiarize yourself with the plugin interface and get acquainted with some useful
plugins.

9.2.1 \ Follow Along: The QuickMapServices Plugin

The QuickMapServices plugin is a simple and easy to use plugin that adds base maps to your QGIS project. It has
many different options and settings. Let’s start to explore some of its features.

1. Start a new map and add the roads layer from the t raining_data Geopackage.
2. Install the QuickMapServices plugin.

3. Click on Web » QuickMapServices. The first menu lists different map providers (OSM, NASA) with available
maps.

4. Click on an entry and you would load the base map into your project.

Project Edit View Layer Settings Plugin: Raster Database Web Mesh Progessing Help
DEBRRX @257 PRA LI OX
LL ALY "

Layers L]
¢ 3= T 3= g=

v roads
~ ¥ ¥ OSM Standard [\

Q
[S

<
%
[ye}
E
@

Ty te (Ctri+k) 1 legend enty removed. Coordinate 3404580204273 | Scale 127093 | | @ Magnifier [100% |3 Rotaton [00° 2|V Render @epscans @

Nice! But one of the main strengths of QMS is to provide access to many data providers. Let’s add them.
1. Click on Web » QuickMapServices w Settings
2. Go to the More services tab.
3. Read carefully the message of this tab and if you agree click on the Get Contributed pack button.
4. Click Save.
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5. Reopen the Web » QuickMapServices menu you will see that more providers are available.

W Mesh Processing Help

MetaSearch

. QuickMapServices & 2qis v
T AutoNavi b
> Bing 4
& esrr v
@ GeoQ v
& Google »
@ NAsA b
¢ CartoDB 4
« BasemapAT >
& Stamen >
B usas g
£ Waze »
9 Yandex >
A2 0O5M »
€} search Qms
€3 Add to search
@3 set proper scale
€3 settings
@} About QMS

6. Choose the one that best fits your needs, and load the data in the project!

It is also possible to search trough the now available data providers

1. Open the plugin’s search tab by clicking on Web » QuickMapServices » Search QMS. This option of the plugin
allows you to filter the available base maps by the current extent of the map canvas or using a search word.

2. Click on the Filter by extent and you should see one service available. If no service is found, zoom out and pan
around the world (or your location) or search with a keyword.

3. Click on the Add button next to a returned dataset to load it.

4. The base map will be loaded and you will have a background for the map.

Project Edit View Layer Settings Plugins Vector Raster Database Web Mesh Progessing Help

DoBnRRY UL RpPPPpR / katllOR -5 %* 2z o
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WMS details, report a problem
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| Layers | Browser Download geodata for your project
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9.2.2 \ Follow Along: The QuickOSM Plugin

With an incredible simple interface, the QuickOSM plugin allows you to download OpenStreetMap data.
1. Start a new empty project and add the roads layer from the t raining_data GeoPackage.

2. Install the QuickOSM plugin. The plugin adds two new buttons in the QGIS Toolbar and is accessible in the
Vector » QuickOSM menu.

3. Open the QuickOSM dialog. The plugin has many different tabs: we will use the Quick Query one.

4. You can download specific features by selecting a generic Key or be more specific and choose a specific Key
and Value pair.

Tip: if you are not familiar with the Key and Value system, click on the Help with key/value button. It will
open a web page with a complete description of this concept of OpenStreetMap.

5. Look for railway in the Key menu and let the Value be empty: so we are downloading all the railway features
without specifying any values.

6. Select Layer Extent in the next drop-down menu and choose roads.

7. Click on the Run query button.

[ - Jo——— Raomt

ey [y ek Dl

apw Bomnt * rasds - Dy sedechend Fezbures

After some seconds the plugin will download all the features tagged in OpenStreetMap as railway and load them
directly into the map.

Nothing more! All the layers are loaded in the legend and are shown in the map canvas.

- o X

RBREEIOS H-8 & G GE#¥TE = -
Qe® 2~ B ¥

Q setings a Coordnate | -33.9575°, 20.4559° | % Scale| 1199045 |~ | @ Magnifier | 100% 3 Rotation (0.0° 2| ViRender Sepscams @
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Advanced menu in QuickOSM and choose where to save the data in the Directory menu.

Varovani: QuickOSM creates temporary layer when downloading the data. If you want to save them permanently,

click on the [:j icon next to the layer and choose the options you prefer. Alternatively you can open the

9.2.3 === Follow Along: The QuickOSM Query engine

The quickest way to download data from QuickOSM plugin is using the Quick query tab and set some small

parameters. But if you need some more specific data?

If you are an OpenStreetMap query master you can use QuickOSM plugin also with your personal queries.

QuickOSM has an incredible data parser that, together with the amazing query engine of Overpass, lets you download

data with your specific needs.

For example: we want to download the mountain peaks that belongs into a specific mountain area known as Dolomites.

You cannot achieve this task with the Quick query tab, you have to be more specific and write your own query. Let’s

try to do this.
1. Start a new project.
2. Open the QuickOSM plugin and click on the Query tab.

3. Copy and paste the following code into the query canvas:

p
gl==

This shows all mountains (peaks) in the Dolomites.
You may want to use the "zoom onto data" button. =>
——>
<osm-script output="json">
<!-- search the area of the Dolomites —-->
<query type="area">

<has-kv k="place" v="region"/>

<has-kv k="region:type" v="mountain_area"/>
<has-kv k="name:en" v="Dolomites"/>
</query>
<print mode="body" order="quadtile"/>
<!-— get all peaks in the area ——>

<query type="node">
<area-query/>
<has-kv k="natural" v="peak"/>

</query>
<print mode="body" order="quadtile"/>
<!-- additionally, show the outline of the area -->

<query type="relation">
<has-kv k="place" v="region"/>
<has-kv k="region:type" v="mountain_area"/>
<has-kv k="name:en" v="Dolomites"/>
</query>
<print mode="body" order="quadtile"/>
<recurse type="down"/>
<print mode="skeleton" order="quadtile"/>
</osm-script>

Poznamka: This query is written in a xm1 like language. If you are more used to the Overpass QL you

can write the query in this language.

4. And click on Run Query:
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(Y} Quickosm w
n Map preset <l
. This shows all mountains {peaks) in the Dolomites,
You may want to use the "zoom onto data™ butforn. =>
’ Quick query -

=

<osm-script owfpwi="json

<query fype= =
<has4v &="place” v="region”/>
<has+v &="region:type” v="mountain_area"/>
<has4v #="name:en” v="Dolomites™/ =

< fquery=

' 05M File

<print mode="body" erder="quadtile™/>
o int mode="body™ arder="quadtile"/’
. Parameters <!-—-get ks in the area -
<query frpe="node">
<areg-guery/=
* About <has4v &="natural” v="peak’/=
e <fquery>

<print mode="body" or:
<query fype="Trelation”=
<has+v &="place” v="region”/=
<has+v &="region:type” v="mountain_area"/>
<has+v k="name:en” v="Dolomites”/>
< fquery=
<print mode="body” arder="quadtile™/>
<recurse fype="down”/=
<print moge="skeleton” order="quadtile”/ =
<fosm-script>|

Generate query -4 » Run query

P Advanced

| QOverpass Turbo Documentation =

1 L3

0%

The mountain peaks layer will be downloaded and shown in QGIS:

You can write complex queries using the Overpass Query language. Take a look at some example and try to explore
the query language.

9.24 \ Follow Along: The DataPlotly Plugin

The DataPlotly plugin allows you to create D3 plots of vector attributes data thanks to the plotly library.
1. Start a new project
2. Load the sample_points layer from the exercise_data/plugins folder

3. Install the plugin following the guidelines described in Follow Along: Installing New Plugins searching Data
Plotly

4. Open the plugin by clicking on the new icon in the toolbar or in the Plugins » Data Plotly menu

In the following example we are creating a simple Scatter Plot of two fields of the sample_points layer. In the
DataPlotly Panel:

316 Kapitola 9. Module: Plugins


https://wiki.openstreetmap.org/wiki/Overpass_API/Overpass_QL
https://d3js.org/
https://plotly.com/

QGIS Training Manual

1. Choose sample_points in the Layer filter, cl for the X Field and mg for the Y Field:

DataPlothy n

& Plottype | Scatter Plat -
w Plot Parameters
Layer o sample_points -
Use only selected features Use only visible features
Feature subset E.
X field l.2d ||

Y field 1.2mg || &

w Properties

Legend title d-mg E.
Marker color v =L Markersize | 10.00 s &
Stroke color D - =l stroke width | 1.00 s &
Marker type Points bt
Point type 9 -
Opacity _ 1] 100.0 % -
Hover tooltip All Values *
Hover label as text

Type of plot Single Plot -

4 Clean Plot Canvas @Update Plot | | i) Create Plot | | Configuration =

2. If you want you can change the colors, the marker type, the transparency and many other settings: try to change
some parameters to create the plot below.
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DataPlothy n
¥ ) -z M

S & o-mg
= +F e ® L &
L
= &
+ + &
45 +
&+
2 40 & &
&
35
+
B % + @
*%
25
Zh + %
20 dh +
40 60 20 100 120 140
d
\‘.;Reload Dynamically update size ;nm qﬂ

3. Once you have set all the parameters, click on the Create Plot button to create the plot.

The plot is interactive: this means you can use all the upper buttons to resize, move, or zoom in/out the plot
canvas. Moreover, each element of the plot is interactive: by clicking or selecting one or more point on the plot,
the corresponding point(s) will be selected in the plot canvas.

TR

You can save the plot as a png static image or as an html file by clicking on the % or on the button in the
lower right corner of the plot.
There is more. Sometimes it can be useful to have two (or more) plots showing different plot types with different
variables on the same page. Let’s do this!

1. Go back to the main plot settings tab by clicking on the ({ button in the upper left corner of the plugin panel

2. Change the Plot Type to Box Plot

3. Choose group as Grouping Field and ph as Y Field

4

. In the lower part of the panel, change the T'ype of Plot from SinglePlot to SubPlots and let the default option
Plot in Rows selected.
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DataPlothy

& Phttype | [ BoxPlot A
w Plot Parameters

Layer | " sample_points - |

Use only selected features Use only visible features

Feature subset @,

Grouping field

{optional) |123 group T | |£|

¥ field 1.2 ph -] [€]
w Properties

Legend title |ph | @,

sxcoor | (I - .
stroke color | (I - =, stokewidth 100 @ |2 €
Opacity : 1] 100.0 % =

Box orientation |\|'ert'n3| = |

Show statistics |None v |

Qutliers |Nc Cutliers = |
Type of plot |Subplcts - |

() Plotin columns (@) Plotin rows

4 Clean Plot Canvas Update Plot | | ) Create Plot | | Configuration = |
|

5. Once done click on the Create Plot button to draw the plot

DataPlotly

e

: [ ] g cl-mg
' > + m e
& + + L ] 75
50 ~ s
+ *é
45 +
7
& + *
35 + 6.5
L
? e PR R
L ] 6
25
+ + @
20 L +
5.5
50 100 150 1 2 3
:;Re\oad Dynamically update size ‘§| |£|

Now both scatter plot and box plot are shown in the same plot page. You still have the chance to click on each plot
item and select the corresponding features in the map canvas.
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Tip: Each plot has its own manual page available in the tab. Try to explore all the plot types and see all the other
settings available.

9.2.5 In Conclusion

There are many useful plugins available for QGIS. Using the built-in tools for installing and managing these plugins,
you can find new plugins and make optimum use of them.

9.2.6 What’s Next?

Next we'll look at how to use layers that are hosted on remote servers in real time.
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Module: Online Resources

When considering data sources for a map, there is no need to be restricted to data which you have saved on the
computer you're working on. There are online data sources which you can load data from as long as you are connected
to the Internet.

In this module, we’ll cover two kinds of web-based GIS services: Web Mapping Services (WMS) and Web Feature
Services (WES).

10.1 Lesson: Web Mapping Services

A Web Mapping Service (WMS) is a service hosted on a remote server. Similar to a website, you can access it as long
as you have a connection to the server. Using QGIS, you can load a WMS directly into your existing map.

From the lesson on plugins, you will remember that it’s possible to load a new raster image from Google, for example.
However, this is a once-off transaction: once you have downloaded the image, it doesn’t change. A WMS is different
in that it’s a live service that will automatically refresh its view if you pan or zoom on the map.

The goal for this lesson: To use a WMS and understand its limitations.

10.1.1 \ Follow Along: Loading a WMS Layer

For this exercise, you can either use the basic map you made at the start of the course, or just start a new map and
load some existing layers into it. For this example, we used a new map and loaded the original places, landuse and
protected_areas layers and adjusted the symbology:
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*Untitled Project - QGIS
Project Edit View Layer Settings Plugins Vector Raster Database Web Mesh Progessing Help

NERRRY OBEL " BPPRIGBRIUR ¢ B o LEE#E= - D

BHV.Aw @ w R 2
Layers (=]E3]
o @ ® T |7 2= g}

v/ * places

v [ ] protected_areas

v [] landuse

Layers = Browser

Q Type to locate (Ctrl+K) 1legendentrie Coordinate| 20.2220-34.0541 |9 Scale| 1:93042 ~ | @ Magnifier| 100% 2| Rotation |0.0° 3| V| Render @Epsciaize @

1. Load these layers into a new map, or use your original map with only these layers visible.

2. Before starting to add the WMS layer, deactivate ,,on the fly* projection (Project » Properties... » CRS tab,
check No CRS (or unknown/non-Earth projection). This may cause the layers to no longer overlap properly, but
don’t worry: we'll fix that later.

3. To add WMS layers, click on the ‘! button to open the Data Source Manager dialog and enable the @
WMS/WMTS tab.
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Layers Lay er Tileset:
Raster New Edit
Mesh Q
o ) 1D Name Title
Point Cloud
Delimited Text
Image Encoding
MS 5QL Server
firtual Layer q
irtual Layer Options
Tile size
| WFS/ OGC API- Features Request step size
-:@; WCs Maximum number of GetFeaturelnfo results
XYZ Coordinate Reference Syster

Use contextual WMS Legend

Vector Tile

ArcGIS REST Server

Layer name

Gecons Load as separate layers
Metadata Search Ready

18 Aide

Data Source Manager | WMS/WMTS

Abstract

Load Save

+ Add @ Fermer

Remember how you connected to a Spatialite or GeoPackage database at the beginning of the course. The
landuse, buildings, and roads layers are stored in a database. To use those layers, you first needed to connect to
the database. Using a WMS is similar, with the exception that the layers are on a remote server.

4. To create a new connection to a WMS, click on the New button.

You'll need a WMS address to continue. There are several free WMS servers available on the Internet. One of

these is terrestris, which makes use of the OpenStreetMap dataset.

5. To make use of this WMS, set it up in your current dialog, like this:

10.1. Lesson: Web Mapping Services
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Create a New WMS/WMTS Connection

Connection Details

Name |terrestris
URL https://ows.terrestris.de/osm/service
Authentication

Configurations | Basic

Choose or create an authentication configuration

Mo Authentication - &

Configurations store encrypted credentials in the QGIS authentication
database.

HTTP Headers
Referer
p Advanced

WMS/WMTS Options

DPI-Mode all -
Ignore GetMap/GetTile/GetLegendGraphic URI reported in capabilities
Ignore GetFeaturelnfo URI reported in capabilities
Ignore axis orientation (WMS 1.3/WMTS)

Ignore reported layer extents
Invert axis orientation

Smooth pixmap transform
H aide " Ok | & Annuler
 The value of the Name field should be terrestris.

¢ The value of the URL field should be https://ows.terrestris.de/osm/service.
6. Click OK. You should see the new WMS server listed:
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Data Source Manager | WM

Browser Layers | Layer Order | Tilesets
|terrestri5 - |
Raster | Connect | | New | ‘ Edit | | Remove Load | | Save |
E |
Mesh =3
) D Name Title Abstract
Point Cloud
Delimited Text
GeoPackage
GPS
SpatiaLite
Image Encoding
Options
Tile size | | ‘ |
S/ OGC API - Features Request step size | | ‘ |
Maximum number of GetFeaturelnfo results ‘ 0 |
Coordinate
Use contextual WMS Legend
s ArCGIS REST Server
Layer name
+ Sl Load as separate |ayers
Metadata Search Ready
| B Aide | v Add | @ Fermer |

7. Click Connect. In the list below, you should now see these new entries loaded:
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Data Source Manager | W

Layers | Laye Tilesets
Vector |terrestr|5 - ‘
Raster | Connect ‘ | New | ‘ Edit | | Remove Load | | Save ‘
e Mesh | Q ‘
P D ~ Name Title Abstract =
omnt Clouc
>0 OpenStreethap WMS
Delimited Text [ OSM-WMS OpenStreethvlap WMS - by terrestris
— 3 OSM-WMS-no-labels 0SM WMS w/o labels - by terrestris
GeoPackage L OSM-Overlay-WMS 0OSM Overlay WMS - by terrestris
e r 6 TOPO-WMS Topographic WMS - by terrestris
Gps » 8 TOPO-OSM-WMS Topographic OSM WMS - by terrestris
10 SRTM30-Hillshade SRTM30 Hillshade - by terrestris
SpatiaLite P SRTM30-Colored SRTM30 Colored - by terrestris
- - b 13 SRTM30-Colored-Hillshade SRTM30 Colored Hillshade - by terrestris =
Image Encoding
() PNG (® JPEG
Options
Tile size | |
Request step size | |
Maximum number of GetFeaturelnfo results |
C linate
Use contextual WMS Legend
cGIS REST Server
Layer name
GeoNode
Load as separate layers
Metadata Search Select layer(s)
| I8l Aide | + Add | @ Fermer |

These are all the layers hosted by this WMS server.

8. Click once on the OSM-WMS layer. This will display the default Coordinate Reference System in use and the
number of CRSes supported by the dataset:
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Data Source Manager | WN

Browser Layers | Layer Order | Tilesets
Vector |terrestri5 - |
Raster | Connect | | New | ‘ Edit | | Remove Load | | Save |
L9 |
Mesh -
D ~ MName Title Abstract 3
Point Cloud
>0 OpenStreetMap WMS
Delimited Text 1 O5M-WMS OpenStreetMap WMS - by terrestls
3 OSM-WMS-no-labels OSM WMS w/o labels - by terrestris
b4 OSM-Overlay-Whs OSM Overlay WMS - by terrestris
P 6 TOPO-WMS Topographic WMS - by terrestris
b8 TOPO-OSM-WMS Topographic OSM WMS - by terrestris
10 SRTM30-Hillshade SRTM30 Hillshade - by terrestris
P11 SRTM30-Colored SRTM30 Colored - by terrestris
b 13 SRTM30-Colored-Hillshade SRTM30 Colored Hillshade - by terrestris

ar AT AR ke B VU - T,

Image Encoding

M5 5QL Server

+ () PNG (@) JPEG
m Virtual Layer Options
Tile size | | ‘ |

_'_ WFS / OGC API - Features Request step size | (| |

Maximum number of GetFeaturelnfo results ‘ 10 |

Coordinate Reference System (25 available) ‘ EPS5G:4326 - WGS 84 =

Use contextual WMS Legend

* rcGIS REST Server

Layer name OpenStreetMap WMS - by terrestris

GeoMNode
Load as separate layers

Metadata Search 1 Layer selected

| B Aide | + Add ||Qfermer|

Since we’re not using EPSG:4326 — WGS 84 for our map, let’s find one that meets our needs.

1. Click the %Selem CRS button. You will see a standard Coordinate Reference System Selector dialog showing
all the CRS the data is published with.
2. We want a projected CRS, so let’s choose WGS 84 / Pseudo-Mercator with EPSG:3857. You can use

the top q Filter widget.
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| Predefined CRS - |

Filter | o} |

Recently Used Coordinate Reference Systems

Coordinate Reference System Authority ID
WGS 84 EF5G:4326
4 L3
Predefined Coordinate Reference Systems Hide deprecated CRSs
wordinate Reference System Authority ID =
~ Cassini
DHDN / Soldner Berlin EP5G:3068
~ Lambert Azimuthal Equal Area
ETRS89-extended / LAEA Europe EP5G:3035
~ Lambert Conformal Conic
ETRS89 / LCC Germany (E-N) EF5G:5243
ETRS89 / LCC Germany (N-E) EP5G:4839
ETRS89-extended / LCC Europe EP5G:3034
~ Mercator
Google Maps Global Mercator EP5G:900913
~ Swiss. Obl. Mercator
CH1903 / LVO3 EF5G:21781
CH1903+ f LV95 EP5G:2056
~ Transverse Mercator
DHDN / 3-degree Gauss zone 3 EF5G:31463
DHDM / 3-degree Gauss-Kruger zone 2 EF5G:31466

4

WGS 84 / Pseudo-Mercator =
Properties

* Lnits: meters

& Dynamic (relies on a datum which is
not plate-fixed)

* Method: Mercator

WEKT

PROJCRS["WG5S 84 / Pseudo-
Mercator”, b’

| @Ade |

1. Click OK. The Coordinate Reference System associated with the entry has changed.
9. Click Add to load the layer in your project using Layer name" (default is OpenStreetMap WMS - by terrestris).
10. Close the Data Source Manager dialog if not done automatically
11. In the Layers panel, click and drag it to the bottom of the list.

12. Zoom out in order to get a global view of the layers. You will notice that your layers aren’t located correctly
(near west of Africa). This is because ,,on the fly“ projection is disabled.
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itled Project - QGIS
Project Edit View Layer Settings Plugins Vector Raster Database Web Mesh Progessing Help

DNoERERE UL, " HPPLa/ il ¢ KN-a-L,B@E#Ta -0

MOLAMB / /G5 B0 <0000 "AEMIELTE R A& B
Layers 7. ; e

« BT WAL

* places 2l Greenland

"] protected areas
[] landuse
~ v/ ¥ OpenStreetMap WMS - by te...
®  Stadt > 1,000,000 EW !
+  Stadt > 250,000 EW/ : i .~ gd iceland. . | i SHE
Stadt > 25,000 EW

/ StraBe

Bundesstraiie ok - = 7 Mangalia !
L 4 P,
S - i B
% €3 : china
[ Wasserfiache : " : " ; ,

Landflache

Wald

Wiese / Acker

[ ] cebiuce

Krankenhaus

Layers ‘ Browser Antarctica
| A Type to locate (Ctrl+k) 1legend entries remove Coordinate | 11838951,16718714 | scale[on |-| @ Magnifier| 100% ~| Rotation |E|§J Render ¥ @

13. Let’s enable the reprojection again, but using the same projection as the OpenStreetMap WMS layer, which
is WGS 84 / Pseudo Mercator.

1. Open the Project » Properties... » CRS tab
2. Uncheck No CRS (or unknown/non-Earth projection)
3. Choose WGS 84 / Pseudo Mercator from the list.
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Project Properties — CRS X

Project Coordinate Reference System (CRS)
e

. General

No CRS (or unknown/non-Earth projection)
l [EELEL

& crs

Filter | ©.

Recently Used Coordinate Reference Systems

Coordinate Reference System Authority ID
¥ Default styles WGS 84 EPSG:4326
B8 Dpatasources
EE Relations
Variables
4 »
B macros Predefined Coordinate Reference Systems Hide deprecated CRSs
QGIS Server Coordinate Reference System Authority ID =
WGS 84 / PDC Mercator EPSG:3349
g‘ Temporal WGS 84 / PDC Mercator EPSG:3832
WGS 84 [ Pseudo-Mercator EPSG:3857
WGS 84 / Pseudo-Mercator EPSG:6871
WGS 84 / World Mercator EPSG:3395
WGS 84 / World Mercator EPSG:6893
WGS84 WEB MERCATOR SPHERIQUE (VISUALISATION) IGNF:WGS84WMSV -

]

'WGS 84 / Pseudo-Mercator

WKT
PROJCRS["WGS 84 / Pseudo-Mercator",
BASEGEOGCRS["WGS 84",

DATUM["World Geodetic System 1984",

ELLIPSOID["WGS B4",66378137,298.257223563,
LENGTHUNIT["metre”, 1111,

PRIMEM["Greenwich",8,
ANGLEUNIT["degree”,®.0174532925199433]1,

ID["EPSG",4326]],

COMUEDETAML ®Danu] nr Mirnalicatinn Drauds Maresdaet

b Datum Transformations

@Help

4. Kliknout OK.

@cancel

@Apply

14. Now right-click on one of your own layers in the Layers panel and click Zoom fo layer(s). You should see the

Swellendam area:

*untitled Project - QGIS X
Project Edit View Layer Settings Plugins Vector Raster Database Web Mesh Processing Help

NEEmEH O@2L "HPP A

LL AT AN
Layers (=]E3]
o o e T & - H O

v/ * places

v [ ] protected_areas
1 landuse
~ v ¥ OpenStreetMap WMS - by te...
®  Stadt > 1,000,000 EW
Stadt > 250.000 EW
Stadt > 25,000 EW

Strale
Bundesstrafe
Autobahn
Wasserflache

Landfldche Bruintjiestivier

Wald

Wiese / Acker
Sreede River

Gebaude

Krankenhaus

Leeu River

Breede River

Layers = Browser

Q Type to locate (Ctrl+K)

LN
= % &

1 legend entrie Coordinate | 2270396,-4020313 % Scale | 1:150052

@@ E\E%"I:Lla

¥ T m- M-

® 2 B

gutiefagsriver

©

Bufteljogsivier

~ | @ Magnifier| 100% 2| Rotation |0.0° + v/ Render @ Epsg3ss? @
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Note how the WMS layer’s streets and our own streets overlap. That’s a good sign!

The nature and limitations of WMS

By now you may have noticed that this WMS layer actually has many features in it. It has streets, rivers, nature
reserves, and so on. What’s more, even though it looks like it’s made up of vectors, it seems to be a raster, but you
can’t change its symbology. Why is that?

This is how a WMS works: it’s a map, similar to a normal map on paper, that you receive as an image. What usually
happens is that you have vector layers, which QGIS renders as a map. But using a WMS, those vector layers are on
the WMS server, which renders it as a map and sends that map to you as an image. QGIS can display this image, but
can’t change its symbology, because all that is handled on the server.

This has several advantages, because you don’t need to worry about the symbology. It’s already worked out, and should
be nice to look at on any competently designed WMS.

On the other hand, you can’t change the symbology if you don’t like it, and if things change on the WMS server, then
they’ll change on your map as well. This is why you sometimes want to use a Web Feature Service (WFS) instead,
which gives you vector layers separately, and not as part of a WMS-style map.

This will be covered in the next lesson, however. First, let’s add another WMS layer.

10.1.2 \ Try Yourself

1. Add the eAt1las WMS server at this URL: https://maps.eatlas.org.au/maps/wms
2. Load a World: Hillshading layer into the map.
3. You might want to set its Encoding to JPEG and its Tile size option to 200 by 200, so that it loads faster.

4. Your map should look like this (you may need to re-order the layers, and apply some transparency):

Layers @®
&4 = T = 3
v ¥ places
v| [ protected_areas
v! [ landuse
~ v & OpenStreetMap WMS - by terrestris
®  Stadt > 1.000.000 EW
Stadt > 250.000 EW
Stadt > 25,000 EW

Strabe
Bundesstrafie
Autobahn
Wasserflache
Landflache
Wiald

Wiese / Acker

|S!hiun!

Krankenhaus pEopE, v #
M- ! ol YA “
- Sm_ .

Layers | Browser
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Answer

1. Go to the Data Source Manager, WMS / WMTS tab and create a new connection entry

2. Use the Q text box to filter the list of layers and select the corresponding layer
3. Remember to check/turn its CRS into EPSG:3857 - WGS 84 / Pseudo Mercator as the rest of the map.

" Data Source Manager | WMS/WMTS e
h’ Browser Layers Layer Order | Tilesets
. g Vector eAtlas -
r Raster Connect New Edit Remove Load Save
i \esh Q. warld: hillshading
g Mesl
. ID ~ Name Title Abstract
Point Cloud
* -0
Delimited Text ~ Imagery Base Maps Earth Cover Imagery Base Maps Earth Cover
ted Texi
L] *World: Bright Earth Basemap (e-Atlas) ‘World: Bright Earth Basemap (e-Atlas)

-ea-be:World_e-Atlas-UCSD_SRTM30-plus_v&_Hillshading ‘World: Hillshading - SRTM30-plus v8.0 (e-Atlas... This layer shows hillshadi...
Bright-Earth_Hillshading Transparent Hillshade

Bright-Earth_Raster Raster A sample style for rasters, ...
ea-be:World_e-Atlas-UCSD_SRTM30-plus_v&_Hillshading-Ir World: Hillshading Low Res - SRTM30-plus v&.... This layer shows hillshadi...
Bright-Earth_Hillshading Transparent Hillshade

Bright-Earth_Raster Raster A sample style for rasters, ...

Image Encoding

- MS SQL Server

m Virtual Layer

PNG PNG8 (@ JPEG GIF TIFF SVG

Options

Tile size 200 200

-+ WFS / OGC API - Features

Reguest step size
_:e-.—; WCs Maximum number of GetFeaturelnfo results 10
* XYZ Coordinate Reference System (6779 available) EPSG:3857 - WGS 84 / Pseudo-Mercator - || @
Use contextual WMS Legend
ArcGIS REST Server
Layer name |World: Hillshading - SRTM30-plus v8.0 (e-Atlas, UCSD)

» GeoNode
Load as separate layers

Metadata Search 1 Layer selected

i Aide + Add @ Fermer

4. After the layer is loaded, you can modify its Opacity value (under the Transparency properties tab)

10.1.3 nm'—-- Try Yourself

Part of the difficulty of using WMS is finding a good (free) server.

* Find a new WMS at directory.spatineo.com (or elsewhere online). It must not have associated fees or
restrictions, and must have coverage over the Swellendam study area.

Remember that what you need in order to use a WMS is only its URL (and preferably some sort of description).

Answer

Spatineo is one of many places you can search for a OGC data. Type in the text area a name, keyword, location of
your interest to see if you get some working results. For this lesson, you might want to filter the results to include
WMS only.

You may notice that many WMS servers are not always available. Sometimes this is temporary, sometimes
it is permanent. An example of a WMS server that worked at the time of writing is the MapServer
Demonstration Server WMS at https://demo.mapserver.org/cgi-bin/wms?SERVICE=WMS&VERSION=1.3.0&
REQUEST=GetCapabilities. It does not require fees or have access constraints, and it is global. Therefore, it does
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satisfy the requirements. Keep in mind, however, that this is merely an example. There are many other WMS servers
to choose from.

10.1.4 & Try Yourself

* Add the bluemarble layer from the MapServer Demonstration Server. Is that a suitable dataset for our study
area?

Answer

1. Hide all other WMS layers to prevent them from rendering unnecessarily in the background.

2. Use the same approach as before to add the new server and the appropriate layer as hosted on that server:

Data Source Manager | WMS/ e
Layers ‘ Layer Order | Tilesets
Vector |Mapsarver - |
Raster | Connect | | New | ‘ Edit ‘ | Remove Load ‘ | Save |
|/ _ | Q |
Mesh
© G e ID ~ Name Title Abstract
oint Clouc
* 0  WMS_server WMS Demo Server for MapServer This demonstration server showcases MapServer (www.map...
Delimited Text 1 bluemarble Blue Marble World Elevation and Bathymetry ...
ted Tex -
» 2continents Wworld continents
v 4 country_bounds World country boundaries
b Gities World cities
Image Encoding
4 M5 5QL Server @ PNG () PNGE () JPEG () TIFF () SVG
ee Vvirtual Layer )
WA vircualL
. Options
Tile size | | ‘ |
Request step size | | ‘ |
Maximum number of GetFeaturelnfo results ‘IO |
Coordinate Reference System (4 available) ‘ EPSG:3857 - WGS 84 / Pseudo-Mercater bt ||§|
Vector Tile Use contextual WMS Legend
ArcGIS REST Server
Layer name |Blue Marble World Elevation and Bathymetry Raster
» GeoNode
Load as separate layers
Metadata Search 1 Layer selected
‘ i Aide | + Add H @ Fermer |

3. If you zoom into the Swellendam area, you’ll notice that this dataset has a low resolution:
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Layers

«| 8 ® T 2 =
v ¥ places
! [ protected_areas

! [ landuse
W Opens

Layers | Browser

Therefore, it’s better not to use this data for the current map. The Blue Marble data is more suitable at global
or national scales

10.1.5 In Conclusion

Using a WMS, you can add inactive maps as backdrops for your existing map data.

10.1.6 Further Reading

* Spatineo Directory

¢ OpenStreetMap.org list of WMS servers
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10.1.7 What’s Next?

Now that you’ve added an inactive map as a backdrop, you'll be glad to know that it’s also possible to add features
(such as the other vector layers you added before). Adding features from remote servers is possible by using a Web
Feature Service (WFS). That’s the topic of the next lesson.

10.2 Lesson: Web Feature Services

A Web Feature Service (WES) provides its users with GIS data in formats that can be loaded directly in QGIS. Unlike
a WMS, which provides you only with a map which you can’t edit, a WFS gives you access to the features themselves.

The goal for this lesson: To use a WFS and understand how it differs from a WMS.

10.2.1 \ Follow Along: Loading a WFS Layer
1. Start a new map. This is for demo purposes and won’t be saved.

2. Click the % Open Data Source Manager button.

3. Enable the “Y) WFS /OGC API - Features tab.
4. Click the New button.

5. In the dialog that appears, enter the Name as nsidc.org and the URL as https://nsidc.org/
cgi-bin/atlas_south?version=1.1.0.

Create a New WFS Connection X

Connection Details

Name |nsidc.org
URL https://nsidc.org/cgi-bin/atlas_south?version=1.1.0
Authentication

Configurations | Basic

Choose or create an authentication configuration

No Authentication = &

Configurations store encrypted credentials in the QGIS
authentication database.

WFS Options

Version Maximum > Detect
Max. number of Features
¥| Enable Feature paging
Page size
Ignore axis orientation (WFS 1.1/WFS 2.0)
Invert axis orientation

Use GML2 encoding For transactions

@ Help Ocancel QoK

10.2. Lesson: Web Feature Services 335



QGIS Training Manual

6. Click OK, and the new connection will appear in your Server connections.

7. Click the Connect. A list of the available layers will appear:

B Browser
. 4 Vector
* Raster
l‘!:_ Mesh
4 Delimited Text
‘ﬁ GeoPackage
i’i SpatiaLite
4 PostgresQL
* MSSQL
DBZ+ DB2

Virtual Layer

\'H WMS/WMTS

@ WFS / OGC API - Features

$ XYZ

=% Vector Tile
& -

" ArcGIS Map Service

4 ATCGIS Feature Service

4 GeoNode

Data Source Manager | WFS / OGC API - Features

Server Connections

Antarctic coastline (includes ice shelves)
Antarctic continent

Antarctic grounding line (excludes ice ...
Ant